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Introduction

1.1. What is NMPlot?

NMPIot is a Microsoft Windows application for viewing and editing sets of georeferenced data

points. These data sets, also know as grids, represent measurable quantities that vary with

geographic location. Examples include noise levels around an airport, monthly records of rainfall

across a state, and water temperature measurements in a lake.

1.2. What Can NMPlot Do?

NMPIlot has the ability to:

Read and write georeferenced data point grids

Apply a mathematical function to the points in a grid

Merge two grids

Compute the sum or difference of two grids

Display a contour plot of a grid

Create a plot that displays a grid using a smoothly varying color gradient
Overlay a plot over a background map

Overlay one plot on top of another

Draw a plot using a printer or plotter

Export a plot to the clipboard and to a bitmap image file
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e (Create an animated plot from a series of grids
e Import background maps in the following formats:
e ARC/INFO Shapefile (SHP)
e Digital Line Graph (DLG)
e AutoCAD Data Exchange Format (DXF)
e Georeferenced Bitmap (BMP, TIF, JPG, PNG)
e Compressed ARC Digitized Raster Graphics (CADRG)
e Export a plot to a Geographic Information System (GIS) in the following formats:
e ARC/INFO Shapefile (SHP)

e AutoCAD Data Exchange Format (DXF)

1.3. Brief History of NMPlot

The original development of NMPlot was sponsored by the United States Air Force (USAF) and
the United States Federal Aviation Administration (US FAA). It was developed to produce
contour plots for their airport noise models.

Version 1.0, released in May 1989, was a Microsoft MS-DOS application. It was written in
Borland Pascal, and had limited capabilities. Numerous successive versions have steadily
increased its power and features.

In January 1997, work began on a Microsoft Windows version of NMPlot. As part of this
project, the entire application was ported to C++, numerous sections were rewritten from scratch,
and the user interface was modified to conform to Microsoft Windows conventions. The first
Microsoft Windows version of NMPlot was released in February, 1998.

While NMPlot was originally designed to support noise models, it is neutral to any particular
application domain. It can just as easily process data from other types of models (for example, air
pollution models) or from sources other than computer models (for example, measured data).

NMPIlot is currently shipped as the standard graphical analysis tool of the following applications.

e BNoise2, the United States Army's application for modeling noise from artillery and
explosive operations
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e INM, the US FAA's application for modeling noise around civilian airports
e Noisemap, the USAF's application for modeling noise around military airports
e ROUTEMAP, the USAF's aircraft training route noise model

e SANCTE, the Swiss environmental agency's Swiss Aircraft Noise Calculation Test
Environment

e SARNAM, the United States Army's application for modeling noise from small arms firing
ranges

e SIPS, the United States Navy's model of noise from explosive operations

e TNM, the United States Federal Highway Administration's traffic noise model

1.4. Distribution License

NMPIlot is distributed as acknowledgement-ware: it may be freely used and distributed, provided
that Wasmer Consulting is acknowledged as the author.

Introduction 3
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Getting Started

2.1. Minimum System Requirements

To take full advantage of NMPlot, your computer should meet the following minimum
requirements.

e Operating System - Microsoft Windows 2000, XP, or Vista
e Processor - 1.0 GHz Pentium

e Memory - 512 MB

Additional memory may be required to process very large grid files. NMPlot requires
approximately 1 MB of memory for every 10,000 grid points.

/

\\g/,/ Tip .

If NMPlot runs very slowly, and your hard drive is continuously accessed (i.e., your
hard drive light stays on), it is likely that your computer does not have enough
memory.

e Monitor - 64,000 colors (i.e., 16-bit color), resolution of 1024 x 768

For best results, you should set your monitor to display the maximum number of colors
possible. True color (i.e., 24- or 32-bit color) is desirable. To change the color and monitor
resolution, go to the Microsoft Windows control panel and select Display.

e Hard Drive Space - 20 MB
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2.2. Obtaining NMPlot

Visit the NMPlot web page, http://wasmerconsulting.com/nmplot.htm, to download the latest
version of NMPlot.

If desired, you can subscribe to the mailing list, and be notified by e-mail when new versions of
NMPIlot are released. See the NMPlot web page for additional information.

2.3. Installing NMPlot

NMPIlot is distributed as a self-extracting WinZip file. Installation consists of nothing more than
uncompressing the NMPlot files and copying them onto your hard drive. To install NMPlot,
follow these steps.

1. Go the the NMPIlot web site, http://wasmerconsulting.com/nmplot.htm, and click on the
Download NMPIlot link. A file named install nmplot.exe will be transferred to your

computer.

2. From Windows Explorer or My Computer, find the file install nmplot.exe and
double-click on it. The Installing NMPlot dialog box appears.

Winip Self-E xtractor - Install_MMPlot_exe

Tounzip all filez in [nstall_MNMPlokexe to the Urzip
specified folder press the Unzip button,

Fun *%ingip

i,

IIhzip to folder:
Iu::'\NMF'I:::t Browse... | Cloze

¥ Owenwrite files without prompting Abaut

Pl

Help

3. Inthe Unzip To Folder text box, type the name of the directory where you wish to install
NMPlot. Press the Browse button to display the Browse for Folder dialog box, which allows
you to select an existing directory.

4. Press the Unzip button. The NMPIot files are copied to your hard disk. NMPlot is now
installed.

5. The file install nmplot.exe is no longer needed. Delete it if you wish.
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2.4. Upgrading to a Later Version of NMPlot

To upgrade to a later version of NMPlot, simply perform a normal installation, noting these
points.

e [f NMPIot is running, close it before performing an upgrade.
e Install NMPlot to the same directory that NMPlot was previously installed to.

e On the Installing NMPIlot dialog box, make sure the Overwrite Files Without Prompting
box is checked.

All NMPIlot configuration information is stored in the file NMP1lot . c£g. This file will not be
overwritten when you install later versions. Therefore, your configuration will be preserved.

2.5. Uninstalling NMPliot

The NMPIlot installer does not make any hidden changes to your computer. In particular, it does
not install any files in the Windows or System directories, and does not modify the registry. To

uninstall NMPlot, simply use Windows Explorer or My Computer to delete the directory where
NMPIot is installed.

2.6. Starting NMPIot

To start NMPlot, follow these steps.

1. Using Windows Explorer or My Computer, navigate to the folder where NMPlot is
installed.

2. Double-click on the NMPlot icon, , labeled NMPlot . exe.

2.7. Viewing the Sample Files

To verify that NMPlot is functioning correctly, you can open the sample files. Follow these steps.

1. Start NMPlot.
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2. Choose Open from the File menu. The standard Microsoft Windows dialog box for opening
files is displayed. Familiarity with the use of this dialog box is assumed.

3. Navigate to the directory where NMPlot is installed, and open the file Sample Plot -
Map Overlay.nmp. A sample plot is displayed, showing contours over a background

map.

4. If desired, repeat the previous two steps and open the other sample files. Appendix D, List of
NMPIot Files, briefly describes the sample files.

2.8. Getting Help

Press the F1 key at any time to access NMPlot's extensive online help system. Press Ctrl + F1 to
display the NMPlot User's Guide table of contents. Chapter 22, Accessing Help, discusses the
help system in detail.
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A Brief Tour of
NMPIiot

The following screen capture shows NMPlot's main window as it would appear after opening two
files: the plot Sample Plot - Contours.nmp and the grid Sample Grid -
Airport Noise.grd. The main components of NMPlot are labeled.

Application Title Bar Horth Indicator
Menu Bar Toolbar Status Bar Document Title Bar

Description of Grid
Noise at Holloman A Fe

HNowze at Holloman A Forc
Memco, as calculated by I
the Thited State's A Force
Ilodel.

Metric

Workspace Grid Document Plot Document
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3.1. Application Title Bar

NMPlot's application title bar displays the program icon, the program name and version, and
buttons to minimize, maximize, and close the application.

Clicking on the program icon displays the Control menu, which contains commands for
positioning, resizing, minimizing, maximizing, and closing NMPIot. Double-clicking on the
program icon closes NMPlot. Double-clicking on the title bar toggles the window between its
maximized and normal sizes.

3.2. Menu Bar

The menu bar displays the headings for each of NMPlot's menus.

To display a menu, either click on its heading with the mouse, or press the Alt key plus the
underlined letter in the heading of the menu. For example, to display the Help menu, press Alt +
H. Note that on some versions of Microsoft Windows, the underline segments will be hidden
until you press the Alt key.

To choose an item on a menu, either: click on the item; press the key corresponding to an
underlined letter in the item's text; or select the item using the up and down arrow keys, and then
press the Enter key.

The result of choosing a menu item depends on the item's type.

e Choosing a menu item that ends with a small triangle will cause a secondary menu to
appear.

e Choosing a menu item that ends with three dots ... displays a dialog box. All dialog boxes
have a Cancel button. Therefore, if you are browsing NMPlot's user interface, it is always
safe to click on a menu item ending in three dots. You can inspect the dialog box and then
cancel it.

e Choosing any other menu item will cause an action to immediately occur.

Menu items that do not currently apply will appear in gray.
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3.3. Toolbar

The toolbar displays buttons that provide quick access to frequently used commands in NMPlot.
To activate a command, press its toolbar button. If a command is unavailable, its toolbar button
will be gray.

The toolbar contains the following buttons:

Button Description
= Print a plot
[& Print preview a plot
Change a plot's options
) Go to a plot's home view
+ Activate Panning tool
Q Activate Zooming tool
@ Activate Display Properties tool
fasad Activate Measurement tool

Activate Point of Interest Computation tool

Activate Grid Computation tool

If you forget the purpose of a toolbar button, briefly hold the mouse cursor over it. A tooltip
window will appear, displaying a brief description of the button.

Y % 9ol

3.4. Status Bar

The status bar, located to the right of the toolbar, displays information that varies, depending on
the action you are currently performing.

e Ifyou are viewing a plot, the status bar displays the location of the mouse, and the grid data
level at that point. You can change the coordinate system used to display the mouse
location: see Section 21.4, Mouse Location Display Coordinates.

Location: lomg: TO6™ 7 12 22" W, lat: 327 52" 215" W
Moize: 65.3 DML

A Brief Tour of NMPlot 11



e [fyou are using the Measurement tool, the status bar displays the distance and heading
between two points on a plot. You can set the units used to display the measured distance:
see Section 21.3, Physical Units.

Digtance, P1 ta P2: 5623 ft Lacation, P1: lang: 106.12451 3 % lat 328420597 W
Heading, P2 from P1: 136.47 dearees Location, P2: lang: 1061718887 % lak 32.830897° W

e [f NMPIot is busy performing a lengthy operation, the status bar displays a message
describing the operation. If possible, it also displays a progress bar showing the percentage
of the operation completed.

[T ENNENNENEENERNEEEE | Loading fie background bp

3.5. North Indicator

The north indicator shows the direction of north on a plot.

6

To display the exact direction of north, briefly hold the mouse cursor over the north indicator. A
tooltip window will appear, displaying the direction of north in degrees.

A

|The direction of north iz 45 degrees clockwize from the top of the map.|

When NMPIlot is busy performing a lengthy operation, the north indicator is replaced with an
animated image of a stopwatch.

3.6. Workspace

The workspace occupies the entire NMPlot application window below the toolbar. When you
open a file, a new document window appears in the workspace. Any number of document
windows can be open simultaneously.
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A document window can be moved and resized in the workspace. Alternatively, it can be
maximized so that it fills the entire workspace.

Use the Window menu to manage document windows.

3.7. Document Title Bar

The title bar of a document window is similar to the title bar of an application. It displays the
document icon, the document file name, and buttons to maximize and close the window.

At any given time, one document window is active. The active window will appear in front of
other document windows, and the text on its title bar will be darker. The active document is the
focus of your actions: all mouse, keyboard, toolbar, and menu activity is directed to it. In order to
work with a document, you must first activate it.

To active a document window, you can:
e Click on the document window title bar.
e Choose from the list of open documents at the bottom of the Window menu.

e Repeatedly choose Next View or Previous View from the Window menu until the desired
window becomes active.

e Repeatedly press F6 or Shift + F6 until the desired window becomes active.
To maximize a document window, you can:

e Press the maximize button Bl on the document title bar.

e Double-click on the document title bar.

e Choose Maximize from the Window menu.
To restore a maximized document window, you can:

e Press the restore button £l on the document title bar.

e Double-click on the document title bar.

e Choose Restore from the Window menu.

To close a document window, you can:

A Brief Tour of NMPlot 13



Press the close button Xl on the document title bar.

Choose Close from the File menu.

3.8. Plot Document

When you create a new plot, or open an existing one, NMPlot displays it in a plot document
window. See Chapter 7, Introduction to Plots, for an overview of the plot window.

When a plot document is active, you can:

Zoom, pan, measure, and display properties of the plot. See Chapter 8, Working With Plots.

Modify the plot's options, which control how the plot appears. See Chapter 9, Contour
Plots, Chapter 10, Color Gradient Plots, Chapter 11, Displaying Grid Data Points, and
Chapter 12, Displaying Geographic Annotations.

Modifty the plot's background, displaying the plot over background maps and plots of other
grids. See Chapter 13, Changing the Plot Background, and Chapter 14, Background Map
Formats.

Print the plot. See Chapter 15, Printing Plots.

Export the plot to a Geographic Information System (GIS). See Chapter 17, Exporting Plots
to a Geographic Information System.

Export the plot as a bitmap image. See Chapter 18, Exporting Plots as Bitmap Images.

3.9. Grid Document

When you open a grid file, NMPIot displays it in a grid document window. This window shows
you the contents of the grid file, as described in Chapter 5, Viewing Grids. Additional
background information about grids can be found in Chapter 4, Introduction to Grids.

When a grid document is active, the commands in the Grid menu are available, allowing you to
work with the grid. These commands are covered in Chapter 6, Working With Grids.
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Introduction to Grids

4.1. What is a Grid?

4.1.1. An Example

Imagine that you are assigned the task of creating a navigational chart for a lake. The chart must
accurately display the lake's depth at any location, so boaters can avoid dangerously shallow
areas. However, the depth of the lake has never been surveyed, so you will need to measure it
yourself.

You get a boat, sail to various points in the lake, and measure the depth. At each point, you
carefully mark your location on a map, and write the measured depth next to it. You have created
a model of the varying depth of the lake by sampling it at discrete points.

In the terminology of NMPIot, you have created a grid .

4.1.2. The Definition of a Grid

When you measure something that can be expressed as a single number (the length of a rope, the
weight of a brick), you are making a scalar measurement.

Often, a quantity being measured will vary depending on exactly where you measure it. Consider
the depth of a lake. It varies smoothly, starting from zero at the shoreline, typically increasing
towards the center. If you measure the depth near the shore, you will get a much different result
than if you measure it near the center. The depth is a scalar field : a measurable scalar quantity
that varies as a function of the measurement location. The world is full of scalar fields. Examples
include the water temperature of the sea and the elevation of the Earth's surface above sea level.

Engineers and scientists often want to record and analyze scalar fields. This can rarely be done
with perfect accuracy. Usually, the best that can be done is to record measurements made at a
number of discrete locations. If enough measurement locations are used, the field can be recorded

Introduction to Grids 15



to an acceptable level of accuracy. Such a set of measurements, along with any auxiliary
information (such as the units of measurement), is defined as a grid. Each measurement is called
a grid point, or alternatively, a data point.

Using a grid, it is possible to compute a data value at any point by interpolating or extrapolating
from the grid's data points. The data value is the best estimate, using the information in the grid,
of the value of the scalar field at that location. If the distribution of grid points is adequate, the
data value will be close to the scalar field's actual value.

The term grid comes from the fact that measurements are often taken at regularly-spaced
locations defined by a two- or three-dimensional rectangular grid. However, this is not a
requirement. Sets of measurements taken at arbitrary locations are also considered grids.

4.1.3. NMPIlot Works With Two-Dimensional Georeferenced Grids

NMPlot works with a specific type of grid: one that characterizes a scalar field that varies with
geographic location. Such grids are two-dimensional: a measurement location can be specified by
two numbers. Furthermore, the grids are georeferenced, which means that we know where on the
surface of the Earth that the measurement points are located. In practice, this means that it is
possible to determine the longitude and latitude of each measurement location.

NMPIlot cannot process three-dimensional grids, such as a set of air temperatures measured
throughout the atmosphere. If can, however, work with a series of grids measuring the air
temperature at a height of 1000 feet, 2000 feet, etc.

4.1.4. Additional Examples of Grids
The following are all examples of grids that NMPlot can work with.

e The level of an air pollutant measured at sampling stations located throughout a city.
e The predicted noise level surrounding an airport, as calculated by an airport noise model.
e The level of insect infestation observed at farms located throughout a state.

e Tomorrow's predicted high temperatures at various cities, as predicted by a weather
forecast.

e The relative humidity measured at 1000 feet above ground level.
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4.2. Parts of a Grid

A grid is composed of the following parts.

4.2.1. Data Points

Certainly, the most important part of a grid is the set of data points. Each data point consists of
three numbers: two for the geographic location of the point on the Earth, and one for the data
value at that location.

In practice, the location of each data point may not be explicitly stored in the grid. For example,
the data points may be stored as a two-dimensional regular grid. In this case, only the dimensions
and location of the grid needs to be specified. The location of individual data points can be
calculated from this information. Of course, if the data points are irregularly distributed, with no
pattern to their locations, then the location of each point must be explicitly included in the grid.

4.2.2. Coordinate System

A grid's coordinate system specifies how to interpret geographic coordinates. It georeferences the
grid, defining how to relate a given geographic coordinate in the grid with a location on the
Earth.
Examples of coordinate systems include:

e [ongitude and latitude

e Universal Transverse Mercator (UTM)

e Meters east and north of the Empire State Building

4.2.3. Data Metric

A grid's data metric specifies what is being measured by the data points in the grid, and what
physical units are used.

Examples of data metrics include:
e Air temperature, measured in ° F
e Noise level, measured in dB

e Grasshopper population density, measured in grasshoppers/m?
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4.2.4. Valid Data Limits

A grid's valid data limits define the minimum and maximum data levels that are considered
valid. Any data points with values outside these limits are considered invalid, and should not be
used in calculations.

If the data points in a grid are stored as explicit location-value pairs, invalid data can simply be
excluded from the grid. However, if the data points are stored as a two-dimensional rectangular
grid, there is no easy way to exclude invalid points. In this case, invalid points are given an
extreme value, far beyond the limits of actual valid data, and the valid data limits are set so that
the extreme value is recognized as invalid.

Invalid data points are common. It is rare that a large data set is collected without error.
Instruments malfunction. Mistakes are made.

Invalid data points can also be generated by computer models. As an example, consider
NOISEMAP, the United States Air Force's airport noise model. NOISEMAP writes a large
two-dimensional grid of predicted noise levels. For data points located far from where airplanes
fly, NOISEMAP does not perform calculations, but simply writes the value -50 dB into the grid.
This value is invalid, in the sense that it does not represent a prediction. It simply means that no
calculations were performed at those points.

8 Tip:

An informal convention in science and engineering is to use large positive or negative
numbers consisting entirely of the digit nine (-999, 9999, etc.) to denote invalid data. Be
suspicious of any data of this form.

4.2.5. Defined Area Polygon

The defined area polygon is the area inside which a grid accurately records a scalar field. A grid
is a record of a continuous smoothly-varying scalar field, made by measuring it at discrete points.
Using the grid, you can compute an approximation of the original scalar field at any location by
interpolating or extrapolating from the measured points. The defined area polygon specifies the
area where it is wise to do so. It is the portion of the Earth's surface where a grid adequately
describes a scalar field.

Any calculations using the grid should be restricted to locations inside the defined area polygon.
For example, if a contour plot of the grid is displayed, no contours should be drawn outside of
the defined area.

In practice, extrapolation is often unreliable. Therefore, as a rule of thumb, the defined area
polygon equals the area where it is mathematically possible to perform interpolation. This area is
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known as the convex hull of the data points. The convex hull is the smallest convex polygon that
completely encloses a set of data point locations.

In some cases, even interpolation is unreliable. Consider the arrangement of data points in Figure
4.1. While it is possible to interpolate values in the area marked A, it may be unwise to do so, as
the results may be inaccurate. Most likely, you would like interpolation to be restricted to the
area surrounded by the dashed line.

- Data Point
ms — Convex Hull of Data Points
- The Mo=t Appropriate
Defined Area Polygon

Figure 4.1 An arrangement of data points for which the convex hull would be an inappropriate defined area polygon.
Although we could interpolate between the data points in the area marked A, it may be unwise to do so, as it may
yield inaccurate results. Most likely, we would like the defined area polygon to equal the area marked by the light

gray dashed line.

If we draw contours based upon this set of data points, they should be restricted to the defined
area polygon, as shown in Figure 4.2.

Introduction to Grids 19



- Data Point
- Defined Area Polygon \
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Figure 4.2 Contours should be clipped to the defined area polygon (i.e., the area in which interpolation can be
reliably performed).

The defined area polygon is an optional part of a grid. If it is not present, then the default defined
area polygon, defined by the convex hull of the data points, should be assumed.

4.2.6. Geographic Annotations

Geographic annotations comprise any relevant map data stored in a grid. While optional, such
data can be of value in working with the grid. For example, in a grid of air pollutant readings
around an industrial site, it would be useful to include the site boundary. A plotting program
could then draw the boundary when creating a contour plot of the grid, and an analysis program
could warn if any off-site readings were above the legal limit.

Such map data can also be stored in an external file. Storing it directly in a grid is simply an
organizational convenience. As a rule of thumb, only map data that is particularly relevant to the
grid should be stored internally. Extensive general-purpose map data should be stored in external
files.

4.2.7. Bookkeeping Information

Bookkeeping information consists of any additional information that may be useful to include
with a grid. Examples of bookkeeping information include:
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A detailed description of the data in the grid

The time and date when the grid was created

Contact information for the person or organization responsible for the grid

For measured data, a description of the instruments and procedures used to collect the data

For data produced by a computer model, a description of the model, and of any parameters
and input files used to run it
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Viewing Grids

5.1. Opening a Grid
To open a grid in NMPlot, follow these steps.

1. Choose Open from the File menu. The standard Windows dialog box for opening files is
displayed. Familiarity with the use of this dialog box is assumed.

2. Navigate to the directory where your grid file is located, then open the file. Grid files
typically have the extension .grd.

3. A Grid Document window appears, displaying the contents of the grid.

5.2. The Grid Document Window

The Grid Document window displays the contents of a grid. The window has two panes. The
Summary pane displays a concise summary of the grid. The Details pane displays an exhaustive
list of the grid's contents.

Use the tabs at the top of the window, just below the title bar, to switch between the two panes.
To display the Summary pane, click on the tab labeled Summary, or press Alt + S. To display the
Details pane, click on the tab labeled Details, or press Alt + D.

5.3. The Summary Pane

The Summary pane of the Grid Document window displays a summary of a grid in report form.
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“Sample Grid - Airport Hoize_grd™ EIEI

Sumrnary Igetails |

Summary of Grid "Sample Grid -
Airport Noise.grd"

Description of Grid
Noise at Holloman A Force Base

Meoize at Holloman Aar Force Base, INew desco, as calculated
by NOISEMAP 6.0, the Tted State's Air Force's Awrport Moise
Idodel

Metric

This grid contains Noise data m units of dB DINL. |

You can scroll through the report, print it, and save it as an HTML document. See Section B. 13,
Document Display Control, for details.

See Appendix C, A Sample Grid Summary Report, for a sample summary report.

5.4. The Details Pane

The Details pane of the Grid Document window displays a complete list of the contents of a grid.
It is intended for advanced users who need more detail than the Summary pane provides. If you
are just learning NMPlot, it is recommended that you skip this section, and return to it if you later
find that the Summary view does not provide enough information.

5.4.1. The Noise Model Grid Format (NMGF) Standard

In order to use the Details pane, you will need to understand the Noise Model Grid Format
(NMGF) standard. NMGF is a documented way of representing a grid and its auxiliary
information as a group of named sections. An introduction to NMGF is available in Appendix F,
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Introduction to the Noise Model Grid Format. Complete NMGF documentation is available from
the NMGF web page, http://wasmerconsulting.com/nmgf.htm.

Internally, NMPIlot processes all grids using NMGF. If you open a grid file that is stored in a
format other than NMGF, NMPlot will automatically translate the data into the NMGF format as
it reads the file.

The Details pane displays the grid as raw NMGF sections.

“Sample Gnd - Awrport Hoize_grd™ EIEI

Eumma[_lrl Qetails |

MMBGF Sectionz in "Sample Grid - Airport M oize.grd"

= [=| TITL - Beginning of MMBGF filz -
« |U% CART - Specify local =% coordinate spstem j
SORC - Source of grid data = Model
o E GTSH -Yald data point walue limits - Lower = -40, pper = 3.9E9
o MTRLC - Grid Metric - Meazuning Maoize in unitz of dB DRHL
= PHTS - Single-Paint Geographic Feature, Category = Point of Interest, Mame = 654
o |:| DESS - Mamedshort description = 65,
on PHTS - Single-Point Geographic Feature, Categony = Point of [nterest, Mame = 674
qn FHTS - Single-Paint Geographic Feature, Category = Point of Interest, Mame = HUD
qn PHTS - Single-Paoint Geographic Feature, Categorny = Paint of Interest, Hame = 5P
on PHTS - Single-Point Geographic Feature, Cateqaory = Mavigational &id, Mame = 165 ;I

Contentz of HMBGF sechon PHTS

Foint Category : Point of Interest
Foint Location : (78046, 189345}

5.4.2. The NMGF Section List

The top portion of the Details pane lists all NMGF sections in the grid. Each item in the list
represents a section. Here is an example.

L] E LIMS - Line Geographic Feature, Categomy = Flight Track, Hame = 1641
For each NMGF section, five pieces of information are displayed, from left to right.

1. A symbol indicating the presence of subsections. A small dot = indicates that the section
does not have subsections. A plus sign ¥ indicates that the section has subsections.
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2. An icon for the section type. In the example above, the icon is Bl
3. The four-letter name of the section type. In the example above, the four-letter name is LINS.

4. A short description of the section type. In the example above, the short description is Line
Geographic Feature.

5. A summary of the data stored in the section and its subsections. In the example above, the
summary is Category = Flight Track, Name = 16A1.

Click on the plus sign to the left of the section to view its subsections. The subsections will be
displayed.

= E| LIMS - Line Geographic Feature, Categomy = Flight Track, Mame = 1641
- |:| DESS - Mame/shart description = 1641
- |:| DESL - Long descrption = Straight-in arrisal
@ @ ATRS - String Attribute - Track Tvpe = Approach
= [A] ATRS - Sting Attribute - Rurway = 16

One section in the list is always selected. This section is highlighted with a different background
color. Click on a section to select it.

5.4.3. The NMGF Section Browser
The bottom portion of the Details pane contains the section browser. It displays the contents of

the section currently selected in the section list.

You can copy text from the browser window to the clipboard. To do so, first select the desired
text by dragging over it with the mouse. Then, copy the text by either a) choosing Copy from the
Edit menu, or b) pressing Ctrl + C.

5.4.4. Resizing the Section List and Section Browser

To change the relative sizes of the section list and section browser windows, use the mouse to
drag the separator between the two windows.
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Chapter
Working With Grids 6

Using NMPlot, you can modify grids in a variety of ways. As an analogy, consider a word
processor, which allows you to open, view, edit, save, and rename word processing documents.
NMPIlot allows you to work with grid files in a similar fashion.

Typically, you will open a grid, modify it by choosing commands from the Grid menu, and then
save it by choosing either Save or Save As from the File menu.
& Tip:

If you are modifying a grid, but want to preserve the original grid file unchanged, it is
recommended that you follow these steps.

1. Open the grid you want to modify.

2. Choose Save As from the File menu, and save the grid using a new name.
3. Make your modifications to the grid.

4. Choose Save from the File menu to save your modifications.

This does introduce an extra step that is not strictly necessary: you could skip the second
step and simply choose Save As after making your modifications. However, it is all too easy
to forget and choose Save instead, overwriting the original grid file with the modified
version.

When NMPIlot modifies a grid, it updates the grid's bookkeeping information with a description
of the modifications. The original bookkeeping information is preserved, resulting in an audit
trail of changes made to the grid.
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6.1. Adding a User-Supplied Value to a Grid

NMPIlot allows you to add a user-supplied constant to the value of every data point in a grid. To
do so, choose Add Value to Grid from the Grid menu. The Add Value to Grid dialog box appears.

Add Value to Grid 2] =l

Walue to add to all data points:

e

ak

Type the value to add, then press OK. The grid is immediately modified.

Invalid data points (i.e., data points with values outside the valid data limits) are not changed.

6.2. Multiplying a Grid by a User-Supplied
Value

NMPIlot allows you to multiply the value of every data point in a grid by a user-supplied
constant. To do so, choose Multiply Grid by Value from the Grid menu. The Multiply Grid by Value
dialog box appears.

Multiply Grid by Yalue 2 x|

Walue ko multiply all data pointz by

et

ak

Type the value to multiply by, then press OK. The grid is immediately modified.

Invalid data points (i.e., data points with values outside the valid data limits) are not changed.
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6.3. Merging Two Grids

Merging refers to creating a new grid that contains the data points from two or more existing

Grid 2

Merged grid containing all
points from both original grids

grids.
Grid 1

| | | | | | | | | | | | n n n
| | | | | | | | | | | | n n n
| | | | | | | | | | | | n n n
| | | | | | | | | | | | n n n
] ] ] ] ] ] u u u
] ] ] ] ] ] u u u
u u u u u u L] L] L]

] ]

| | | |

| | | |
| |
| | | | | |
| |
| | | | | |
» - Grid Point = = .

For example, assume that you are modeling the noise levels around an airport with a noise
analyses program that can only generate regular rectangular grids. To model the noise adequately,

you generate two grids.

The first grid captures the gross structure of the noise over a large area around the airport. It
covers an area 20 miles across with a resolution (i.e., a distance between adjacent data points) of
1000 feet. The second grid captures the fine structure of the noise near the airport. It covers an
area only two miles across with a finer resolution of 100 feet.

Using NMPlot, you merge these two grids into a single grid. You then plot noise level contours
based upon this merged grid. This plot adequately displays the noise levels at all scales of

interest.

O Caution:

Do not confuse merging grids with combining grids. To insure that you choose the correct

action, you should review Section 6.4, Combining Two Grids.

Working With Grids 29



6.3.1. Step-by-step Guide To Merging Grids

To merge two or more grids, follow these steps.
1. Open the first grid.
2. Choose Save As from the File menu, and give the grid a new name.

3. Choose Merge Grids from the Grid menu. The Merge Grids dialog box appears.

Merge Grids llil
File containing zecond gnd, which will be merged with the current gnd:
Sample Gnd - Airport Moize. grd J
Ok

4. Type the name of the file containing the second grid. Press the Browse button J, located
to the right of the text box, to display the Open File dialog box, which allows you to browse
for the file.

5. Press OK. The data points from the second grid are merged into the first grid.
6. Repeat steps 3 through 5 for any additional grids you want to merge.

7. Choose Save from the File menu to save the merged grid.

6.3.2. Merging Grids With Different Metrics

If you merge two grids with different metrics or physical units (for example, trying to merge a
data set of noise levels with a data set of air pollutant levels), a warning is added to the merged
grid.

O Caution:

NMPIlot does not prevent the merging of grids with different metrics. The decision to allow
this was a pragmatic one. It is not uncommon for the same metric to be referred to by
different names. For example, one person might refer to the outside temperature as "Air
Temperature", while another might use "Ambient Temp.". To facilitate the merging of
grids from different sources, NMPlot allows you to merge grids with different metrics. You
are responsible for determining whether the metrics are equivalent.
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6.3.3. Merging Grids That Cover Different Geographic Areas

NMPlot can merge any two grids. The geographic area covered by the two grids can overlap
totally, partially, or not at all. The grids can have different coordinate systems.

6.3.4. The Merged Grid's Defined Area Polygon

The defined area polygon of the merged grid is equal to the union of the two original grids'
defined area polygons. That is, the new defined area polygon consists of the geographic area in
the first grid's defined area polygon, the second data grid's defined area polygon, or both.

Grid 1 Grid 2

" = = Iﬁ
| | | | | | | | | | | | | | n n n n n
| | | | | | | | | | | | | | n n n n n
| | | | | | L] L] L] L] L] L] n n n
| | | | | | n n n
u ] ] ] u u u
L] u u u L] L] L]
Merged grid
] ] ] u u u
#II | | IITI n n n
| | | | | | | | | | n n n n
L] L] | | | | | | L] n n n
= - Grid Point |' i
—— - Defined Area = wuan =
Pnl}pgnn L O | [ I I |

6.3.5. Geographic Annotations
NMPIlot does not merge geographic annotations. This capability may be added in the future.

6.4. Combining Two Grids

Combining refers to creating a new grid by performing a mathematical operation, such as
addition or subtraction, on the data points in two existing grids.
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Grid 1 Grid 2

8 7 9 2 4 5
5 6 7 3 2 2
6 9 4 1 4 4

Combined Grid, Equal
To Grid1 - Grid 2

[ 3 4
2 4 5
5 5 0

The small numbers represent grid points

As an example, assume that you have two grids. The first represents the existing levels of an air
pollutant across a city, while the second represents the predicted levels a few years in the future,
after several proposed changes have been made at local factories. You use NMPlot to subtract the
first grid from the second, and display the combined grid using contours on a background map of
the city. This contour plot clearly indicates whether a particular neighborhood can expect its air
quality to improve or deteriorate.

O Caution:

Do not confuse combining grids with merging grids. To insure that you choose the correct
action, you should review Section 6.3, Merging Two Grids.

6.4.1. Step-by-step Guide To Combining Two Grids

To combine two grids, follow these steps.
1. Open the first grid.
2. Choose Save As from the File menu, and give the grid a new name.

3. Choose Combine Grids from the Grid menu. The Combine Grids dialog box appears.
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Combine Grids llil

File containing zecond grid, which will be combined with the current gnd:

I Sample Grid - Airpart Maige. grd J

kethod to uze to combine the data poinks:

| 4dd tthmetically (F1 + P2) =l

The defined area polygon af the new grid zhould be...

I thie interzection of the bwo existing ards’ defined area polygons j

[rata points from the curent and that are outzide the second and's defined area polygon should. .

I not be included in the new grid j

Data paints from the second gnd that are outside the current and's defined area polygon should...

I not be included in the new gnd j

|f & data paint in the current arid is located within |1 m af the clozest data paint

in the second grid, the data pointz are considered to be at essentially the same location, and
anly ane will appear in the new grid.

ak.

4. Type the name of the file containing the second grid. Press the Browse button J, located
to the right of the text box, to display the Open File dialog box, which allows you to browse
for the file.

5. Select the method for combining the grids. You have three options. In the list of options, P1
and P2 represent grid data values from the first and second grids being combined,
respectively.

e Arithmetic addition (P1 + P2)
e Arithmetic subtraction (P1 - P2)
e Addition of noise decibels (10 Log,, (10°"/1?+ 107%1%))

6. Select the method for computing the combined grid's defined area polygon. You have two
options.

e [ntersection - The combined grid's defined area polygon is the area covered by both of
the two existing grids' defined area polygons. This is the recommended option for
most situations.

Working With Grids 33



—— First Grid"s Defined Area Polygon

— Second Grid's Defined Area Polygon

[ Intersection of the Two Grids"
Defined Area Polygons

e Union - The combined grid's defined area polygon is the area covered by either or both
of the two existing grids' defined area polygons.

—— First Grid"s Defined Area Polygon

— Second Grid's Defined Area Polygon

[ Union of the Two Grids' Defined
Area Polygons

7. Select how to handle a grid's data points that are outside the defined area polygon of the
other grid. You have two options.

e Do Not Include The Points - The data points are discarded. This is the recommended
option for most situations.

e [nclude the Points Unchanged - The data points are included in the combined grid.
Their values are not changed.

8. Type the minimum tolerance distance that must separate two data points in order for them
to be considered distinct. If a data point in one grid is located within the tolerance distance
of a data point in the other grid, the data points are considered to be at the same location. In
this case, only one will appear in the combined grid.

Typically, the tolerance distance should be set to a small value: 1 meter is a reasonable
default value. However, there are situations where you may want to use a larger tolerance. It
is recommended that after combining grids, you create a plot of the combined grid and
display its grid points. You may see spurious points.

* % % % *
% % % % %
% % % % %
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If this happens, use the Measurement tool to measure the distance between the pairs of
points, and set the tolerance to a somewhat larger distance. Then recombine the grids. The
spurious points should be gone.

+ + + + +
+ + + + +
+ + + + +

9. Press OK. The data points from the second grid are combined with those in the first grid.

10. Choose Save from the File menu to save the combined grid.

6.4.2. Combining Grids That Cover Different Geographic Areas

NMPIlot can combine grids that do not have identical data point locations. In this case,
interpolation is used to combine the two grids. The geographic areas covered by the two grids do
not have to be identical. However, there must be at least some overlap between them. The grids
can have different coordinate systems.

6.5. Creating a Plot of a Grid

If you are viewing a grid, you can easily create a plot of it by choosing Create Plot Of This Grid
from the Grid menu.
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Introduction to Plots

A plot is a graphical representation of a grid that displays a combination of the following
elements.

e A set of contours representing the grid's scalar field

e Smoothly varying gradients of color representing the grid's scalar field
e A map of the location of the grid's data points

e The grid's geographic annotations

e A background map

This chapter discusses the basics of creating and configuring plots. Later chapters discuss the
various elements of a plot in detail.

7.1. Creating a New Plot

To create a new plot, follow these steps.

1. Choose New from the File menu, then choose Plot. The New Plot dialog box appears.
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Mew Plot

¥ [Create plot of a grid
Enter the name of the gnid file you wizh to dizplan;

2l x|

Sample Gnd - Airport Hoize. grd

i~ Create plot showing only & backgraund map

Enter the map layers to dizplay:

Shiow O ptions
DLG laver 'Roads' "2 O ptions
DLG layer ‘Railroads' ¥ Optionz
DLG layver ‘Rivers and Lakes' 72 Cptionz

Add Layer | Femove Layer tove Upin Listl tove Down in Listl

ak

Cancel

A

2. Select the type of plot to create. You have two choices.

e Create plot of a grid - This is the most common choice. A contour plot of a grid will

be created.

Type the name of the grid file that you want the plot to display. Press the Browse
button J, located to the right of the text box, to display the Open File dialog box,

which allows you to browse for the file.

e Create plot showing only a background map - A plot will be created that shows one or
more background map layers. No grid file is required. This is useful for previewing the

contents of a map file.

Specity the background map layers that you wish to display. See Section 13.2,

Background Layers, for more information.

3. Press OK. A plot document window appears, displaying the new plot.

7.2. The Plot Options Dialog Box

To display the Plot Options dialog box, you can:

e Choose Options from the Plot menu.
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e Press the Options button =T on the toolbar.

Use the Plot Options dialog box to change a plot's appearance. All plot options are set from here.

Optionz for plot Unnamed. nmp ilﬁl

Option Cateqaories: Frirnary Grid Options
Bl ey Grid |
= [Conkours
= Levels ISampIe Gnd - Airport Moize.grd J
= Shiles
= Smoathing
= Label Locations
= Color Gradient
= Geographic Annotations
= Paints
= Lines
* Areas
Grid [ ata Points
Haorne Wigt
Orientation
Legend

File name of primary grid file:

o
o
o
o

= Background
2 Color
= Layers

k. Cancel Undo Page Apply

The left portion of the dialog box displays a list of option categories. One category in this list is
always selected. The right portion of the dialog box displays controls that allow you to change
the options in the selected category.

The Plot Options dialog box is a Multiple Page dialog box. See Section B.2, Multiple Page
Dialog Boxes, for more information.

7.3. The Primary Grid of a Plot
The purpose of a plot is to graphically display a grid, which is know as the plot's primary grid.

@ Note:

In addition to the primary grid, one or more additional grids may be displayed as
background layers. See Section 13.3, Overlaying Grids, for more information.
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NMPIlot assumes that the primary grid is stored in a file. When a plot is created, you are
prompted for the name of the primary grid file. If you later want to change the primary grid,
follow these steps.

1. Display the Primary Grid page of the Plot Options dialog box.

File name of primary grid file:
ISampIe Gnid - Airpart Moige. grd J

2. Inthe box provided, type the name of the grid file containing the primary grid. Press the

Browse button J, located to the right of the text box, to display the Open File dialog box,
which allows you to browse for the file.

To display a plot's primary grid, choose Display Primary Grid of this Plot from the Plot menu.
NMPIlot will open the primary grid and display a summary of it. See Chapter 5, Viewing Grids,
for more information.

7.4. Saving a Plot

You can save a plot to a file, referred to as a plot file . All options on the Plot Options dialog box
are saved. Plot files typically have the extension . nmp, which is short for NMPlot Plot.

To save a plot, choose either Save or Save As from the File menu.

7.5. Opening a Plot

To open a plot that has been saved to a file, follow these steps.

1. Choose Open from the File menu. The standard Windows dialog box for opening files is
displayed. Familiarity with the use of this dialog box is assumed.

2. Navigate to the directory where your plot file is located, then open the file. Plot files
typically have the extension .nmp.

3. A Plot Document window appears, displaying the plot.

NMPIlot can read all previous versions of plot files.
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Working With Plots

8.1. Mouse Location Displayed On Status Bar

To determine the geographic coordinates of a location on a plot, point to that location with the
mouse. The coordinates are displayed on the status bar. You can change the coordinate system
used to display the location: see Section 21.4, Mouse Location Display Coordinates.

Location: long: 1067 7' 12.22" W, lat; 327 52" 215" N
Moize: B5.3 DML

If the location is within the primary grid's defined area polygon, the data value of the grid at that
location is also displayed. If the location is between grid data points, two-dimensional
interpolation is used to compute the data value.

If the location is outside the primary grid's defined area polygon, dashes ---- are displayed for the
data value.

The coordinates and the data value are automatically updated as the mouse is moved.

8.2. Mouse Tools

NMPIlot provides a number of tools for working with plots. For example, the Measurement tool
allows you to measure the distance between two points on a plot.

To use a tool, you must first activate it by pressing its button on the toolbar. When the mouse
cursor is over a plot, the cursor changes shape to indicate which tool is active.

The tools are described in detail in this chapter.

Working With Plots 41



8.3. Zooming and Panning

Zooming refers to increasing or decreasing the magnification level at which a plot is displayed.

"Example Plot.nmp" O] x| "Example Plot.nmp” 0] x| "Example Plot.nmp” O] x|

_J
—

A Sample Plot A Sample Plot After Zooming In A Sample Plot After Zooming Out

Panning refers to moving a plot horizontally or vertically, so that previously hidden portions of
the plot become visible.

"Example Plot. nmp" Qlil "Example Plot.nmp" QIEI "Example Plot.nmp™ QIEI

[\

A Sample Plot A Sample Plot After Panning Up A Sample Plot After Panning Right

8.3.1. The Zoom Mouse Tool

Activate the Zoom mouse tool by pressing its button QL on the toolbar. When the Zoom tool is
active, you can:

e Zoom in by clicking on a plot with the left mouse button.

e Zoom out by clicking on a plot with the right mouse button.
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8.3.2. The Pan Mouse Tool

Activate the Pan mouse tool by pressing its button < on the toolbar. When the Pan tool is active,
you can pan the plot the clicking with the left mouse button. The point that you click upon is
shifted to the center of the plot window.

Clicking near the center of the plot window will cause the plot to pan a small amount. Clicking
near the edge of the plot window will cause the plot to pan a larger amount.

8.3.3. Dragging a Rectangular Area of Interest

When either the Zoom or Pan tool is active, you can drag a rectangular area using the left mouse
button. The plot is zoomed and panned so that this area fills the plot window.

8.3.4. Using the Mouse Wheel

If your mouse has a wheel button, you can use it to zoom and pan the plot.
Roll the wheel forward to zoom in. Roll the wheel backward to zoom out.

Pan by pressing and holding the wheel button. A small marker [#] appears at the point where you
press the button. While holding the button down, move the mouse cursor away from the marker.
The plot pans in the direction that you move the mouse. The farther the mouse is from the
marker, the faster the plot pans. Release the mouse button to stop panning.

Alternatively, click and release the wheel button. NMPlot enters panning mode. Move the mouse
to pan the plot. Exit panning mode by clicking the wheel button a second time.

g Tip:

You can zoom and pan using the mouse wheel regardless of which mouse tool is active.
This provides you with a convenient way to zoom and pan while using the other mouse
tools.

8.3.5. Keyboard Shortcuts

The following keyboard shortcuts allow you to pan and zoom a plot regardless of which mouse
tool is active.
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Key Action

T Pan up

ctri+ T Pan up faster
d Pan down

ctrl+ Pan down faster
«— Pan left

Ctrl + < Pan left faster
- Pan right

Ctrl + = Pan right faster
+ Zoom in
- Zoom out

8.4. The Home View

When a plot is first displayed, it is automatically zoomed and panned so that the "interesting"
features of the plot (the contours, the geographic annotations, etc.) fill the plot window. This is
called the home view.

If, after scrolling and zooming, you wish to return to the home view, you can:
e Press the Home View button &} on the toolbar
e Press the Home key

To change the home view of a plot, follow these steps.

1. Display the Home View page of the Plot Options dialog box.
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Horme wiew iz of...
& Specified Plot Elements
V¥ Contours
[ Frimary Grid
[T Defined Area Palyaaon
[ Geographic Annotationz
[ Background Map

' Manually Specified frea

The manually zpecified home view iz defined by the paintz. .

( [-100 |00 J .and..
[ ]100 100 )

...in the coordinate system...

I Frimary Grid's Coordinate System j

2. Select the method for computing the home view. You have two choices.

e Specified Plot Elements - The home view fills the plot window with the selected parts
of the plot. You may choose any combination of the following parts.

e The contours

e The primary grid's data points

e The primary grid's defined area polygon

e The primary grid's geographic annotations
e The background map layers

e Manually Specified Area - The home view fills the plot window with a rectangular
portion of the plot defined by two points that you specify. Enter the coordinates of two
points that define opposite corners of this rectangle. Select the coordinate system used
to specify these points. You have two choices.

e The primary grid's coordinate system

e Longitude and latitude, specified in decimal degrees east and north. Note that
west longitudes are negative
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8.5. Plot Orientation

Following mapping conventions, plots are typically displayed with north at the top. However,
NMPIlot allows you to display plots at any orientation. To set the orientation of a plot, follow
these steps.

1. Display the Orientation page of the Plot Options dialog box.

Marth an the plat iz...
Up

Dot
Tothe left
To the right

Ak a angle of...

ID deqrees

2. Select the direction of north. If you select A¢ an angle of, type the direction of north, in
degrees clockwise from the top of the plot.

7YY W

The north indicator at the bottom of the dialog box page displays the direction of north that you
have selected.

8.6. The Display Properties Mouse Tool

Use the Display Properties tool to display information about objects in a plot. Activate the tool
by pressing its button @ on the toolbar. Click on an object in a plot to display the Properties of
Selected Object dialog box, which shows information about the object.
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Properties of zelected object llil

Line Geographic Feature

Category = Flight Traclk

Hame = 2G5DT

Description = Transient left turn departure.
Traclk Tyvpe = Departure

Funway = 2§

LCopy to Clipboard |

To copy the information to the clipboard, press the Copy to Clipboard button. To copy only a
portion of the text, select it (by dragging over it with the mouse) before pressing the button.

8 Tip:

If you click upon a contour, NMPIlot displays the area inside the contour. You can change
the units used to display the area: see Section 21.3, Physical Units.

@ Note:

NMPIlot cannot display information about objects in background layers.

8.7. The Measurement Mouse Tool

Use the Measurement tool to measure the distance and angle between two points on a plot.
Activate the tool by pressing its button ¥ on the toolbar. To measure the distance between two
points, press and hold the left mouse button over the first point, then move the mouse to the
second point. The status bar displays the coordinates of the two points, the distance between
them, and the directional heading from the first point to the second.

Digtance, P1 ta P2 B.E23 ft Lacation, P1: long: 106124513 W lat: 32.842059° N
Heading, P2 fram P1: 136.47 dearees Lacation, P2: long: 106111888 W lat: 32830897 M

You can change the coordinate system used to display the location of the two points: see Section
21.4, Mouse Location Display Coordinates.

You can change the units used to display the distance between the two points: see Section 21.3,
Physical Units.
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The heading is the direction of the second point as seen from the first point, measured in degrees
east of true north.

8.8. The Point Of Interest Computation Mouse
Tool

Use the Point of Interest Computation tool to perform a detailed analysis of the conditions at a
specific location on a plot. In order to use this tool, the plot's primary grid must have been
created by a third-party numerical model supported by a client-specific extension to NMPlot.
Point of Interest extensions have been developed for the following models.

e NOISEMAP 7.0, the United State Air Force's airport noise model

To use the Point of Interest Computation tool, follow these steps.

1.

2.

Activate the tool by pressing its button "= on the toolbar.

Using the left mouse button, click on a plot at the location where you want to perform the
point of interest analysis.

. A client-specific dialog box may appear, asking you for additional information. Enter the

requested information, then press the OK button. See Section 21.5, Client-Specific
Extensions, for more information.

NMPlot runs the appropriate third-party numerical model, instructing it to perform a
detailed point of interest analysis at the indicated location.

. The results of the analysis are displayed in the New Point of Interest dialog box.

The results of the analysis are added to the plot's primary grid as a point geographic
annotation. When you close the plot, you are given a chance to save the modified primary
grid in a file.

See Section 21.5, Client-Specific Extensions, for more information about client-specific
extensions to NMPlot. See Section 21.6, NOISEMAP 7.0 Client-Specific Extension, for more
information about the NOISEMAP 7.0 client-specific extensions.
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8.9. The Grid Computation Mouse Tool

Use the Grid Computation tool to increase the resolution of a grid by merging additional data
points into it. In order to use this tool, the plot's primary grid must have been created by a
third-party numerical model supported by a client-specific extension to NMPlot. Grid
Computation extensions have been developed for the following models.

e NOISEMAP 7.0, the United State Air Force's airport noise model

To use the Grid Computation tool, follow these steps.

1.

2.

Activate the tool by pressing its button & on the toolbar.

Using the left mouse button, drag a rectangular area on a plot where you want to increase
the resolution of the plot's primary grid . That is, move the mouse to one corner of the
rectangular area, press and hold the left mouse button, move the mouse to the opposite
corner of the rectangular area, and release the mouse button.

A client-specific dialog box may appear, asking you for additional information. Enter the
requested information, then press the OK button. See Section 21.5, Client-Specific
Extensions, for more information.

The Run New Grid dialog box appears.

Run new grid ilil

Enter the distance between adjacent gridpoints in the new gnid:
500 ft

ak

Type the resolution of the data points (i.e., the distance between adjacent data points) you
want to merge into the primary grid.

Press the OK button. NMPlot runs the appropriate third-party numerical model, instructing
it to create a new grid with data points distributed on a two-dimensional rectangular grid of
locations. The area covered by this new grid will be the rectangular area that you specified
using the mouse. The distance between adjacent data points will be the resolution you
specified in the Run New Grid dialog box.

The new grid is automatically merged into the primary grid, and the plot is updated.

When you close the plot, you are given a chance to save the modified primary grid in a file.
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See Section 21.5, Client-Specific Extensions, for more information about client-specific
extensions to NMPlot. See Section 21.6, NOISEMAP 7.0 Client-Specific Extension, for more
information about the NOISEMAP 7.0 client-specific extensions.

g Tip:

Use the Grid Computation tool to increase a grid's resolution in areas where a contour plot
of the grid appears ragged, or where the contours break up into unconnected islands. This
will often improve the appearance of the contours.
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Chapter

Contour Plots )

Contours are a powerful tool for visualizing a grid. Using NMPlot, you can easily create
publication-quality contour plots.

9.1. Primary and Secondary Contours

Consider the following contour plot.

Note that this plot has two different styles of contour lines. One is thick, black, and labeled with
the contour level. The other is thin, gray, and not labeled.

Typically, contour plots are drawn using two styles of contours. Primary contours are bolder and
often labeled. Secondary contours are subtler. There are usually several secondary contours
between every adjacent pair of primaries. This reduces clutter, and results in a plot that is both
informative and readable.
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However, there are situations where additional contour styles are required. An example is a plot
in which each contour is filled with a different color.

A

T ip:

Use additional contour styles to highlight contour levels of specific interest. The following
example plot uses conventional primary and secondary contours to show the terrain

elevation near a river. The river's flood plain is highlighted by an additional red-filled
contour.
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9.2. Displaying Contours
To display contours on a plot, follow these steps.
1. Go to the Contours page of the Plot Options dialog box.

W Show Contours

2. Check the box labeled Show Contours.

3. Visit the other contour pages of the Plot Options dialog box, and set the options as desired.

9.3. Contour Levels

To set the levels at which contours are drawn, follow these steps.

1. Go to the Levels page of the Plot Options dialog box.

Contour Plots
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¢ Automatically calculate contour levels

Approgimate number of primary levels: |5
Murnber of zecondary level: between each primary level: |1
' Manually specify contour levels
Lowest primary level: I 1] Highest: I 100
Spacing between primary lewvels: |1EI
Murnber af zecandary level: between each primary level: |1—

" Manually specify each contour level

Contour Lewel[z] Contour Skyle
ER, 75, 85 Frirmary Cantours >
70,80 Secondary Contours ™

Add Bow | Remove Row | tove Bow Lp ke Bow Down

2. Select how you would like to specify the contour levels.

e Automatically calculate contour levels - NMPlot inspects the data values in your grid,
and automatically chooses an appropriate set of contour levels.

1. Type the approximate number of primary contours that will be drawn. In order to
select an aesthetically pleasing set of levels, NMPlot may choose to display a
slightly different number of primary contours.

2. Type the number of secondary contours that will be drawn between every
adjacent pair of primary contours. Type zero to turn off the display of secondary
contours.

The primary and secondary contours will be drawn using the Primary Contours and
Secondary Contours styles, respectively. See Section 9.4, Contour Styles, for more
information.

e Manually specify contour levels - NMPlot calculates the contour levels based on a set
of conditions that you specify.

1. Type the levels of the highest and lowest primary contours.

2. Type the spacing between primary levels: i.e., the difference in levels between
adjacent primary contours. For example, if you specify 50, 90, and 10 for the
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lowest level, highest level, and spacing, respectively, NMPlot will draw primary
contours at the following levels: 50, 60, 70, 80, and 90.

3. Type the number of secondary contours that will be drawn between every
adjacent pair of primary contours. Type zero to turn off the display of secondary
contours.

The primary and secondary contours will be drawn using the Primary Contours and
Secondary Contours styles, respectively. See Section 9.4, Contour Styles, for more
information.

e Manually specify each contour level - Y ou explicitly specify the level and style of
every contour.

Enter one or more levels, and select the contour style associated with each. Press the
Add Row button to add another row to the table. Press the Remove Row button to
remove a row.

To associated more than one contour level with a particular style, type a list of levels,
separated by commas. For example, "10, 20, 30".

You can specify the levels in any order.

9.4. Contour Styles

NMPIlot gives you full control over the styles (color, thickness, labeling, etc.) of your contours.
The set the styles, follow these steps.

1. Go to the Styles page of the Plot Options dialog box.
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Stule Mane Line Calar Line “Afidth [mm)] Line F —
Primary Contaurs . Elack |06 _
Secondary Contours . D ark Gray =01 _—
Thick, with Labels I Black - |08 S
Thick without Labels I Black - |08 S
Thirn without Labels I Black - |02 —
Thin Dashed I Black - |02 - —
Thin Dotted Il Black ~|02 [
al | 2

Add Bow | Remowve Row | tove Row Lp | e Row Down |

2. Contour styles are displayed using a standard spreadsheet control, which functions much

like a spreadsheet such as Microsoft Excel. See Section B.7, Spreadsheet Control, for more
information on using spreadsheet controls.

Press the Add Row button to add a style. Press the Remove Row button to remove the style
that contains the selected cell.

Press the Move Row Up and Move Row Down buttons to change the order in which styles
are listed. The order is irrelevant to NMPIlot, but you may wish to list styles in a logical
order for organizational purposes.

@ Note:

Two styles, named Primary Contours and Secondary Contours, cannot be deleted.
These styles are used for the primary and secondary contours. See Section 9.3,
Contour Levels, for more information.

. Inthe Style Name column, type a unique, descriptive name for each of your styles.

@ Note:

You cannot change the names of the Primary Contours and Secondary Contours
styles.

. Inthe Line Color column, select the color of the lines used to draw your contours. See
Section B.10, Color Control, for information on selecting colors.

. Inthe Line Width column, type the width, in millimeters, of the lines used to draw your
contours. Typically, widths are between 0.2 to 1.0 millimeters.
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6.

10.

11.

In the Line Pattern column, select the dash pattern (dashed, dotted, solid, etc.) of the lines
used to draw your contours. See Section B.11, Line Pattern Control, for information on
selecting line patterns.

In the Label column, type the text used to label your contours. If you do not want the
contours labeled, delete the label text.

See Section 9.6, Contour Label Locations, for information on setting the locations where
contours are labeled.

The label can include symbolic fields, placeholders for text that is automatically inserted
when the label is displayed. For example, the field {Level} is automatically replaced with
the contour level.

Press the Insert Symbolic Field button ﬁl, located to the right of the text box, to display
a list of fields from which you can choose.

Some of the fields commonly used in contour labels are:

Field Description
{Level} Level of the contour being drawn
{Metric} Metric of the grid being plotted: i.e., what is being measured by
the grid
{Units} Physical units of the grid being plotted

See Section B.5, Symbolic Fields Text Control, for more information about symbolic fields.

In the Label Font column, select the font used to draw contour labels. See Section B.9, Font
Control, for information on selecting fonts.

. In the Fill Contour column, check the box to fill contours with a solid color. If this box is

not checked, only the contour line is drawn.

In the Fill Color column, select the color used to fill your contours. See Section B.10, Color
Control, for information on selecting colors.

NMPlot allows you to export a plot to a Geographic Information System (GIS) in a number
of common formats. Some GIS formats support the concept of named layers. In the Contour
Lines Layer Name and Contour Labels Layer Name columns, type the names of the layers
that contour lines and contour labels are exported in. To export to the default unnamed
layer, delete the layer name.
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9.5. Smoothing Contours

If the distance between data points in a grid is relatively large, then a contour plot of the grid may
contain sharp angles. NMPlot allows you to improve the appearance of these contours by
smoothing them.

Unsmoothed Contours Smoothed Contours

To smooth contours, follow these steps.
1. Go to the Smoothing page of the Plot Options dialog box.

Do not smooth contours

f*  Smooth contours

Tenzion: I 2
b airneim angle: I 3 deqrees
kinimum zegment length: |1 .

2. Select the Smooth Contours radio button.

3. Tension: Type the smoothing tension. NMPlot uses a smoothing method called Splines
Under Tension. Intuitively, you can imagine a contour as a rubber band. Without tension,
the rubber band curves smoothly. When pulled tight, the rubber band becomes straight.

You can set the tension to any value between 0.1 and 100. A tension of 1 or 2 will produce
nicely smoothed contours. Smaller values will make the contours more rounded. Larger
values will decrease the smoothing effect. Large tensions, above about 50, effectively
disable smoothing.

4. Maximum angle: When NMPIlot draws smoothed contours, what appears to be a continuous
curve is actually drawn as a large number of tiny straight line segments. Type the maximum
angle, in degrees, that is allowed between adjacent segments.

Decreasing the angle makes the contours appear smoother, but also increases the time
required to draw them. A value of 3 degrees is a reasonable compromise: it usually results
in contours that appear smooth to the naked eye.
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The Maximum Angle has the greatest effect on broadly curving contours.

5. Minimum segment length: When NMPIlot draws smoothed contours, what appears to be a
continuous curve is actually drawn as a large number of tiny straight line segments. Type
the minimum allowed length, in millimeters, of a line segment.

Decreasing this length makes the contours appear smoother, but also increases the time
required to draw them. A value of 1 millimeter is a reasonable compromise: it usually
results in contours that appear smooth to the naked eye.

The Minimum Segment Length has the greatest effect on sharply curving contours.

O Caution:

Use care when smoothing contours. While it does improve the appearance of a plot,
smoothing can give the impression that your grid has a finer resolution than it actually
does. Unsmoothed contours will not mislead you about the accuracy of your data.

9.6. Contour Label Locations

Use the Contour Label Locations page of the Plot Options dialog box to control where contour
lines are labeled.

™ Do not label contours

&' Position contour labels automatically

Crraw a label every I 15 cm. along contours

Select the Do not label contours radio button to turn off contour labeling.

Select the Position contour labels automatically radio button to turn on contour labeling. Type
the distance, in centimeters, between adjacent labels along each contour line.

See Section 9.4, Contour Styles, for information on setting the text used to label contours.

9.7. Contour Clipping

Use the Contour Clipping page of the Plot Options dialog box to control how contours are
displayed if they reach the edge of the grid.
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If & contaur reaches the edge af the and...
' Cloze contour by extending it along the edge of the grid
" Clip contour at the edge of the grid

Select Close contour by extending it along the edge of the grid if you want your contour lines to
always appear as closed polygons. If a contour reaches the edge of the grid, it will follow the
edge until it reaches the location where the contour reenters the grid.

Select Clip contour at the edge of the grid to stop contour lines at the edge of the grid. In this
case, the contours will form isolated line segments instead of closed polygons.

@ Note:

A grid's edge is defined by its defined area polygon: see Section 4.2.5, Defined Area
Polygon.

9.8. Contour Topology

Use the Contour Topology page of the Plot Options dialog box to control the topology of the
polygons that represent contours.

Contour T opolagy
& Overlapping polygons
" Adiacent nested ringz

Select Overlapping polygons to generate contour polygons with overlapping areas. For example,
if you draw contours with levels of 10 and 20, the contour polygon representing level 10 will
enclose all points with a grid value above 10.
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Select Adjacent nested rings to generate contour polygons with adjacent, non-overlapping areas.
For example, if you draw contours with levels of 10 and 20, the contour polygon representing
level 10 will enclose all points with a grid value above 10 and below 20.

g Tip:

Unless you have special needs, it is recommended that you select Overlapping polygons.

9.9. Displaying Contour Areas

To display the area inside each contour on a plot, choose Display Contour Areas from the Plot
menu. The Contour Areas dialog box appears.

Contour Areas 2 x|

Contour Areas

Level Area, =g. mile=
1 41 069 *xx
75 a.0037
a5 1. 2542

#x%% — Tarning: Contour(=s) not encloszed by grid.

Copy to Clipboard

You are warned if any contours are not completely enclosed by your grid's defined area polygon.
In this case, the displayed contour area is too low, since the area calculation does not include the
portion of the contour beyond the edge of your grid.

You can change the units used to display the areas. See Section 21.3, Physical Units.

The current contour topology controls the meaning of a contour's area. See Section 9.8, Contour
Topology. If the topology is set to Overlapping polygons, then a contour's area includes all points
where the grid value is greater than the contour's level. If the topology is set to Adjacent nested
rings, then a contour's area includes all points where the grid value is greater than the contour's
level but less than the next higher contour's level.

Contour Plots 61



62 Chapter9



Chapter

Color Gradient Plots

Color gradient plots display a grid using smoothly varying colors. They can bring out subtle
details in your data that are difficult to visualize using contours.

10.1. The Color Gradient Table

To create a color gradient plot, you must define a color gradient table, which maps grid data
values to colors. For example:
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Data Level Color

10 Black
20 Dark Green
30 Light Green

NMPIlot draws a color gradient plot by computing grid data values at a large number of locations,
then interpolating in the color gradient table to find the corresponding colors to draw. For
example, based upon the color gradient table above, a point on a plot where the grid data value is
25 would be colored medium green.

10.2. Creating a Color Gradient Plot

To create a color gradient plot, follow these steps.
1. Go to the Color Gradient page of the Plot Options dialog box.

¥ Shaw grid wzing color gradient

R ezalutian: I GO0 pixel:

Calar interpolation space: I Fed Green Blue j
™ Automatically compute mapping of grid levels to colors
Colar of lowest level: ||:| Drark Green j
Color of highest level: ||:| [Ereen j
&+ Manually speciiy mapping of grd levels to colors
Lewel Color
45 [ ] white -
B [ ] Light Gray -
30 []RGE 231154154 =

Add Bow | Remove Bow

2. Check the box labeled Show Grid Using Color Gradient.

3. Resolution: Type the resolution of the color gradient plot. This should be an integer
between 2 and 10,000. Higher values produce smoother gradients, but also use more
memory, and take longer to display.
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It is recommended that you initially try a resolution between 500 and 1000. If your color
gradient plot appears blocky, increase the resolution.

Resolution = 200 Resolution = 1000

If your computer takes an excessively long time to display a color gradient plot, decrease
the resolution. When NMPIot is creating a color gradient plot, it displays the message
"Building color gradient image" on the status bar.

_ | Bullding color gradient image é

4. Color Interpolation Space: Select the method used to interpolate colors in the color gradient
table.

There are two common ways to represent colors mathematically. One method uses the
relative intensities of the three primary colors: red, green, and blue. The other method use
the color's hue, luminance, and saturation. You can select which method is used to represent
colors when interpolating in the color gradient table.

It is not necessary to understand the details of the interpolation methods. Simply be aware
that the two methods will produce different results. You should try both, and select the one
that produces the best results for your particular grid and color table.

5. Select the method used to specify the color gradient table. You have two choices.

o Automatically compute mapping of grid levels to colors - Choose the colors associated
with the lowest and highest data values in your grid. NMPlot will automatically
construct the color gradient table.

e Manually specify mapping of grid levels to colors - Enter two or more levels, and the
color associated with each. Press the Add Row button to add another row to the table.
Press the Remove Row button to remove a row.
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You can specify the rows in any order. NMPlot will sort them if necessary.

See Section B.10, Color Control, for information on using the drop-down color control to specify
colors.

10.3. Tips and Suggestions
g Tip:

Set your plot's background color to the color associated with the lowest level in your color
gradient table.

e Tip:

Avoid color gradient plots where the colors vary across the spectrum. Numerous studies
have shown that the eye does not naturally give a visual ordering to colors, with the
exception of red, which is interpreted as representing higher levels than other colors. Favor
color gradients that vary by lightness and not by hue. For example, have your color

gradient vary from dark green to light green. Alternatively, vary your colors from dark to
light gray, with red to highlight extreme levels.

Good color gradient

Good color gradient
Colors vary by lightness

Colors vary by lightness
Red used a= highlight

Poor color gradient
Colors vary by hue

e Tip:

For a powerful plot, consider adding bold contours to a color gradient plot.
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Displaying Grid Data
Points

NMPIlot can display a grid's data points on a plot. The location of each data point is marked with
a symbol, and optionally labeled with the point's value.

p— |
65.1 65.4
68.3 69.:
67.9 69
70
68.6 9
69 71.2

To display the data points of a plot's primary grid, follow these steps.

1. Go to the Grid Data Points page of the Plot Options dialog box.
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v Shaw arid data points

Shu:uwl every fifth j data point

Show data paints in zubgridz nested up ta I 999 levels deep

S_I.Iml:u:uI:I + |

Color: I B Fed j
[V Label data points
Faont; I'IE pt Times Mew Roman _I

2. Check the box labeled Show Grid Data Points.

3. You can choose to display only a portion of the data points in your grid: for example, every
third point. This can make your plot less cluttered.

Select which subset of the data points to display: every second data point, every third data
point, etc. Select Show every data point to display all data points.

+ + + + + + + + + + + + + +
+ + + + + + + + + + + + + + +

+ + + + + + + + + +

+ + + + + + + + + + + + + + + + + + +
+ + + + + + + + + +

+ 4+ + + + + + + + + + + + + +

+ + + + + + + + + + + + + +
+ + + + + + + + + + + + + + +

+ + + + + + + + + +

+ + + + + + + + + + + + + + + + + + +

Show every data point Show every second data point  Show every third data point

4. NMPlot supports the concept of nested subgrids: i.e., sets of data points that double the
resolution of a portion of a grid. Nested subgrids can, in turn, have their own subgrids.

If your grid contains nested subgrids, you can choose to show only the data points in a
portion of the subgrids. This is an alternative way to make your plot less cluttered.

Type the maximum nesting level of the subgrids that you want to display. This can be any
integer between zero and 999. A nesting level of zero means that no subgrids are displayed,
while a nesting level of 999 means that all subgrids are displayed.
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Symbol:

+ + + + + + + + + + + + + + + + + + + + + + + + + + + + + +

+ + + + + + + + + + + + + + + + + + + + + + + + + + + + + +

+ + + + + + + + + + + + +++++++++++ + 4+ + + ++++++++HEH+ + 4
+4++++++++++ ++++++++++4+

+ + + + + + + + + + + + e+ttt + 4+ + + 4+ttt + +
EEE L + ++ +++

+ + + + + + + + + + + + e+ttt + 4+ + + +++ +++ + +
+++++++++++ ++4 +++

+ + + + + + + + + + + + +H++H++ e+ + o+ + + +++ +++ + +
+++++++++++ +++ +++

+ + + 4+ + + + + o+ + + e+ttt +F + + 4+t o+
+++++++++++ +++++++++++

+ + + + + + + + + + + + +++HHH A+ o+ + + +++HHH A+ o+

+ + + + + + + + + + + + + + + + + + + + + + + + + + + + + +

+ + + + + + + + + + + + + + + + + + + + + + + + + + + + + +

Subgrid Hesting Level =0 Subgrid Hesting Level =1 Subgrid Hesting Level = 2

Choose the symbol used to display data points on your plot. Press the Select

Symbol button J to display the Select Symbol dialog box, which allows you to browse the
available symbols. See Section B.12, Symbol Control.

Color: Select the color used to display data points. See Section B.10, Color Control.

Label Data Points: Check this box to label each data point with its value.

e Font: Select the font used to label data points. Press the Select Font button J to
display the Font dialog box, which allows you to browse the available fonts. See
Section B.9, Font Control.
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Displaying
Geographic
Annotations

Grids can contain geographic annotations: optional map data stored in the grid. See Section
4.2.6, Geographic Annotations. NMPlot can display geographic annotations on a plot.

12.1. Types of Geographic Annotations

There are three types of geographic annotations.

e Points - Point geographic annotations represent point-like features, such as the location of
schools and hospitals.

e Lines - Line geographic annotations represent linear features, such as roads and rivers.

e Areas - Area geographic annotations represent two-dimensional features, such a lakes and
city boundaries.

12.2. Geographic Annotation Categories and
Names

Every geographic annotation has the following two properties.

e (Category - A geographic annotation's category specifies the broad class of objects that the
annotation belongs to. Examples of categories are "Schools", "Streets", and "Lakes".
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e Name - A geographic annotation's name specifies its proper name: i.e., the name of a
specific object. Examples of names are "Baker High School", "Main Street", and "Lake
Michigan".

Use the Summary pane of the Grid Document window to find information about the geographic
annotations in a grid. The summary report lists the types of annotations present in a grid, their
categories, and their names. See Chapter 5, Viewing Grids, for more information.

12.3. Display Rules

The Plot Options dialog box has a separate page for each type (point, line, or area) of geographic
annotation. However, you set the options for displaying all three types of annotations in a similar
fashion. The method for setting display options for line geographic annotations will be described.
Keep in mind that display options for point and area geographic annotations are set in a similar
fashion.

For reference, here is the page used to specify how line geographic annotations should be
displayed.

WV Show line geographic annotations

Category M ame Shom Color ]
Ruriay * v B Dark Gray -2
Flight Track. o v |:| Light Gray -|02
Prirnary B oad * F |l Red -|1
Secondary Road * | Dark Red -|02
Other Foad e ® W | Dark Gray -|02
Railroad e ® | Black -|02
W ater e ® | Ble -|1
* e | ® I . Black |02
| | i

Add Fow | Femove Row | fdoyve Baw e | - Move Bow Down |

Note the spreadsheet-like table that occupies most of the page. This is referred to as the display
rule table. Each row in the table defines a display rule.
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The first two columns in the table, labeled Category and Name, specify the categories and names
that each rule applies to. The rest of the columns in the table specify display options: colors, line
widths, fonts, etc. The display options specify how to draw and label the geographic annotations.

12.3.1. Searching the Display Rule Table

When NMPlot displays a plot, it attempts to draw each of the primary grid's geographic
annotations in the following fashion.

1. NMPlot searches the appropriate display rule table (i.e., either the point, line, or area table)
for a display rule whose category and name match the geographic annotation's category and
name. The table is searched from the top to the bottom.

2. If a matching rule is found, the geographic annotation is drawn using the display options
associated with that rule.

3. If a matching rule is not found, the geographic annotation is not displayed.

The case of letters (upper verses lower case) is not considered when searching for a matching
rule. For example, a display rule category of "STREET" would match a geographic annotation
with a category of "street".

Spaces are also not considered when searching. For example, a display rule category of
"PavedRoad" would match a geographic annotation with a category of " Paved Road ".

12.3.2. Category and Name Wildcards

The Category and Names columns of a display rule table can contain wildcards. These are
characters that have special meanings. They allow you to match groups of categories and names.

For example, you can create a rule that will refer to any geographic annotation with the word
"Road" in its category. Such a rule will match annotations with categories of "Primary Road" and
"Paved Road".

You may be familiar with wildcards used by many operating systems, which allow you to refer to
groups of file names: for example, *.txt to refer to all text files. The "*" in this example is a
wildcard.

NMPIlot recognizes the following wildcards.

e * - Matches any sequence of zero or more characters. For example, A*B would match AB,
AXB, or AXXB.
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e ? - Matches exactly one of any character. For example, A?B would match AXB, but not AB
or AXXB.

e [ABC] - Match any one of the characters A, B, or C. For example, A[XY]B would match
AXB or AYB, but not AB, AXXB, or AZB.

e , - Matches either what is on the left or right of the comma. For example, AA,BB would
match AA or BB.

Wildcards can be combined in powerful ways. As an example, consider a display rule with a
Category of "Roads" and a Name of "US10*,IL10?". This rule would match roads named US10,

US10B, and IL10B, but not IL10 or IL10BB.

12.3.3. An Example

Consider the following sample display rule table. For simplicity, only the Category, Name, and
Color columns are shown.

Category Name Color
Road Peachtree Road Red
Road *Lane Green
Road * Black

Railroad * Gray
River,Creek * Blue
* * Brown

The following table lists the color that would be used to draw a variety of geographic
annotations, based upon the above rule table.

Annotation Category Annotation Name Color Used To Display Annotation

Road Peachtree Road Red
Road Peachtree Lane Green
Road Peachtree Street Black

Railroad L & M RR Gray
River Mississippi Blue
Creek Trout Blue
Trail Baker Hill Brown
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Note the last rule in the sample display rule table. The * wildcard is used for both the category
and name. This rule serves as a catch-all, matching any geographic annotation not matched by an
earlier rule.

O Caution:

The order of rules is important. Rules are matched starting at the top of the rule table. Place
more specific rules above more general rules, as was done in the sample rule table.
Consider the last rule in the sample table, which uses the * wildcard for both the category
and name. If this rule appeared at the top of the table, the other rules would never be used,
since the first rule would match all annotations.

12.3.4. Editing Rule Tables

Rule tables are displayed using a standard spreadsheet control, which functions much like a
spreadsheet such as Microsoft Excel. See Section B.7, Spreadsheet Control, for more information
on using spreadsheet controls.

Press the Add Row button to add a rule. Press the Remove Row button to remove the rule that
contains the selected cell. Use the Move Row Up and Move Row Down buttons to change the
ordering of rules.

In the Category column, type the categories that each rule applies to. Alternatively, press the

Select Categories From List button J A list of the categories in your grid file is displayed, and
you can choose from them.

Select categories of interest 2 x|

[~ Power Line

v Primary Road
[T Raiload

[T River

|7 Secondary Foad

Select All | Select Hone Inwert Selection |

ak. Cancel |

A

In the Name column, type the names that each rule applies to. Use wildcards if desired.

Alternatively, press the Select Names From List button J A list of the names in your grid file
that match the rule's categories is displayed, and you can choose from them.
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Select names of interest llil

[V Baker Road
™l Higkway B
[T Main Strest
[T st Johns Highuwway

Select All | Select None etk Selection |

0k Cancel |

A

12.4. Displaying Point Geographic
Annotations

To display point geographic annotations, follow these steps.
1. Go to the Points page of the Plot Options dialog box.

¥ Shaw point gengraphic annotations

Cateqaorny M ame Show Symbal Colar

Paint of [Rterest I

M avigational Aid e

<

q
@

Static Pad * 4}:

17

YTOL Pad nE I Black

»'I I ﬂ

Add Bow Remove Row | fifl e B MD'-.-'EHDWDDWH'

2. Check the box labeled Show point geographic annotations. If this box is not checked, no
point annotations will be displayed on your plot.
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3. Add display rules to the table, and set the Category and Name columns for each rule. See
Section 12.3, Display Rules, for instructions.

4. For each display rule in the table, set the value of each display option column.

Show

I

o Show -

Check this box to display point annotations. If this box is not checked, point
annotations matched by this display rule will not be displayed.

Surnbal

*

e Symbol -

Select the symbol used to display point annotations matched by this display rule. Press

the Select Symbol button J to display the Select Symbol dialog box, which allows
you to browse the available symbols. See Section B.12, Symbol Control.

Calar

I Blue
e Color -

Select the color used to display point annotation matched by this display rule. See
Section B.10, Color Control.

Label

I

o Label -

Check this box to label each point annotation matched by this display rule. The points'
names will be displayed on the plot.

Label Fant

12 pt Times Meve Roman

o Label Font -

Select the font used to label point annotations matched by this display rule. Press the

Select Font button J to display the Font dialog box, which allows you to browse the
available fonts. See Section B.9, Font Control.
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Paint Layer Mame Label Laver Mame

Specific Points Specific Point Labels

e Point Layer and Label Layer Names -

NMPlot allows you to export a plot to a Geographic Information System (GIS) in a
number of common formats. Some GIS formats support the concept of named layers.
Type the layer names used for point annotations matched by this display rule. You can
specify different layers for the point symbols and the point labels.

12.5. Displaying Line Geographic Annotations

To display line geographic annotations, follow these steps.
1. Go to the Lines page of the Plot Options dialog box.

W Shaw line geographic annotations

Categony Hame S b Colar b
Rurway o B ™2 B Dark Gray -2
Flight Track ™2 |:| Light Gray nz
Prirary Road ¥ |l R=d 1
Secondary Road I | D=k Red 0.2
Other Raoad ¥ | Dark Gray 0.2
Railraad ¥ | Black 0.2
' aher ¥ | Bu= 1
* O I . Black =02
| | i

.-“-‘-.dl:th:uwl Femove Row | fiawe Bov g MDVEHDWDDWH'

2. Check the box labeled Show line geographic annotations. If this box is not checked, no line
annotations will be displayed on your plot.

3. Add display rules to the table, and set the Category and Name columns for each rule. See
Section 12.3, Display Rules, for instructions.

4. For each display rule in the table, set the value of each display option column.
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Show

Show - v

Check this box to display line annotations. If this box is not checked, line annotations
matched by this display rule will not be displayed.

Calor

Color - B Dark Gray =

Select the color used to draw line annotations matched by this display rule. See Section
B.10, Color Control.

"Width [rarn.)
2

Width -

Type the width of the line, in millimeters, used to draw line annotations matched by
this display rule.

Line Patterm

Line Pattern -

Select the dash pattern (dashed, dotted, solid, etc.) used to draw line annotations

matched by this display rule. Press the Select Line Pattern button J to display the
Select Line Pattern dialog box, which allows you to browse the available patterns. See
Section B.11, Line Pattern Control.

Label

Label - 4

Check this box to label each line annotation matched by this display rule. The lines'
names will be displayed on the plot.

Label Fant

12 pt Times Mew Roman

Label Font -

Select the font used to label line annotations matched by this display rule. Press the

Select Font button J to display the Font dialog box, which allows you to browse the
available fonts. See Section B.9, Font Control.
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e Line Layer and Label Layer Names -

NMPlot allows you to export a plot to a Geographic Information System (GIS) in a
number of common formats. Some GIS formats support the concept of named layers.
Type the layer names used for line annotations matched by this display rule. You can
specify different layers for the lines and the line labels.

12.6. Displaying Area Geographic Annotations

Line Layer Mame

Label Layer Mame

Rurmans

Rurnuay Labels

To display area geographic annotations, follow these steps.

1. Go to the Areas page of the Plot Options dialog box.

W Shaw area geographic annotations

Categony Hame S b Cutline Cutline Color
WA aber ™2 I~ . Doark Blue
City Limnitz ™2 I~ . Elack
Fareszt ™2 I~ . Doark. Green
I I . Black
al| | i

.-“-‘-.dl:th:uwl Fieml:uvth:uwl fiawe Bov g

bove Bow Diown |

2. Check the box labeled Show area geographic annotations. If this box is not checked, no

area annotations will be displayed on your plot.

3. Add display rules to the table, and set the Category and Name columns for each rule. See

Section 12.3, Display Rules, for instructions.

4. For each display rule in the table, set the value of each display option column.
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Show

Show - v

Check this box to display area annotations. If this box is not checked, area annotations
matched by this display rule will not be displayed.

Outline

v

Outline -

Check this box to draw the outlines of area annotations matched by this display rule. If
you do not display outlines, you should choose to fill the areas (see Fill below).
Otherwise, the areas will not be visible.

Outlite Calor

[l CakBlue =

Outline Color -

Select the color used to draw the outlines of area annotations matched by this display
rule. See Section B.10, Color Control.

“fidth [mimn.)
1

Width -

Type the width of the line, in millimeters, used to draw the outline of area annotations
matched by this display rule.

Outline Pattern

Outline Pattern -

Select the dash pattern (dashed, dotted, solid, etc.) used to draw the outline of area

annotations matched by this display rule. Press the Select Line Pattern button J to
display the Select Line Pattern dialog box, which allows you to browse the available
patterns. See Section B.11, Line Pattern Control.

Fill

Fill-| ™

You can fill area annotations on your plot with a solid color. Check this box to fill the
area annotations matched by this display rule. If you do not fill areas, you should
choose to display the area outlines (see Outline above). Otherwise, the areas will not
be visible.
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Fill Calar

o Fill Color - | Sky Blue =

Select the color used to fill area annotations matched by this display rule. See Section
B.10, Color Control.

Label

o Label - 4

Check this box to label each area annotation matched by this display rule. The areas'
names will be displayed on the plot.

Label Fant

12 pt Times Mew Roman .

o Label Font -

Select the font used to label area annotations matched by this display rule. Press the

Select Font button J to display the Font dialog box, which allows you to browse the
available fonts. See Section B.9, Font Control.

Area Laver Hame | Label Layer Mame
Lakes Lake Labelz

e Area Layer and Label Layer Names -

NMPIlot allows you to export a plot to a Geographic Information System (GIS) in a
number of common formats. Some GIS formats support the concept of named layers.
Type the layer names used for area annotations matched by this display rule. You can
specify different layers for the areas and the area labels.

84 Chapter 12



Changing the Plot
Background

NMPIlot gives you considerable control over the background of a plot. It can be as simple as a
solid color, or as complicated as a set of map layers displaying themes such as roads and rivers.
The background can also include plot elements, such as contours and geographic annotations,
from other girds. This allows you to overlay contours from two or more grids.

13.1. Background Color

When NMPIlot draws a plot, it first fills the entire plot with the background color. To set the
background color, follow these steps.

1. Go to the Background Color page of the Plot Options dialog box.

Backaground calar:

|0 wihite =

2. Background color: Select the background color. See Section B.10, Color Control, for
information on selecting colors.

13.2. Background Layers

You can add any number of background layers to a plot. Use Map Background Layers to display
background maps. Use Grid Overlay Background Layers to overlay contours from two or more
grids.
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13.2.1. Managing Background Layers
Use the Background Layers page of the Plot Options dialog box to manage background layers.

W Show background laypers

Show O ptions

DLG laver "W ater Features' v O ptions

DLG layer 'Borders' v Options

DLG laver 'Roads' v O ptionz

DLG laver ‘Railroads' v O ptions

DLG layer 'Other Tranzportation Features' v Options
Add Laver | Femove Layer fif e [ it Lt | Mave Diown ik List |

Check the Show background layers box to display background layers. If this box is not checked,
no layers will be shown.

The background layers list displays all background layers. This list is presented using a
spreadsheet control. See Section B.7, Spreadsheet Control, for more information.

13.2.2. Adding a Background Layer
To add a background layer, follow these steps.

1. If desired, select an existing layer by clicking on it. The new layer will be added just before
the selected layer. Ignore this step if the list is empty.

2. Press the Add Layer button, located below the background layers list. The Select Layer
Type dialog box is displayed.

Select type of map layer to add ilil

Dvigital Line Graph [DLG]

ARC/IMNFO Shapefile [SHF)

Georeferenced Bitmap Image

AutoCAD Drawing Exchange Format [D3F]
Compressed ARC Digitized B aster Graphics [CADRG]

ok Cancel

Vi
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3. Choose the type of layer you would like to add, then press OK. As a shortcut, simply
double-click on the desired layer type.

The Grid Overlay layer type is described in Section 13.3, Overlaying Grids. The
background map layer types are described in Chapter 14, Background Map Formats.

4. A new layer, of the appropriate type, is added to the list.

5. Press the new layer's Options button. The layer's options dialog box appears. Set the layer
options as desired.

13.2.3. Removing a Background Layer

To remove a background layer, follow these steps.
1. Select the layer to remove by clicking on it in the background layers list.

2. Press the Remove Layer button, located below the background layers list.

13.2.4. Ordering Background Layers

Background layers are drawn in order, starting with the last layer in the background layers list.
This means that the topmost layer in the list is drawn last, and therefore appears on top of other
layers. Generally, you will want to order the list so that the most important layers are at the top.

@ Note:

Background layers are drawn in three stages. All area features are drawn first, followed by
all line features, and finally all point features. This means that a filled area feature will not
obscure a point feature, regardless of the ordering of the layers. This matches most people's
intuitive idea of how layers should work.

To change the ordering of layers in the list, follow these steps.
1. Select a layer by clicking on it in the background layers list.

2. Press the Move Up In List or Move Down In List button to move the selected layer. These
buttons are located just below the background layers list.

If you press and hold one of these button, it will automatically repeat. This is useful for
moving a layer several rows up or down.
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13.2.5. Hiding or Displaying a Background Layer

Use the Show column of the background layers list to selectively hide or display individual
layers. A layer will be displayed only if its Show box is checked.

13.2.6. Changing a Background Layer's Options

Use the Options column of the background layers list to change the options used to display a
layer. Pressing a layer's Options button will display that layer's options dialog box.

13.3. Overlaying Grids

Using Grid Overlay background layers, you can overlay the plot elements from two or more

grids. For instance, you can create a plot that displays contours from two different grids. This is
useful for comparing grids representing alternative scenarios.

As an example, assume that you have two grids. The first represents the existing noise levels
around an airport, while the second represents the predicted levels a few years in the future, after

air traffic has increased. You create a plot that displays both the current and predicted noise level
contours. This plot clearly shows how far the noise contours are expected to grow. See the
sample plot included with NMPlot, Sample Plot - Contour Overlay.nmp, for an
example.

H\\
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To create a plot overlaying two grids, follow these steps.
1. Create a new plot, and set its primary grid equal to the first of the grids you want to overlay.

2. Add a new Grid Overlay background layer to your plot. See Section 13.2, Background
Layers, for instructions.

3. Click on the new layer's Options button. The Grid Overlay Options dialog box appears.

Grid overlay options 2| x

Option Cateqories; Overlay Grid Options
- [ETE
= Conkours
= Levels ISampIe Gnd - Airport Moize plus 3 dB.grd
= Primary Levels Shyle
=  Secondary Levels Style
= Smoathing
= Label Locations
@ Colaor Gradient
= [aeographic Annotations
= Points
= Lines
* Areas
= [Grnid D ata Points

File name of overlay grid file:

] Cancel Ilndo Page

4. The Grid Overlay Options dialog box looks very similar to the Plot Options dialog box. In
fact, with the exception that some pages are missing, it is nearly identical. Set the options
for the overlay just as you would set the options for a regular plot. Set the overlay grid
(which is the Grid Overlay's equivalent to a plot's primary grid) equal to the second of the
grids you want to overlay.

@ Note:

The missing pages on the Grid Overlay Options dialog box contain options that are
not applicable to an overlay. For example, the Plot Orientation page is missing, as it is
nonsensical to have the overlay oriented differently than the main plot.

g Tip:

You can overlay as many grids as you wish. Take care, however, as overlaying more than
two sets of contours can result in a cluttered plot that is difficult to interpret. A plot
overlaying contours from several grids works best if you make one set of contours very

Changing the Plot Background 89



bold (use thick, solid lines in a dark color), and make the rest of the contours more subtle
(use thin, possibly dashed lines in lighter colors).

= Hoise Levels, Existing
Predicted Hoise Levels, Proposal One
Predicted Hoise Levels, Proposal Two
Predicted Hoise Levels, Proposal Three

13.4. Displaying Background Maps

NMPIlot can display your plot over one or more background map layers.
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The map layers can be stored in a number of common Geographic Information System (GIS)
formats. These formats are discussed in detail in Chapter 14, Background Map Formats.

To add a background map to your plot, simply add a new background layer of the appropriate
type, as described in Section 13.2, Background Layers. See Chapter 14, Background Map
Formats, for instructions on setting the layer options associated with each map format.
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Chapter

Background Map
Formats

NMPIlot can display background map layers stored in the following Geographic Information
System (GIS) formats.

e ARC/INFO Shapefile (SHP)

e Digital Line Graph (DLG)

e AutoCAD Data Exchange Format (DXF)

e Georeferenced Bitmap (BMP, TIF, JPG, PNG)

e Compressed ARC Digitized Raster Graphics (CADRG)
This chapter discusses each of these formats in detail.

See Section 13.2, Background Layers, for instructions on adding background map layers to a
plot.

14.1. ARC/INFO Shapefile (SHP)

14.1.1. Shapefile Map Layer Options Dialog Box
Use the Shapetfile Map Layer Options dialog box to configure a shapefile map background layer.
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ARC/INFOD Shapefile [SHP] map layer options 7| x|
Option Categaories: Shapefile Hame Optionz
o Coordinate System Shapefile file narne:
@ Scale IMyShapeFiIe.shp _I
= [rawing
k. Cancel IIndo Page
A

The Shapefile Map Layer Options dialog box is a Multiple Page dialog box. See Section B.2,
Multiple Page Dialog Boxes, for more information.

14.1.2. Shapefile Name Options Page
Use the Shapefile Name page of the Shapefile Map Layer Options dialog box to set the name of
the shapefile you wish to display.

Shapefile file name:
I MyShapeFile. shp _I

Type the name of the file containing the shapefile. Press the Browse button J, located to the
right of the text box, to display the Open File dialog box, which allows you to browse for the file.

@ Note:

A single shapefile actually consists of three files: a main file, an index file, and an attribute
file. These files should have the extensions . shp, . shx, and .dbf, respectively. On the
Shapefile Name page, specify the name of the main file (i.e., the . shp file).

14.1.3. Coordinate System Options Page

Use the Coordinate System page of the Shapefile Map Layer Options dialog box to specify the
coordinate system used by the shapefile.
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Coordinate zustem uged ta zpecify locationg in the shapefile:

niverzal Transverse Mercator [LITM]
Zone: 15
Draturn: Default [currently WES 34]

See Section 20.1, Coordinate System Control, for instructions on specifying a coordinate system.

14.1.4. Scale Options Page
Use the Scale page of the Shapefile Map Layer Options dialog box to specify the scales at which
this shapefile is displayed.

™ Show this layer at all scales

& Show this laver only at scales above...

1: [24000
[1 [inch =] = [2000 lfest =]

If a plot is displayed at a scale below the one you specity, the shapefile layer is not displayed.
This is useful if you have shapefiles with varying levels of detail. Using multiple shapefiles, you
can construct maps that reveal more detail as you zoom in.

For example, assume that you have two shapefiles. The first contains main roads, and the second
contains secondary roads. You can set the main roads layer to display at all scales, and the
secondary roads layer to display only at scales above 1:24,000. This prevents the secondary roads
from cluttering the plot if you view it at a smaller scale.

14.1.5. Drawing Options Page

Use the Drawing page of the Shapefile Map Layer Options dialog box to specify the style (colors,
line widths, etc.) used to draw features in the shapefile.
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Diraw colar; I- Elack j
Fill calar; ||:| Light Gray j

Dizplay pointz with: | & |

Line patterr; I— _I
Lire width: I'I riirn

Digplay areas by I drawing their outling and filling them j

You can set the following options.

e Draw color: Select the color used to draw point features, line features, and the outlines of
area features. See Section B.10, Color Control, for information on selecting colors.

e Fill color: Select the color used to fill the interior of area features. For example, if the
shapefile contains areas representing lakes, you can set the fill color to blue.

e Display points with: Select the symbol used to display point features. Press the Select

Symbol button J to display the Select Symbol dialog box, which allows you to browse the
available symbols. See Section B.12, Symbol Control.

e Line pattern: Select the dash pattern (dashed, dotted, solid, etc.) of lines used to draw line
features and the outlines of area features. See Section B.11, Line Pattern Control, for

information on selecting line patterns.

e Line width: Type the width, in millimeters, of lines used to draw line features and the
outlines of area features. Typical widths are between 0.2 to 1.0 millimeters.

e Display areas by: Select how area features are displayed. You have three options.
e Draw their outlines
e Fill their interiors with a solid color

e Both draw their outlines and fill their interiors

14.1.6. Technical Details
NMPIlot can display shapefile records of the following types.

e Point
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e PointZ

e PointM

e Multipoint

e MultipointZ
e MultipointM
e PolyLine

e PolyLineZ

e PolyLineM
e Polygon

e PolygonZ

e PolygonM

Shapefiles containing a mixture of record types are supported.

Only the Main (.shp) file is required. The Index (.shx) and Attribute (.dbf) files may be present,
but are not used. Attributes are not loaded.

The shapefile format is controlled by Environmental Systems Research Institute, Inc (ESRI), the
makers of the ARC/INFO GIS system. The official specifications are documented in an ESRI
white paper titled "ESRI Shapefile Technical Description", which can be found on the ESRI web
site, http://www.esri.com . As of September 2000, the URL for this document was
http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.

14.2. Digital Line Graph (DLG)

14.2.1. Map Formatting Schemes

Every map feature in a Digital Line Graph (DLG) file contains attribute codes that specify
properties of the feature. For example, a line feature might have the attribute codes for Primary
Road and Under Construction. An attribute code consists of two integers: a 3-digit major code,
and a 3- or 4-digit minor code. Attribute codes are standardized and documented: see Section
14.2.3, Technical Details.
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A map formatting scheme is a file containing rules that associate attribute codes with display
styles. For example, a rule might state that line features with the code 170 212 (four-wheel-drive
roads) should be drawn in a thin gray dashed line.

Map formatting schemes are stored in files with the extension .mapformattingscheme.
You can create, view, and edit map formatting schemes using NMPlot.

To open an existing scheme, choose Open from the NMPIlot File menu, then select a map
formatting scheme file. A map formatting scheme document window appears.

Default.M apFormatting5Scheme QIEI

Edt Poit Aules |

EdtLine Ruless |

Edit Area Rules |

Z

Map formatting scheme rules are divided into three groups, according to whether they apply to
point, line, or area map features. Press one of the buttons to edit a group's rules. For example, if
you press the Edit Line Rules button, a dialog box appears that allows you to edit the rules used
for line features.
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Rules for interpreting attribute codesz for line geographic features ilil
Rule Mame Scale [1:#] DLG Attribube Shiow Calar e |
Prirmary Foad 9333339 170 201-204 W |[] Orange »| 0.8
Secondany Foad 9333339 170 205-208 W |[] Orange »|0.2
Clazz 3 Road 250000 170 209 = [] Camel =02
Clazz 4 Road 50000 170 210,401-402 v [] Raose =02
Four-wheeldive Road | 50000 170212 W |[]Roze =02
Trail 50000 17021 ™ [] Light Gray =| 01
Airport Buraays 9533395 130 403 ¥ | [ Battleship Gray =02
Railroads 3333533 180 207-205 = |:| Battleship Gray =| 0.1
Rairoad Sidings 20000 180 209 ¥ | [] Light Gray - |01
Power Line 50000 130 202 ¥ | [ Battleship Gray = 0.1 :I
T| | i
Add new rule Bemove mile ke rule up | b e rule down |
ok LCancel |
Z

The rules in a map formatting scheme are very similar to the display rules used for grid
geographic annotations. Please review Chapter 12, Displaying Geographic Annotations, which
describes display rules and discusses how they are edited. Map Formatting Scheme rules are
edited in the same fashion, with three exceptions.

1. Map Formatting Scheme rule tables have an additional column labeled Rule Name. This
column is used to give a descriptive name to a rule.

2. Instead of columns labeled Category and Name, map formatting scheme rule tables have a
column labeled DLG Attribute Codes. Map Formatting Scheme rules are matched against a
DLG feature's attribute codes in the same way that Grid Geographic Annotation display
rules are matched against an annotation's category and name. In the DLG Attribute Codes
column, type the attribute codes associated with each rule. Here are some examples.

e "170 201" matches DLG features with the attribute code 170 201.

e "170 201..205" matches DLG features with a major code of 170, and a minor code
between 201 and 205.

e "170201,203" matches DLG features with a major code of 170, and a minor code of
either 201 or 203.
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e "170 201 and 170 603" matches DLG features with both attribute codes 170 201 and
170 603.

e "170 201 then 170 603" matches DLG feature with both attribute codes 170 201 and
170 603, with 170 603 following 170 201 in the feature's list of codes.

e " "matches DLG features with no attribute codes.

As an example, "170 201-208 and 170 603,604" matches all primary and secondary roads
under construction.

3. Map Formatting Scheme rule tables have an additional column labeled Scale (1:x). This
column allows you to specify the minimum scale at which matching DLG features are
displayed. If a plot is displayed at a scale below a rule's scale, any DLG features matching
that rule are not displayed. This allows you to construct maps that reveal more detail as you
zoom in.

@ Note:

NMPIlot is distributed with a default map formatting scheme. This scheme is in the file
Default.MapFormattingScheme, which can be found in the directory where
NMPlot is installed.

@ Note:

This section provides only the briefest introduction to attribute codes. If you intend to
modify map formatting schemes, obtain the official DLG documentation, which describes
attribute codes in detail. See Section 14.2.3, Technical Details, for information on
obtaining the documentation.

14.2.2. Digital Line Graph (DLG) Options Dialog Box

Use the Digital Line Graph Map Layer Options dialog box to configure a DLG map background
layer.
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Digital Line Graph [DLG] map layer options 1'5'

Descriptive name of thiz map layer [for example, 'Foadz and trails']:

I'W'ater Features

b ap formatting zcheme that will be uzed tointerpret thiz map laver's data;
I Drefault. b apFormattingS cheme _I

Geographic datum uzed to store coordinates in this map layer's DLG file(s):
I Drefault [curently WwWias G4] _I

Show. W Paints W Lines W Areas

Mame(z] of DLG file(z] that contain this map laver's data;

Sampletapbatatls2_HYFO4_opt.dig
Sampletdaph atahL52_HYFOS_opt.dig

Add file to list Hemove file from lizt

ok Cancel |

A

Descriptive name of this map layer: Type a short description of this map layer. Examples are
"Roads" and "Water Features". This allows you to identify this layer in the future.

Map formatting scheme that will be used to interpret this map layer's data: Type the name of the
file containing the map formatting scheme used to display this DLG layer. Press the Browse

button J, located to the right of the text box, to display the Open File dialog box, which allows
you to browse for the file. Map formatting schemes typically have the extension
.mapformattingscheme. See Section 14.2.1, Map Formatting Schemes.

Geographic datum used to store coordinates in this map layer's DLG file(s): Select the DLG
files' geographic datum. See Section B.14, Datum Control, for information on selecting datums.
See Appendix H, Introduction to Datums, for general information on datums.

/ Important:

Many DLG files supplied by the United States Geological Survey (USGS) are in the North
American Datum of 1927 (NAD-27). Make sure that you know the correct datum for your
DLG files.
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Show Points, Lines, Areas: Check the boxes corresponding to the geographic features you wish
to display. Typically, all three boxes should be checked. However, if necessary, you can restrict
which features are displayed. For example, you can choose to display only point geographic
features.

Name(s) of DLG file(s) that contain this map layer's data: Type the names of the DLG files that
you wish to display as part of this layer. Any number of files can be listed. Press one of the

Browse buttons J, which are located to the right of the file name text boxes, to display the
Open File dialog box, which allows you to browse for a file. DLG files typically have the
extension .d1lg.

Press the Add File To List button to add a file. Remove a file by clicking on it with the mouse,
and then pressing the Remove File From List button.

14.2.3. Technical Details
NMPIlot can read 1:24000 and 1:100000, level 3, optional format DLG files.

The coordinate system of the DLG file must be Universal Transverse Mercator (UTM).
The DLG file cannot contain DLG accuracy records.
NMPIlot can display DLG records of the following types.
e N (Node)
e [ (Line)
e A (Area)
DLG files containing a mixture of record types are supported.
NMPlot can merge DLG topology data in layers containing more than one DLG file.

The DLG format is controlled by the National Mapping Division of the United States Geological
Survey (USGS). The official specifications are documented in a technical report titled "Standards
for Digital Line Graphs", which can be found on the USGS web site, http://www.usgs.gov. As of
September 2000, the URL for this document was
http://rockyweb.cr.usgs.gov/nmpstds/dlgstds.html. This document contains a list of all DLG
attribute codes.
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14.3. AutoCAD Data Exchange Format (DXF)

O Warning:

Use the DXF format as a last resort, only if no alternative is available. DXF is a very
ambiguous format, which results in different applications interpreting the same DXF file in

different ways. You can expect fewer problems using other formats, such as ARC/INFO
Shapefile or Digital Line Graph.

14.3.1. DXF Map Layer Options Dialog Box
Use the DXF Map Layer Options dialog box to configure a DXF map background layer.

AutoCAD DXF map layer options ilil
Option Categaories: [F Filename Options
@ Coordinate Sostem Da<F file hame:
* Scale | My DF File.df ]
= [rawing
k. Cancel IIndo Page
A

The DXF Map Layer Options dialog box is a Multiple Page dialog box. See Section B.2, Multiple
Page Dialog Boxes, for more information.

14.3.2. DXF Filename Options Page

Use the DXF Filename page of the DXF Map Layer Options dialog box to set the name of the
DXEF file you wish to display.

D=F file name:
[ My DiF File. duf ]
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Type the name of the DXF file. Press the Browse button J, located to the right of the text box,
to display the Open File dialog box, which allows you to browse for the file. This file will
typically have the extension .dxf.

14.3.3. Coordinate System Options Page

Use the Coordinate System page of the DXF Map Layer Options dialog box to specify the
coordinate system used by the DXF file.

Coordinate zuztem uzed to zpecify locationg in the DF file:

niverzal Transverse Mercator [LITM]
Zone: 15
Draturn: Default [currently WES 34]

See Section 20.1, Coordinate System Control, for instructions on specifying a coordinate system.

14.3.4. Scale Options Page

Use the Scale page of the DXF Map Layer Options dialog box to specify the scales at which this
DXF file is displayed.

™ Show this layer at all scales

& Show this laver only at scales above...

1: [24000
[1 [inch =] = [2000 lfest =]

If a plot is displayed at a scale below the one you specify, the DXF layer is not displayed. This is
useful if you have DXF files with varying levels of detail. Using multiple DXF files, you can
construct maps that reveal more detail as you zoom in.

For example, assume that you have two DXEF files. The first contains main roads, and the second
contains secondary roads. You can set the main roads layer to display at all scales, and the
secondary roads layer to display only at scales above 1:24,000. This prevents the secondary roads
from cluttering the plot if you view it at a smaller scale.

14.3.5. Drawing Options Page

Use the Drawing page of the DXF Map Layer Options dialog box to specify the style (colors, line
widths, etc.) used to draw features in the DXF file.
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Diraw colar; I- Elack j
Fill calar; ||:| Light Gray j

Dizplay pointz with: | & |

Line patterr; I— _I
Lire width: I'I riirn

Digplay areas by I drawing their outling and filling them j

You can set the following options.

e Draw color: Select the color used to draw point features, line features, and the outlines of
area features. See Section B.10, Color Control, for information on selecting colors.

Fill color: Select the color used to fill the interior of area features. For example, if the DXF
file contains areas representing lakes, you can set the fill color to blue.

Display points with: Select the symbol used to display point features. Press the Select

Symbol button J to display the Select Symbol dialog box, which allows you to browse the
available symbols. See Section B.12, Symbol Control.

Line pattern: Select the dash pattern (dashed, dotted, solid, etc.) of lines used to draw line
features and the outlines of area features. See Section B.11, Line Pattern Control, for

information on selecting line patterns.

Line width: Type the width, in millimeters, of lines used to draw line features and the
outlines of area features. Typical widths are between 0.2 to 1.0 millimeters.

Display areas by: Select how area features are displayed. You have three options.
e Draw their outlines
e Fill their interiors with a solid color

e Both draw their outlines and fill their interiors

14.3.6. Technical Details
NMPIlot can display DXF entities of the following types.

e POINT
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e LINE
e POLYLINE
NMPIlot recognizes entities in either BLOCKS or ENTITIES sections.

The DXF format is controlled by Autodesk, Inc., the makers of AutoCAD. The official
specifications are documented in an appendix of the AutoCAD Reference Manual.

14.4. Georeferenced Bitmap

14.4.1. Georeferenced Bitmap Map Layer Options Dialog Box

Use the Georeferenced Bitmap Map Layer Options dialog box to configure a Georeferenced
Bitmap Image map background layer.

Georeferenced Bitmap map layer options 2| x|

Option Cateqaories: Image File Optionz

=1

Image file name:

IM_I,Ih-'Iap.I:-mp _I

= Georeferencing

Supported image types

Type E stenzionz Farmats
Microzoft WWindows Bitmap brnp 1.4, 8. 16, 24, & 32-bit
JPEG iPg. ipeq. jif jif 8 & 24-hit
Puartable Metwork. Graphics phg 1.4, 8,16, 24, 32, & B4-bit
T agged Image File Format Hif, Liff 1. 8, & 24-bit, uncompreszed
k. Cancel IIndo Page

Z

The Georeferenced Bitmap Map Layer Options dialog box is a Multiple Page dialog box. See
Section B.2, Multiple Page Dialog Boxes, for more information.
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14.4.2. Image File Options Page
Use the Image File page of the Georeferenced Bitmap Map Layer Options dialog box to set the
name of the bitmap image file you wish to display.

Image file name:

IMyM ap.bmp _I

Type the name of the bitmap image file. Press the Browse button J, located to the right of the
text box, to display the Open File dialog box, which allows you to browse for the file.

NMPIlot can read the following types of bitmap image files.

Microsoft Windows Bitmap (bmp)

JPEG (jpg, jpeg)

Portable Network Graphics (png)

Tagged Image File Format (tif; tiff), uncompressed

14.4.3. Georeferencing Options Page

Use the Georeferencing page of the Georeferenced Bitmap Map Layer Options dialog box to
specify the portion of the Earth's surface represented by the bitmap image.

Irmage projection coordinate system;

Lambert Canfarmal Conic
Center Longitude and Latitude: lang; 900000007 v lat: 400000007 M
Standard Parallels: 20 and B0 °
Falze Easting: O0m  Falze Maorthing: 0 m
Draturn: Default [curently WES 84]

Image georeferencing:

= I Georeference using locations of the image's lower-left and upper-night cormers j N

Geographic coordinates of lower-left comer of the image:

: IEEIEIEI m IEEIEIEI m

Geographic coordinates of upper-right cormer of the image:

: I'IEEIEIEI m |13EIEIEI m

Image projection coordinate system: Select the projection coordinate system of the bitmap
image. See Section 20.1, Coordinate System Control, for information on specifying a coordinate
system.
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Image georeferencing: Use the drop-down list to select the method for georeferencing the image.
You have three choices.

o Georeference using locations of the image's lower-left and upper-right corners - Specify
the geographic coordinates of the image's lower-left (i.e., southwest) and upper-right (i.e.,
northeast) corners. The coordinates must be supplied in the image's projection coordinate
system.

e Georeference using location of the image's lower-left corner, and size of the image -
Specify the geographic coordinates of the image's lower-left (i.e., southwest) corner. The
coordinates must be supplied in the image's projection coordinate system. Also specify the
width (i.e., the east-west extent) and the height (i.e., the north-south extent) of the image.
The units used to specify the width and height depend upon the projection coordinate
system.

e Georeference using location of the image's lower-left corner, and size of an image pixel -
Specify the geographic coordinates of the image's lower-left (i.e., southwest) corner. The
coordinates must be supplied in the image's projection coordinate system. Also specify the
width (i.e., the east-west extent) and the height (i.e., the north-south extent) of a single pixel
in the image. The units used to specify the width and height depend upon the projection
coordinate system.

o Georeference using location of the image's upper-left corner, and size of the image -
Specify the geographic coordinates of the image's upper-left (i.e., northwest) corner. The
coordinates must be supplied in the image's projection coordinate system. Also specify the
width (i.e., the east-west extent) and the height (i.e., the north-south extent) of the image.
The units used to specify the width and height depend upon the projection coordinate
system.

o Georeference using location of the image's upper-left corner, and size of an image pixel -
Specify the geographic coordinates of the image's upper-left (i.e., northwest) corner. The
coordinates must be supplied in the image's projection coordinate system. Also specify the
width (i.e., the east-west extent) and the height (i.e., the north-south extent) of a single pixel
in the image. The units used to specify the width and height depend upon the projection
coordinate system.

e Georeference using world file - NMPlot will read georeferencing information from a world
file associated with the image. The world file must have the same file name as the image,
and must have one of the following extensions:

wid, .wf, .worldfile, .twf, .tifw, .tiffw, .tfw, .bwf, .bmpw, .bpw, .pwf, .pngw, .pnw, .pgw,
Jwf, jpgw, .jpegw, .jpw, .jgw
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For example, if the image file is named "Chicago.bmp", an acceptable world file name
would be "Chicago.wld".

@ Note:

A world file is a standard way of specifying georeferencing information for a bitmap
image. The format was defined by Environmental Systems Research Institute, Inc
(ESRI).

A world file is a simple text file consisting of 6 numbers, each on a separate line.
The first number is the size of an image pixel in the X (east-west) direction.

The second and third numbers are rotation terms. NMPlot does not currently support
world file rotation. Therefore, these numbers must be zero.

The fourth number is the size of an image pixel in the Y (north-south) direction. This
number is usually negative: see below.

The fifth number is the X coordinate of the center of the upper-left image pixel.

If the fourth number is negative, the sixth number is the Y coordinate of the center of
the upper-left image pixel.

If the fourth number is positive, the sixth number is the Y coordinate of the center of
the lower-left image pixel.

@ Note:

You should be able to find georeferencing information in the documentation that
accompanies your bitmap image. If you do not have this information, ask the person or
organization who supplied the image. Or, contact your local GIS expert. If NMPlot does
not support your image's projection, contact the developers: see Appendix I, Contacting
Wasmer Consulting.

Georeferenced bitmap images are often distributed with an accompanying world file, which
contains georeferencing information. However, keep in mind that a world file does not
contain information about an image's projection. Your image's projection must be entered

into NMPlot by hand.
O Caution:

You can display any number of georeferenced images on a single plot. However, all of the
images must have compatible projection coordinate systems. NMPlot will allow you to
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create a plot with images in different projections, but this should be attempted only if you
have a thorough understanding of map projections. To be safe, novices should insure that
all georeferenced images have exactly the same projection.

14.4.4. Technical Details
NMPIlot can read bitmap images in the following formats.

e BMP: 1-, 4-, 8-, 16-, 24-, and 32-bits
e JPEG: 8- and 24-bits
e PNG: 1-, 4-, 8-, 16-, 24-, 32-, and 64-bits

e TIFF: 1-, 8- and 24-bits, uncompressed

14.5. Compressed ARC Digitized Raster
Graphics (CADRG)

14.5.1. Compressed ARC Digitized Raster Graphics (CADRG) Map
Layer Options Dialog Box

Use the Compressed ARC Digitized Raster Graphics (CADRG) Map Layer Options dialog box
to configure a CADRG map background layer.
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Compreszzed ARC Digitized Raster Graphicz [CADBG] map layer options 1'5'

T able of contents file:
[ERPFY.TOC ]

Brightness adjustrment [-100 ta 1 00);

e

Contrazst adjustrment [-100 o 1007
I 70

Longitude Tweak [-0.7 to 0.7 7
o

Latitude Tweak [-0.7 ta 0.7 7]
o

The table of contents iz a file named "A. TOC". vou will find it in the root directorny [i.e., the
RPF directory] of the CADRG map that vou wish o load.

ok Cancel |

A

Table of contents file: Type the name of the CADRG table of contents file. Press the Browse

button J, located to the right of the text box, to display the Open File dialog box, which allows
you to browse for the file.

The CADRG table of contents is a file is named A . TOC. You will find it in the root directory
(i.e., a directory named RPF) of the CADRG map you wish to load.

Brightness adjustment:

Contrast adjustment.: Type numbers between -100 and 100 to indicate how much the brightness
and contrast of the CADRG map should be adjusted before it is displayed. Values of 0 leave the
map unchanged. Values above 0 increase the brightness and contrast; value below 0 decrease the
brightness and contrast.

Longitude Tweak:

Latitude Tweak: Type numbers between -0.1 and 0.1 to indicate how much the CADRG map
should be shifted in degrees longitude and latitude. If foreground elements do not line up exactly
with the background CADRG map, use non-zero values to shift the map slightly. The appropriate
tweak values are best found using trial and error.
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e Tip:

As distributed, most CADRG maps are poor backgrounds. The map colors are too intense,
making it difficult to see any foreground detail displayed over the map.

In most situations, you should adjust the brightness and contrast so that the map colors are
muted. As a starting point, try a brightness adjustment of 30 and a contrast adjustment of
-70. These values have been found to work well with most CADRG maps distributed by
the United States' National Imagery and Mapping Agency.

-2 |
B i N 00 CTIT
1
RSO / e
i Z
|
rdif .
E {
- 850.CTH-—
R 275kt
N 51/ !
ﬂ /
[ S50 C TIT L
Nk 325 kit
Brightness =0, Contrast = 0 - Brightness = 30, Contrast = -7l

e Tip:

CADRG maps are typically distributed on a CD-ROM. If desired, you can copy the

CADRG map to your hard drive. Simply copy the RPF directory, taking care to preserve
the subdirectory structure.

A CADRG map will load much faster from a hard drive. It may also be more convenient to
use, since you do not have to insert a CD-ROM.

0D

Warning:

CADRG maps can be huge. Uncompressed, they can be several thousand megabytes in
size. NMPlot supports incremental loading: it reads sections of the CADRG map on an
as-needed basis. However, as you zoom out on a plot, you cause more CADRG map data to
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be loaded. If you zoom out far enough, enough map data can be loaded to overwhelm even
the largest computer.

@ Note:

Do not confuse the Compressed ARC Digitized Raster Graphics (CADRG) format with the
Digital Raster Graphics (DRG) format developed by the United States Geological Survey.
They are different formats.

14.5.2. Technical Details

Compressed ARC Digitized Raster Graphics (CADRG) is a georeferenced bitmap format for
storing background maps. It was developed by the United States Department of Defense's
Defense Mapping Agency (now known as NIMA, the National Imagery and Mapping Agency).

The CADRG format is documented in military specification MIL-PRF-89038 (formerly
MIL-C-89038), dated 6 October 1994, and Amendment 1, dated 27 April 1999. These documents
can be downloaded from the NIMA web site, http://www.nima.mil/. As of September 2001, the
URLSs for PDF versions of these documents were
http://www.nima.mil/publications/specs/printed/89038/89038 CADRG.pdf and
http://www.nima.mil/publications/specs/printed/8§9038/89038 A1l.pdf.
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Printing Plots

NMPIlot lets you print any plot. You can choose a scale to print the plot at, and add a detailed

legend.

15.1. Print Dialog Box

To print a plot, you can:
e Choose Print from the File menu
e Press the Print toolbar button &¥

e Press Ctrl + P

The standard Microsoft Windows Print dialog box appears.
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HPF Lazer) et 5F/SMF PostS cript |_

The exact appearance of this dialog box will vary, depending on the version of Windows you are
using. However, all versions let you choose a printer. Familiarity with this dialog box is assumed.
Choose a printer, and press OK. Your plot is sent to the selected printer.

15.2. Page Setup

Microsoft Window's standard Page Setup dialog box lets you select the paper orientation (portrait
or landscape) and page margins of your printer.
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letter =
Autamatically Select |_

The exact appearance of this dialog box will vary, depending on the version of Windows you are
using. Familiarity with this dialog box is assumed.

To display the Page Setup dialog box, you can:
e Choose Page Setup from the File menu

e Press Ctrl + Shift + P

15.3. Print Options

Choose Print Options from the File menu to display the Print Options dialog box. Use it to control
how plots are printed.
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The Print Options dialog box is a Multiple Page dialog box. See Section B.2, Multiple Page
Dialog Boxes, for more information.

15.3.1. Scale
Use the Scale page of the Print Options dialog box to set the scale at which a plot is printed.

Select how the scale is determined.
o Automatically select the scale at which the plot is printed - NMPlot selects a scale so that
the plot's area of interest just fills the paper's margins when printed. The area of interest is

specified on the Area To Print page. See Section 15.3.2, Area to Print.

e Print the plot at a scale of - Specify the scale at which the plot is printed.

15.3.2. Area to Print
Use the Area To Print page of the Print Options dialog box to select the portion of your plot that

is printed.

118 Chapter 15



Select the area to print. You have two choices.

e Print the home view - The home view of the plot is printed. See Section 8.4, The Home
View, for more information about the home view.

e Print the area currently displayed on the screen - The portion of the plot currently
displayed on your computer's monitor is printed. If you want to print only a small portion of

your plot, zoom in on that section, then print the plot, choosing to print the area currently
displayed on the screen.

@ Note:

If the Area to Print is not the same shape as the paper on which a plot is printed (i.e., if the
aspect ratios are different), the area printed will be larger that the area requested. For
example, if you select an Area to Print that is square, and then print on paper that is tall and
narrow, the requested square area will fill the paper to the left and right margins. In

addition, a portion of the plot beyond the area requested will appear at the top and bottom
of the paper.

Extra portion of plot displayed
to fill margins

Area to Print

Extra portion of plot displayed
to fill margins

Printing a plot with a square Areato
Print on a tall, narrow sheet of paper
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@ Note:

If you print a plot to scale, NMPIlot attempts to display the Area To Print at the requested
scale. If the requested scale is too large, this area will not fit on the paper. In this case, you
have three options: 1) choose a smaller scale, 2) choose a smaller Area To Print, or 3) print
to a larger sheet of paper.

15.3.3. Level of Detail

Use the Level Of Detail page of the Print Options dialog box to control how much background
map detail is displayed when you print a plot.

% Frint the plot with a level of detail appropriate fior the scale at whick the plat iz printed
" Print the plot with the level of detail curently displayed on the screen
' Print the plot with all detailz: dizplayed

Ilze caution, az thiz may show =0 much detail az to make the plot unreadable

™ Print the plot with a level of detail appropriate for dizplay at a szale of...

1 : [100000

[ finch —| = [s333.33333 flest ]

Many background maps specify a minimum scale at which various features should be displayed.
As you zoom in on such a map, additional detail is displayed. The intent is to prevent excessive
detail from cluttering a plot when it is displayed at a small scale. See Chapter 14, Background
Map Formats.

Use the Level of Detail page to control how NMPlot uses this recommended scale information
when you print a plot. You have four choices for how NMPlot determines how much detail to
display.

e Print the plot with a level of detail appropriate for the scale at which the plot is printed -
Any recommended scale information in the background map is used.

o Print the plot with the level of detail currently displayed on the screen - The level of detail
is the same as that currently displayed by the plot on your computer's monitor.

o Print the plot with all details displayed - Any recommended scale information in the
background map is ignored.

O Caution:

This may display so much background map detail as to make the plot illegible.
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e Print the plot with a level of detail appropriate for display at a scale of - The level of detail
is the same as if the plot was being printed at a scale you specify.

15.4. Legends

When printing a plot, you can add a legend that displays information about the plot.

Sample plot, with the legend highlighted

You have full control over the appearance and content of the legend. The legend can have
multiple fonts, colors, and borders. Text can be segregated into outlined rectangular areas, much
like an architectural blueprint legend. A graphical scale and north arrow are supported.

To change the legend, display the Legend page of the Plot Options dialog box.
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Edit Legend Save Legend to File Load Legend from File

A sample of the current legend is displayed.

Press the Edit Legend button to edit the legend. The Edit Legend dialog box is displayed. See
Section 15.5, Editing Legends, for information on editing legends.

Creating a legend from scratch involves a significant amount of work. Therefore, NMPlot gives
you the ability to save and load legends to and from files. The intent is that you will create a
small number of legends, and then reuse them as needed.

Press the Save Legend To File button to write the current legend to a file. Press the Load Legend
From File button to read a previously saved legend. In both cases, you will be asked for the file's
name.

NMPIot is distributed with several ready-to-use legends. These legends are stored in files that
have the extension .nmplot legend, and are located in the same directory as the NMPlot
program file, NMP1lot . exe. If you do not wish to go to the trouble of learning how to edit
legends, you can simply use one of these ready-to-use legends.

8 Tip:

If you intend to create your own legend, you may wish to start with one of the ready-to-use
legends included with NMPIot, and then edit it incrementally. You will likely find this
easier than creating a new legend from scratch.
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15.5. Editing Legends

15.5.1. Legend Concepts

An NMPIot legend is an area that surrounds a plot when it is printed. The legend displays
information about the plot, such as descriptive text, a graphical scale, and a north arrow. The
legend may also include a border around the plot.

NMPIlot's legends are based upon a concept of cells. Cells are rectangular areas of the paper that
can contain text, graphical features such as scales and north arrows, and other cells. In addition,
there is a cell that contains the plot itself. Each cell has a variety of properties, such as a
background color, a margin, and a border.

The printable area of the paper (i.e., the paper minus any margins) is the outermost cell. You
build a legend by adding cells to this outermost cell, and setting their properties. Recall that cells
can contains other cells. The legend consists of a hierarchy of cells, with the outermost cell as the
hierarchy root.

There are three types of cells:

e Text Cells - These cells contain text, and possibly, graphical elements such as a north arrow
and the plot itself.

Horizontal Organizer Cells - These cells contain a horizontal row of other cells.

Vertical Organizer Cells - These cells contain a vertical column of other cells.

15.5.2. Edit Legend Dialog Box
Use the Edit Legend dialog box to inspect and edit an NMPlot legend.
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The left side of the Edit Legend dialog box displays a preview of what the current legend will
look like when printed. This is know as the legend preview.

The right side of the Edit Legend dialog box displays a hierarchical list of the cells in the legend.

This is known as the cell list.

At any given time, one cell is selected. This selected cell is the one that you are currently
working with. The selected cell is highlighted in both the legend preview and the cell list.

15.5.3. Working with the Legend Preview

Press the Zoom In button & to magnify the legend preview for close study. Press the Zoom Out

button & to reduce the magnification level.
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Press the Change Sample Paper Size button [7 to select the size and orientation of the
hypothetical piece of paper used to display the legend preview.

Press the Print Sample Legend button & to print the legend preview.

Click on a cell in the legend preview to select it. Double-click on a cell to displays the cell's Edit
Legend Cell dialog box, which allows you to inspect and change the cell's properties. See Section
15.5.5, Edit Legend Cell Dialog Box.

15.5.4. Working with the Cell List

The cell list displays a hierarchical list of the cells in the legend being edited. The selected cell is
always highlighted. To change the selected cell, either use the arrow keys, or click on the cell to
be selected.

To edit the properties of the selected cell, you can:
e Press the Edit Cell button
e PressAlt+E
e Double-click on the cell in the cell list

The cell's Edit Legend Cell dialog box, which allows you to inspect and change the cell's
properties, is displayed. See Section 15.5.5, Edit Legend Cell Dialog Box.

Use either the keyboard or the Move buttons to move the selected cell.

Key Button Action
Alt+ T 1 Move selected cell up in the cell list.
Alt+ 1 Move selected cell down in the cell list.
Alt + - Move selected cell in one level towards the root of the cell list.
e
Alt + - Move selected cell out one level away from the root of the cell
- list.

Use either the keyboard or the Add buttons to add a new cell as the child of the selected cell.
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Key Button Action

Alt+T; ] Add a new text cell
Alt+H [ Add a new horizontal organizer cell
Alt+V E2 Add a new vertical organizer cell

Delete the selected cell by either pressing the Delete button X, or by pressing the Delete key.

15.5.5. Edit Legend Cell Dialog Box

The Edit Legend Cell dialog box allows you to inspect and change the properties of the selected
cell.

The Edit Legend Cell dialog box is a Multiple Page dialog box. See Section B.2, Multiple Page
Dialog Boxes, for more information.
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15.5.6. Text Page
The Text page of the Edit Legend Cell dialog box allows you to change the text of a text cell.

Cell Test:
Created by {AppMame} version {Apptersion},

Fix}

Type the desired text in the box provided. The text can have as many lines as desired: press the
Enter key to insert a new line.

The text can include symbolic fields, placeholders for text that is automatically inserted when the
legend is printed. For example, the field {ConciseGridDescription} is automatically replaced
with a short description of the plot's primary grid.

Symbolic fields can also represent graphical elements, such as a north arrow. Of particular
interest is the {Plot} symbol, which represents the plot being annotated by the legend. Each
legend should contain exactly one text cell that has the {Plot} symbol as part of its text.

Some commonly used symbolic fields are:

Field Description
{ConciseGridDescription} Short description of the plot's primary grid
{DetailedGridDescription} Longer, more detailed description of the plot's primary

grid
{Metric} The data metric of the plot's primary grid: i.e., what is

1

being measured by the grid. For example, "aircraft noise'
or "water temperature"

{Units} Physical units of the plot's primary grid. For example,
"dB" or "degrees C".
{GridFilename} Name of the file containing the plot's primary grid
{CurrentDate} Date on which the plot is printed
{CurrentTime} Time at which the plot is printed
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{Plot} The plot being printed
{NorthArrow} An arrow indicating the direction of north on the plot

{MapScale} A graphical distance bar showing the plot scale

Press the Insert Symbolic Field button ﬂl, located to the right of the text box, to display a list
of fields from which you can choose. See Section B.5, Symbolic Fields Text Control, for more
information.

15.5.7. Size Page
The Size page of the Edit Legend Cell dialog box allows you to specify the horizontal and
vertical size of a cell.

Cell "idth:
' Detemine cell width automatically
™ Cell should be...

I Ab Least j I 5 cm wide

™ Cell should be...

IE:-:au:tI_l,l _I wide enough for contents

™ Aszlage as possible

Cell Height:
= Detemine cell Height automatically
' Cell should be...

IE:-:an::tI_l,l j |5 i high

™ Cell should be...

I.-’-‘-.t Least _I high enough for contents

i~ Az large az possible

You can specify both the cell's width (i.e., horizontal size) and height (i.e., vertical size). Since
the width and height are specified in an analogous manner, only the width is described in detail.

Select the method used to specify the cell's width. You have four choices.

e Determine cell width automatically - NMPlot will automatically calculate an appropriate
width for the cell. For text cells, the width is computed from the text being displayed. For
organizer cells, the width is computed from the widths' of the cell's child cells.
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e (Cell should be - Type the width of the cell, in centimeters. Choose Exactly from the
drop-down list to force the cell to be exactly the width you supplied. Choose At least to
allow the cell to be wider: NMPlot will assign the cell a larger width if there is room for it.

e (Cell should be - Choose how the cell uses its contents (either its text or child cells) to
determine its own width. Choose Exactly to restrict the cell to the smallest width that will
accommodate its contents. Choose At least to allow the cell to be wider: NMPlot will assign
the cell a larger width if there is room for it.

e As large as possible - The cell will be as wide as possible: it will fill the horizontal space
available for it.

15.5.8. Style Page

The Style page of the Edit Legend Cell dialog box allows you to specify the visual appearance of
a cell: its color, font, and justification.

B ackground Color; ||:| white j
Text Calar; I- Black j
Test Font: |12 pt Times Mew Raoman _I

Harizontal Justification; I Left "’I

Wertical Justification: Top =

Background color - Select the background color of the cell. See Section B.10, Color Control, for
information on selecting colors.

Note that for some organizer cells, the background color will not be visible, as the entire cell will
be filled with other cells that have their own background colors. Typically, you will set the
background colors of all text cells, and all organizer cells that have non-zero margins.

Text Color - Select the color of the cell's text. This is relevant only for text cells.

Text Font - Select the font used to display the cell's text. This is relevant only for text cells. See
Section B.9, Font Control, for information on selecting fonts.

Horizontal Justification - Select how the cell's contents (either its text or its child cells) are
horizontally justified. You have three choices: Left, Center, and Right.

Vertical Justification - Select how the cell's contents (either its text or its child cells) are
vertically justified. You have three choices: Top, Center, and Bottom.
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15.5.9. Margins Page

The Margins page of the Edit Legend Cell dialog box allows you to specify a cell's margins. The
margins are white space around the edge of the cell, similar to the margins on a piece of paper.

% Set all cell marging:

E jom ]

™ Set horizontal and vertical cell marging individually:

Harizontal b arginz: IEI Iu:m j

Wertical b argins: IEI Iu:m j

™ Set each cell margin individually:

Left Margin: [0 EE
Right Margin: [0 EE
Top Magin: |0 [em ]
Bottom Marin: [0 [en ]

Choose the method used to specify the margins. You have three choices: specifying a single
margin for all four sides of the cell, specifying different margins for the left-right and top-bottom
sides of the cell, and specifying the margins for all four sides individually.

Type the desired margin or margins, and select the units used to specify the margins.

15.5.10. Borders Page

The Borders page of the Edit Legend Cell dialog box allows you to specify a cell's borders. The
borders are optional lines that can be drawn around some or all of the four edges of the cell, just
outside of the margins.
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Choose the method used to specify the borders. You have four choices: displaying no borders,
specifying a single border style for all four sides of the cell, specifying different border styles for
the left-right and top-bottom sides of the cell, and specifying the border styles for all four sides
individually.

Select the desired color(s) of the line(s) used to draw the borders. See Section B.10, Color
Control, for information on selecting colors.

Type the desired width(s) of the line(s) used to draw the borders, in millimeters. If a width of
zero is specified, then the border is not drawn.
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Chapter

Using Print Preview

NMPIlot's print preview capability lets you view the pages of a document before you print it. You
can select paper orientation and margins, view 1, 2, 4, or more pages at a time, magnify
individual pages for close inspection, and select individual pages to print.

To print preview a plot, either press the Print Preview button [& on the application toolbar, or
choose Print Preview from the File menu.

To print preview the NMPlot User's Guide, press the print preview button [& on the User's Guide
reader toolbar. See Chapter 22, Accessing Help, for more information.

16.1. Print Preview Dialog Box

The Print Preview dialog box is used to print preview documents.

Using Print Preview 133



Print Preview - User's Guide

[Q i (S| 1« <> »|m| ODBEEEE

ey -
e

L ——
:r e o

E = Drns B ey

THR Wawinng Cieidvree Taghid ia N Tabie of Cormens
1oy o b o o PR s parnh s el e ey ey 8 iy
newdom me B g, b i o s oper

Lo | T SR

Fage 3 of ¥

= Hepers o, A el e

L1 Swircbang The Ropboard Facan Boreees Panea
o, sk th haik o o rigt s e U Ls's okt P Bsa s b
s s B, e s, s smc oy il icheor it et el

ot il o savll e it . T b Mo b a0 s ol s . v L Tk

by

e Svaing ihve Table of Dasrmtr

O NI P ———
bl

Pross £ + 7 b ritch borwean slowing and g, B mebie o cononts

L
Inch g B we b ban, B L' Grack Fosrsppors yparin The s deplryed assg
bl ryp Ok o ek e Follomy L

Heomvw hach v provieusty vied topeo Ty

# s Cu bk bas 8

Use either the toolbar buttons or the keyboard to navigate through the pages.

Button Key Description
4 - Go forward to next page
1 «— Go back to previous page
M Page Down Go forward to next group of pages
“ Page Up Go back to previous group of pages
P End Go to last page
4 Home Go to first page

16.2. Magnifying a Page

You can magnify a page to study it in detail. Follow these steps.

1. Press the Magnify toolbar button QL. This activates the Magnify Page tool.
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2. Click on a page. The page is magnified so that it fills the print preview window.

Print Preview - User's Guide x|
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16.2.2. Viewing Obscured Topics in the Table of Contents
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16.2.2. Switching The Keyboard Focus Between FPanes

Ataty giventime, either theleft or the right pane of the Uset's Guide Feader has the keyboard
focus. Depending onwhich pane has the focus, the arrow keys will either navigate the table of :I

3. Click on the page a second time to return it to its normal size. Alternatively, press the - key.

16.3. Displaying Multiple Pages at a Time

You can display 1, 2, 4, or more pages simultaneously.
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Use either the toolbar buttons or the keyboard to change the number of pages simultaneously
displayed.

Button Key Description

Ctrl +1 Show 1 page at a time
Ctrl +2 Show 2 page at a time
Ctrl +3 Show 4 page at a time
Ctrl + 4 Show 8 page at a time
Ctrl +5 Show 16 page at a time

Ctrl +6 Show 32 page at a time

Ctrl +7 Show 64 page at a time

Press the + key to decrease the number of pages displayed simultaneously. Press the - key to
increase the number of pages displayed simultaneously.
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@ Note:

The functions of the + and - keys may seem backwards to you. To help remember the
meanings of these two keys, note that the + key makes each page bigger. Indeed, if you
press the + key when only a single page is displayed, that page is magnified.

16.4. Printing All Pages

To print all pages from the print preview window, follow these steps.
1. Display the Print dialog box by either:
e Pressing the Print button & on the print preview toolbar

e Pressing Ctrl + P

2. Inthe Page Range section of the Print dialog box, choose All. Then press the OK button.

16.5. Selecting Pages to Print
To print a subset of the pages in the print preview window, follow these steps.
1. Press the Page Selection toolbar button M. This activates the Page Selection tool.

2. Click on the pages you want to print. A border will appear around the pages you select.
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Click on a selected page a second time to deselect it.

To select a range of pages, click on the first page in the range, then Shift + click (i.e., click
while holding down the Shift key) on the last page in the range.

To deselect a range of pages, click on the first page in the range, then Ctrl + click (i.e., click
while holding down the Ctrl key) on the last page in the range.

3. Display the Print dialog box by either:
e Pressing the Print button & on the print preview toolbar
e Pressing Ctrl + P

4. In the Page Range section of the Print dialog box, choose Selection. Then press the OK
button.
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16.6. Changing the Paper Margins and
Orientation

Display the Page Setup dialog box by either:
e Pressing the Page Setup button B on the print preview toolbar

e Pressing Ctrl + Shift + P

Microsoft Window's standard Page Setup dialog box lets you select the paper orientation (portrait
or landscape) and page margins of your printer. The exact appearance of this dialog box will
vary, depending on the version of Windows you are using. Familiarity with this dialog box is
assumed.

16.7. Closing the Print Preview Dialog Box
To close the Print Preview dialog box, you can:
e Press the Close button

e Press the Esc key
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Exporting Plots to a
Geographic
Information System

NMPIlot allow you to export plots to a Geographic Information System (GIS) in the following
formats.

e ARC/INFO Shapefile (SHP)

e AutoCAD Data Exchange Format (DXF)

O Warning:

Use the AutoCAD DXF format as a last resort, only if no alternative is available. DXF is a
poorly-documented format, which results in different applications interpreting the same

DXF file in different ways. You can expect fewer problems using another format, such as
ARC/INFO Shapefile.

17.1. Export to GIS Dialog Box

To export a plot to a Geographic Information System (GIS), follow these steps.

1. Choose Export to GIS from the File menu. The Export To GIS dialog box appears.
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Export to GIS llil

— Farmat

Format; ESRI ARCANFO Shapefile [SHP) j Froperties |

— Output Filename(z]

™ Create bazed on curent document file name

¥ [Create bazed upon this file name:

I C:\DatahTest tat _I

Dutput file[z):  C:\DatasTest_{LayerMame}_{Faints Lines Areast shp
C:hDatahTest {Laver amel {Points Lines Areash shis
C:hDatahTest {LaverM ame)_{Paoints Lines Areas) dbf

ok Cancel

Z

2. Format - Select the GIS format that you want to use to export the plot. Press the Properties
button to display the GIS Export Options dialog box, which allows you to set the export
options associated with the selected format.

3. Output Filename(s) - Specify the name(s) of the file(s) that the exported plot will be written
to. Depending on the export format, more than one file may be created. You specify a base
file name. The names of all output files are constructed from this base name by changing the
extension and/or adding a suffix.

At the bottom of the box labeled Output Filename(s), the files that will be created are listed,
based upon your current selections for the export format and the base file name.

Select the method used to specify the base file name. You have two choices.

e Create based on current document file name - The name of the plot (.nmp) file you are
exporting will be used as the base file name.

e Create based upon this file name - Type the base file name in the box provided. Press

the Browse button J, located to the right of the text box, to display the Open File
dialog box, which allows you to browse for the file.

17.2. GIS Export Options Dialog Box

Use the GIS Export Options dialog box to control how a plot is exported to a GIS.
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Options for Exporting to a GIS in ESRI ABC/INFO Shapefile [SHF] Format ilil

Option Categaories: Coordinate System Options

Coordinate System
o Level of Detail € Export in the default coordinate spstem

" Export in the following coordinate system;

niverzal Transverse Mercatar [LUTM]
Zone: 15
Cratur: Drefault [currently %GS5 34]

] 4 Cancel Ilnhdo Page

Vi

The GIS Export Options dialog box is a Multiple Page dialog box. See Section B.2, Multiple
Page Dialog Boxes, for more information. The pages on this dialog box vary, depending on
which GIS format you selected.

17.2.1. Coordinate System Page

Use the Coordinate System page of the GIS Export Options dialog box to select the coordinate
system that coordinates are exported in.

™ Export in the default coordinate system

& Export in the following coordinate system;

riverzal Tranzwverse Mercator [T k]
Zohe: 15
Draturn: Drefault [curently wWizS 84)

Choose Export in the default coordinate system to use the primary grid's coordinate system.

Choose Export in the following coordinate system to specify a coordinate system. See Section
20.1, Coordinate System Control.

17.2.2. Level of Detail Page

Use the Level Of Detail page of the GIS Export Options dialog box to control how much
background map detail is exported.
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= Export with the level of detail curently displayed on the screen

™ Export with & lewel of detail appropriate for display &t a zcale of..

1 : | 24000
[ [inch —] = [2000 [fest ]

Many background maps specify a minimum scale at which various features should be displayed.
As you zoom in on such a map, additional detail is displayed. The intent is to prevent excessive
detail from cluttering a plot when it is displayed at a small scale. See Chapter 14, Background
Map Formats.

Use the Level of Detail page to control how NMPlot uses this recommended scale information
when you export a plot to a GIS. You have two choices for how NMPlot determines how much
detail to export.

o Export with the level of detail currently displayed on the screen - The level of detail is the
same as that currently displayed by the plot on your computer's monitor.

o Export with a level of detail appropriate for display at a scale of - The level of detail is the
same as if the plot was displayed at a scale you specify.

17.2.3. Contours Page

Use the Contours page of the GIS Export Options dialog box to control how contours are
exported.

v Append the contaur level bo names of layers that contain contours

Most GIS formats allow attributes to be associated with objects. When exporting contours in one
of these formats, the contours' levels are associated with the contours as attributes.

The DXF format does not support attributes. However, it does support named layers. If you
check this box, NMPIlot will export each contour in a separate layer. The name of each of these
layers is created by taking the contour layer name and appending the contour's level to it.

@ Note:

This page appears on the GIS Export Options dialog box only if you are exporting to a GIS
in AutoCAD DXF format.
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Exporting Plots as
Bitmap Images

Using NMPlot, you can create a bitmap image of a plot. The image can be stored in a file or
copied onto the clipboard. More than a mere screen capture, the image can be created at a high
resolution (for example, 600 pixels per inch), resulting in a publication-quality image. For
low-resolution plots that will be displayed on a computer monitor, you can use oversampling to
improve the plot's appearance.

18.1. Exporting a Plot to a Bitmap Image File

To export a plot to a bitmap image file, choose Export to Bitmap from the File menu. The Bitmap
File Export Options dialog box appears.

Bitmap File Export Options ilil
Dption Categories: File Options

o Image Size M arme and farmat of file ta write bitmap image ba:

= [Overzampling Inutput.bmp _I

= Area to Draw

= Scale 3 ) 5 :

e Level of Detal I BRP - Microzoft Windows Bitrmap j I:Iptu:unsl

0k, Cancel IIndo Page
P

The Bitmap File Export Options dialog box is a Multiple Page dialog box. See Section B.2,
Multiple Page Dialog Boxes, for more information.
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18.2. Copying a Plot to the Clipboard

To copy a bitmap image of a plot onto the clipboard, choose Copy from the Edit menu, or press
Ctrl + C. The Clipboard Copy Options dialog box appears. This dialog box is identical to the
Bitmap File Export Options dialog box, with the exception that the page used to specify the
destination file and format is not present.

In this chapter, only the Bitmap File Export Options dialog box will be discussed. Keep in mind,
however, that the options described also apply when a plot is copied to the clipboard.

18.3. Destination File Name and Format

Use the File page of the Bitmap File Export Options dialog box to set the name and format of the
file where the bitmap image is written.

MHame and format of file ta write bitmap image to:

I output, brnp _I
I BMP - Microsoft Windows Bitmap j I:Iptil:unsl

In the box provided, type the name of file where the bitmap image will be written. Press the

Browse button J, located to the right of the text box, to display the Open File dialog box, which
allows you to browse for the file.

Select the image format of the file. You have the following choices.
e BMP - Microsoft Windows Bitmap Format
e JPG - JPEG Format
e TIF - Tagged Image File Format (TIFF)

e PNG - Portable Network Graphics Format

18.3.1. JPEG Options

If you select the JPEG format, the Options button will be available. Press it to display the JPEG
Options dialog box.
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JPEG Dptions 7| x|

JPEG Image Cuality [1-100]
I 95

The Image Quality Aumber contralz the tradeoff between compression
and image quality in JPEG images. A value of 100 produces the highest
quality image, but alzo resultz in the largest file zize. Conversely, a value
af 1 praduces the smallest file zsize, but also results in a severely degraded
image.

ok Cancel |
P

Type the image quality number, an integer between 1 and 100. The Image Quality number
controls the tradeoff between compression and image quality in JPEG images. A value of 100
produces the highest quality image, but also results in the largest file size. Conversely, a value of
1 produces the smallest file size, but also results in a severely degraded image.

18.3.2. Selecting an Image Format

The JPEG format is intended for storing photographs. Most plots are line images, so one of the
other image formats will usually be a better choice. However, if your plot has areas of
smoothly-changing color (for example, a color gradient plot), JPEG will be the best format.

Neither the BMP nor the TIFF formats are compressed, so they will produce large files.
However, both are very common formats. The BMP format, in particular, is very well supported
on the Microsoft Windows platform. If you intend to import your image into another program,
the BMP format is an excellent choice.

If you intend to archive the image, or display it on the web, the PNG format is a good choice. It
achieves high compression on most plots (not color gradient plots, however). It is a newer format
than the others, but most applications (and in particular, most web browsers) now support it.

18.4. Image Size

Use the Image Size page of the Bitmap File Export Options dialog box to select the size,
resolution, and color depth of the bitmap image you will export your plot to.
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Image calar depth

| 24-bit Color (True Color] =]

% |mage iz the same size az the image on the screen
" |mage size is...

|4EIEI pirelz wide and |3EIEI pirelz high

% |mage has same resolution az the screen

" Image rezolution iz...

I 72 pixels per inch

18.4.1. Image Color Depth

Select the color depth of the bitmap image. This is the maximum number of colors in the bitmap.
You have the following choices.

e 24-bit Color (True Color) - Each pixel in the bitmap requires 24 bits (3 bytes) of memory.
The bitmap can display over 16,000,000 colors. It is recommended that 24-bit color be used
when exporting color gradient plots.

e 8-bit Color, Optimized Palette - Each pixel in the bitmap requires 8 bits (1 byte) of
memory. The bitmap can display 256 colors. The 256 colors are selected so that they best
represent the colors in your plot. This color depth requires one-third the memory of 24-bit
color. Many plots can be reduced to 256 colors with little loss in quality.

e §-bit Color, Web Palette - Each pixel in the bitmap requires 8 bits (1 byte) of memory. The
bitmap can display 256 colors. The 256 colors are those that all web browsers can display
without dithering. This color depth requires one-third the memory of 24-bit color, but the
image quality can be poor unless you carefully select the colors in your plot.

e 8-bit Grayscale - Each pixel in the bitmap requires 8 bits (1 byte) of memory. The bitmap
can display 256 shades of gray. This color format is useful if the bitmap will be printed on
black-and-white laser printers.

18.4.2. Image Size
Select the method used to specify the dimensions of the bitmap image (i.e., the width and height
of the bitmap, in pixels) that your plot will be exported to. You have two choices.

e [mage is the same size as the image on the screen - The bitmap image has the same
dimensions (in pixels) as the portion of the screen currently used to display the plot.
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e [mage size is - Type the width and height of the bitmap image, in pixels.

O Caution:

Your computer's memory limits the maximum size and color depth of an export bitmap
image. If your computer takes an exceptionally long time to export a plot to a bitmap, you
may not have enough memory. This is especially true if your hard drive light stays on
constantly while creating the image. Try reducing the image's size and/or color depth.

The image's resolution does not affect the amount of memory used.

18.4.3. Image Resolution

The resolution of a bitmap measures the size of the pixels. It is typically expressed in pixels per
inch or pixels per centimeter.

As an example, assume that your plot has features that are drawn with 1-millimeter-wide lines. If
you export this plot to a bitmap image with a resolution of 100 pixels per centimeter, these lines
will be 10 pixels wide.

Computer monitors typically have a resolution of 70 to 90 pixels per inch. Laser printers
typically have a resolution of 600 to 1200 pixels per inch.

Select the method used to specify the image resolution. You have two choices.
e [mage has same resolution as the screen

e [mage resolution is - Type the resolution, in pixels per inch.

18.5. Oversampling

NMPIlot can use oversampling to improve the appearance of low-resolution plots. Oversampling
reduces jagged edges. In technical terms, it antialiases your entire plot.

The amount of oversampling is controlled by the oversampling factor, an integer between one
and eight. An oversampling factor of one means that oversampling is not performed. Higher
factors result in smoother, higher-quality images, but also dramatically increase the amount of
memory required to export a plot.
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Use the Oversampling page of the Bitmap File Export Options dialog box to set the
oversampling factor used when exporting a plot to a bitmap image.

Owerzampling Factor [bebween 1 ta 8]

renene

Larger overzampling factorz result in zmoather, higher quality images,
but alza take mare time and memary to process.

Type the oversampling factor in the box provided.

When using oversampling, you should choose 24-bit true color or 8-bit grayscale color for your
image. See Section 18.4.1, Image Color Depth.

O Caution:

Oversampling dramatically increases the amount of memory needed to export a plot to a
bitmap image. The amount of memory required is proportional to the square of the
oversampling factor.

Until you gain familiarity with your computer's capabilities, it is recommended that you
initially export your plot with a low oversampling factor, and then attempt to export it with
gradually increasing factors. If your computer takes an exceptionally long time to export a
plot, you may not have enough memory. This is especially true if your hard drive light
stays on constantly while exporting. Try reducing the oversampling factor.

18.6. Area to Draw

Use the Area To Draw page of the Bitmap File Export Options dialog box to select the portion of
your plot that is drawn on the exported bitmap image.
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¥ Draw the home view

¢~ Draw the area curently displayed on the screen
Select the area to draw. You have two choices.

e Draw the home view - The home view of the plot is drawn. See Section 8.4, The Home
View, for more information about the home view.

e Draw the area currently displayed on the screen - The portion of the plot currently
displayed on your computer's monitor is drawn. If you want to export only a small portion
of your plot, zoom in on that section, then export the plot, choosing to draw the area
currently displayed on the screen.

@ Note:

If the Area to Draw is not the same shape as the export bitmap image (i.e., if the aspect
ratios are different), the area drawn will be larger that the area requested. See the note in
Section 15.3.2, Area to Print, for more information.

@ Note:

If you export a plot to scale, NMPlot attempts to display the Area To Draw at the requested
scale. If the requested scale is too large, this area will not fit on the bitmap image. In this
case, you have four options: 1) choose a smaller scale, 2) choose a smaller Area To Draw,
3) increase the size of the bitmap image, or 4) decrease the resolution of the bitmap image.

18.7. Scale

Use the Scale page of the Bitmap File Export Options dialog box to set the scale at which your
plot is drawn on the export bitmap image.

& Automatically select the scale at which the image is drawn

~ Draw the image at a scale of..

1 : | 100000

E [inch ] = Je333.33333 N

Select how the scale is determined.

Exporting Plots as Bitmap Images 151



o Automatically select the scale at which the image is drawn - NMPlot selects a scale so that
the plot's area of interest just fills the export bitmap image. The area of interest is specified
on the Area To Draw page. See Section 18.6, Area to Draw.

e Draw the image at a scale of - Specify the scale at which the plot is drawn on the export
bitmap image.

18.8. Level of Detail

Use the Level Of Detail page of the Bitmap File Export Options dialog box to control how much
background map detail is displayed when you export your plot as a bitmap image.

&' Draw the image with a level of detail appropriate for the scale at which the image iz diawn
= Draw the image with the level of detail currently displayed on the screen
€ Draw the image with all details displayed

Ilze caution, as thiz may show 2o much detail as to make the image unreadable
= Draw the image with a level of detail appropriate for dizplay at a zcale of ..

1+ [ 100000
[ [inen ] = Je33333333 Jrest ]

Many background maps specify a minimum scale at which various features should be displayed.
As you zoom in on such a map, additional detail is displayed. The intent is to prevent excessive
detail from cluttering a plot when it is displayed at a small scale. See Chapter 14, Background
Map Formats.

Use the Level of Detail page to control how NMPIlot uses this recommended scale information
when you export your plot as a bitmap image. You have four choices for how NMPlot
determines how much detail to display.

e Draw the image with a level of detail appropriate for the scale at which the image is drawn
- Any recommended scale information in the background map is used.

e Draw the image with the level of detail currently displayed on the screen - The level of
detail is the same as that currently displayed by the plot on your computer's monitor.

e Draw the image with all details displayed - Any recommended scale information in the
background map is ignored.
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O Caution:

This may display so much background map detail as to make the exported image
illegible.

e Draw the image with a level of detail appropriate for display at a scale of - The level of
detail is the same as if the plot was being exported at a scale you specify.
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Creating Movies

Using NMPlot, you can create a movie from a group of grid files. The movie's frames consist of
plots of your grid files.

As an example, consider the high temperature on January 1 of last year, as measured at a number
of cities across the United States. You could make a grid file containing these measurements, and
then use NMPlot to create a contour plot of the temperatures, displayed over a background map
of the United States. This plot would show you the distribution of high temperatures on January
1.

Now assume that you have 365 of these grid files, each corresponding to a single day of last year.
Using NMPlot, you could create a movie from these grids. This movie would display the plot of
high temperatures mentioned in the previous paragraph. Only now, the plot would be animated.
The contours would move, and you could see how the high temperatures varied throughout the
year.

19.1. Steps in Creating a Movie

To make a movie, follow these steps.

1. Create grid files from your data. See Appendix G, Quick-Start Guide to Importing Data into
NMPlot, Chapter 4, Introduction to Grids, and Appendix F, Introduction to the Noise
Model Grid Format, for information on creating grid files.

All of the grid files must be located in the same directory, and must have identical file
names, with the exception of a number just before the extension at the end of the file name.
For example, the following list of grid file names would meet these conditions.

e C:\temp\MyDatal.grd

e C:\temp\MyData2.grd

e C:\temp\MyData3.grd
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The movie will display plots of your grid files, ordered by the numbers at the end of the
grids' file names. Leading zeros in the file names (MyData009.grd, MyData010.grd,

MyData011.grd) are allowed but not required.

2. Create a plot of one of the grids (it does not matter which one). Set all plot options (contour
levels, background maps, etc.) as desired. See Chapter 7, Introduction to Plots.

g Tip:

Pay particular attention to the plot's home view. By default, the home view displays
the area covered by the largest contour. This works well for a single plot. However,
for movies where the contours move, such a home view may cause the plot's
background to also move. This can be distracting.

For best results, set the home view to the primary grid and/or the define area polygon.
Or, manually specify the home view. See Section 8.4, The Home View, for more

information.

3. Choose Create Movie from the File menu. The Create Movie dialog box appears.

Create Movie

Option Categories:

Bl ovieFile |
Size

Flayback Speed
Overzampling

Level of Detail
Fresig

(=] (=] (=] (=] o

kuovie File Options

MHame of file to wite mowvie to;

2l x|

I C:ADatab Myt ovie. awi

The movie will be written in A% format. Typically, A4 files have the
extenzion ' aw',

ok

Cancel IIndo Page |

The Create Movie dialog box is a Multiple Page dialog box. See Section B.2, Multiple Page
Dialog Boxes, for more information.

Set the various movie options as desired, and then press the OK button.

4. NMPIlot begins creating the movie. Depending on the options you selected, this can take
anywhere from a few seconds to a few hours. A dialog box is displayed that shows

NMPlot's progress.
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Creating Movie “output_avi" EI

[ EEERENEEEEEER  Computing contours E
_ Processing movie frame 9 of 40

Femaining time: 0:17
Q‘-—
r\ﬁ e
QO
:‘ ;
VAN

Cancel

When the movie is finished, this dialog box disappears. The movie will be in the AVI file
whose name you specified on the Movie File page of the Create Movie dialog box. You can
display the movie using any third-party multimedia application capable of playing AVI files
(for example, Microsoft Media Player). You can also post the movie on the Internet, or load
it into a third-party movie editing program for editing.

19.2. Movie File

Use the Movie File page of the Create Movie dialog box to set the name of the file where your
movie will be written.

M arne of file ta write movie b
C:hhemphoutput avi _I

The movie will be wiitten in A4 format. Typically, &4 files have the
emtenzion " avi',

In the box provided, type the name of file where your movie will be written. Press the Browse

button J, located to the right of the text box, to display the Open File dialog box, which allows
you to browse for the file.

Your movie will be written as an AVI file. Typically, AVI files have the extension .avi.
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19.3. Size

Use the Size page of the Create Movie dialog box to select the size, resolution, and format of the
frames in your movie.

b ovie format;

I 24-bit Color [True Color), Uncompreszed j

" Movie frames are the same size az the plot on the screen
& Movie frames are...

|4I:IEI pixels wide and |3EIEI pixelz high

% hovie frames have same resolution as the screen

" Movie frames have a resolution of ..

I T pixelz per inch

19.3.1. Movie Format

Select the format of the frames in your movie. This is a combination of the color depth (the
maximum number of colors in each frame) and the compression method. You have the following
choices.

e 24-bit Color (True Color), Uncompressed - Each frame pixel requires 24 bits (3 bytes) of
memory. Frames can display over 16,000,000 colors. No compression is used. It is
recommended that this format be used if your movie displays a color gradient plot.

e §8-bit Color, Optimized Palette, Uncompressed - Each frame pixel requires 8 bits (1 byte) of
memory. Frames can display 256 colors. No compression is used.

e §8-bit Color, Optimized Palette, Compressed with RLE - Each frame pixel requires 8 bits (1
byte) of memory. Frames can display 256 colors. Frames are compressed using Run Length
Encoding (RLE). This format will usually result in the smallest movie file.

e 8-bit Grayscale, Uncompressed - Each frame pixel requires 8 bits (1 byte) of memory.
Frames can display 256 shades of gray. No compression is used.

e 8-bit Grayscale, Compressed with RLE - Each frame pixel requires 8 bits (1 byte) of
memory. Frames can display 256 shades of gray. Frames are compressed using Run Length
Encoding (RLE).
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19.3.2. Movie Frame Size

Select the method used to specify the dimensions of the frames in your movie (i.e., the width and
height of your movie, in pixels). You have two choices.

e Movie frames are the same size as the plot on the screen - Your movie has the same
dimensions (in pixels) as the portion of the screen currently used to display the plot that this
movie is based upon.

e Movie frames are - Type the width and height of your movie, in pixels.

19.3.3. Movie Frame Resolution

The resolution of a movie frame measures the size of the pixels. It is typically expressed in pixels
per inch or pixels per centimeter.

As an example, assume that your movie has features that are drawn with 1-millimeter-wide lines.
If your movie has a resolution of 100 pixels per centimeter, these lines will be 10 pixels wide.

Movies typically have the same resolution as computer monitors: i.e., 70 to 90 pixels per inch.
Select the method used to specify the resolution. You have two choices.
e Movie frames have same resolution as the screen

e Movie frames have a resolution of - Type the resolution, in pixels per inch.

19.4. Playback Speed

Use the Playback Speed page of the Create Movie dialog box to set the rate at which your movie
should be displayed.

tovie playback speed [between 0.01 and 100);

I 15 frames per zecond

In the box provided, type the speed at which your movie should be played, in frames per second.
Typical speeds are between 8 and 36 frames per second.

Divide the total number of frames in your movie (i.e., the number of grid files) by the playback
speed to determine the total length of your movie, in seconds.
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19.5. Oversampling

NMPIlot can use oversampling to improve the appearance your movie. Oversampling reduces
jagged edges. In technical terms, it antialiases your movie's frames.

The amount of oversampling is controlled by the oversampling factor, an integer between one
and eight. An oversampling factor of one means that oversampling is not performed. Higher
factors result in smoother, higher-quality movies, but also dramatically increase the amount of
memory required to create them.

Ouersampllng Factor = ﬂuersampllng Factor = Oversampling Factor =

Use the Oversampling page of the Create Movie dialog box to set the oversampling factor used
when creating your movie.

Owverzampling Factor [between 1 to 8]

e

Larger overzampling factors result in zmoather, higher quality movies, but
alzo increase the time and memory needed to create the movie.

Type the oversampling factor in the box provided.
When using oversampling, you should choose 24-bit true color or 8-bit grayscale color for your
movie's color depth. See Section 19.3.1, Movie Format.

O Caution:

Oversampling dramatically increases the amount of memory needed to create your movie.
The amount of memory required is proportional to the square of the oversampling factor.

Until you gain familiarity with your computer's capabilities, it is recommended that you
initially create your movie using a low oversampling factor, and then attempt to create it
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with gradually increasing factors. If your computer takes an exceptionally long time to
create your movie, you may not have enough memory. This is especially true if your hard
drive light stays on constantly. Try reducing the oversampling factor.

19.6. Level of Detail

Use the Level of Detail page of the Create Movie dialog box to control how much background
map detail is displayed in your movie.

& Draw movie frames with a level of detail appropriate for the scale at which the frames are drawn
= Diraw movie frames with the level of detail curently displayed on the zcreen

" Draw movie frames with all details displayed
I1ze caution, as this may show 2o much detail az to make the movie illegible
= Diraw movie frames with & level of detail appropriate for display at a scale of ..

1 : [100000
[ [inch =] = Je33333333 [fet ]

Many background maps specify a minimum scale at which various features should be displayed.
As you zoom in on such a map, additional detail appears. The intent is to prevent excessive detail
from cluttering a plot when it is displayed at a small scale. See Chapter 14, Background Map
Formats.

Use the Level of Detail page to control how NMPlot uses this recommended scale information
when you create your movie. You have four choices for how NMPlot determines how much
detail to display.

e Draw movie frames with a level of detail appropriate for the scale at which the frames are
drawn - Any recommended scale information in the background map is used.

e Draw movie frames with the level of detail currently displayed on the screen - The level of
detail is the same as that currently displayed by the plot on your computer's monitor.

e Draw movie frames with all details displayed - Any recommended scale information in the
background map is ignored.

O Caution:

This may display so much background map detail as to make your movie illegible.
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e Draw movie frames with a level of detail appropriate for display at a scale of - Your movie
is created with a level of detail appropriate for the scale you specify.

19.7. Preview

Use the Preview page of the Create Movie dialog box to see a summary of the options that will
be used to create your movie, and to preview selected frames.

Y'ou are creating a movie conzisting of 40 framez. Each
frame will dizplay a plat of a grid file located in the directony
"CoAbypDatah,

Frame 1 will display grid file MupGnd-0071. grd
Frame 2 will dizplay grid file kMyGnid-002. grd

Frame 39 will display grid file MyGrid-039.grd
Frame 40 will dizplay arid file MyGnd-040.grd

Show Al Grid File Names |

The maovie will be written to the file "C: WMol atabbdpbd ovie awi'.
The zize of this file will be 13.7 ME.

Preview Frame | number |1 [between 1 and 40]

The text presents a brief summary of the movie that will be created. This summary includes a
listing of grid files associated with the first and last frames in the movie. To see a full listing of
the grids files that will be used, press the Show All Grid File Names button.

/ Important:

Pay particular attention to the size of the AVI movie file that will be created. Movies can
be very large: ensure that you have enough free hard disk space to hold the movie. Also,
the AVI file must be smaller than 1.96 Gigabytes: a warning will be displayed if this limit
may be exceeded.

P The size of thiz file will be 213 GE, which excesds the mavimum size of 1.95 GE.

To preview a frame from your movie, type the frame number in the box provided, then press the
Preview Frame button. The requested frame will be displayed. There may be a delay before the
frame appears.
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g Tip:

Movies can take a long time to create. Therefore, you should preview a representative
sampling of your movie's frames to insure that you are satisfied with the options you have
selected.
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Chapter

Geographic
Coordinate Systems

The location of a point on the Earth's surface can be numerically described in a number of ways.
Examples include:

e the longitude and latitude of the point (100.5° west, 45.3° north)

e the location with respect to another known point (500 feet northwest of the Empire State
Building)

e the Universal Transverse Mercator coordinates of the point (715,326.1 meters east,
5,037,295.1 meters north, UTM zone 15)

Each of these methods of describing a location is known as a geographic coordinate system.
When working with maps, the term projection is also commonly used. While there are technical
differences, for most practical purposes, you can consider the terms "coordinate system" and
"projection" as synonymous.

NMPIlot allows you to use a number of common coordinate systems when working with
geographic data. The supported coordinate systems are:

e Equirectangular

e Lambert Azimuthal Equal Area
e Lambert Conformal Conic

e Local Flat-Earth X-Y

e Longitude and Latitude

e Orthographic

e Stereographic
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e Universal Transverse Mercator (UTM)

For additional information about coordinate systems, the following references are recommended.

o An Album of Map Projections, U.S. Geological Survey Professional Paper 1453, by John P.
Snyder and Philip M. Voxland, United States Government Printing Office, 1989.

e Map Projections—A Working Manual, U.S. Geological Survey Professional Paper 1395, by
John P. Snyder, United States Government Printing Office, 1987.

20.1. Coordinate System Control

A Coordinate System Control is used to select a geographic coordinate system.

niverzal Transverse Mercatar [LIT ]
Zone: 15
Dratum: WG5S 84

The current coordinate system is displayed in the box. To change it, either press the Space Bar, or

press the Select Coordinate System button J The Select Coordinate System dialog box is
displayed.
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Select coordinate system llil

— I niverzal Transverse Mercator [UTM] j

v Always use zone

|15 (Longitude from 96 t0 30 “west) ]

Falze easting:
% Default value [500,000]

™ User specified value
IEEII:II:IEIEI

Falze northing:

&+ Diefault value for nothern hemizsphere (0]
= Default value for zouthem hemisphere (10,000,000
™ User specified value

—

Dratum ;

w5 84 [

Save ToFile Load From File ok Cancel |
P

Use the drop-down list at the top of the outlined area to select the coordinate system. Then
supply values for the selected system's parameters.

Some coordinate systems have numerous parameters, which can be tedious to enter. Therefore,
NMPIlot allows you to save coordinate systems to files for later reuse. Press the Save To File
button to save the current coordinate system to a file. Press the Load From File button load a
previously saved coordinate system.

20.2. Coordinate System Conversion Tool

The coordinate system conversion tool allows you to convert a point's coordinates from one
geographic coordinate system to another. To use the tool, follow these steps.

1. Choose Coordinate System Conversion Tool from the Tools menu. The Coordinate System
Conversion Tool dialog box appears.
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. From Coordinate System - Select the geographic coordinate system that you are converting
from. See Section 20.1, Coordinate System Control, for information on selecting a
coordinate system.

. From Point - Specify the geographic coordinates of the point in the coordinate system you
are converting from. The controls available for entering the point will vary, depending on
the From coordinate system.

. To Coordinate System - Select the geographic coordinate system that you are converting to.
See Section 20.1, Coordinate System Control, for information on selecting a coordinate
system.

. To Point - The geographic coordinates of the point, expressed in the To coordinate system,
are displayed. Press the "Copy To Point to Clipboard" button to put this text onto the
clipboard.
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Q Tip:

You can use the coordinate system conversion tool to convert between datums. Choose
"Longitude and Latitude" for both the From and To coordinate systems. Set the datums of
the From and To coordinate systems to your From and To datums, respectively.

ooz | [wead]

45.45555 Morth =

Q Tip:

You can use the coordinate system conversion tool to convert a longitude and latitude from

decimal degrees to degrees, minutes, and seconds, or vice versa. Make sure that you use the
same datum for both the From and To coordinate systems.
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Longitude and Latitude
Espress az degrees, minutes, and seconds

From Coordinate Syztem: D atum;: WiGs 84
Long: |30 o (T T
From Paint:
Lat: [45 S FEE FICTI [T

Longitude and Latitude
Espress as decimal degrees
To Coordinate Systen: D atum;: WiGs 84

TaPaoint:  long: 9024600197 % lat 454569757 M

20.3. Equirectangular

20.3.1. Description

The Equirectangular coordinate system is essentially a direct scaling of longitudes and latitudes
to distances east and north, with the scaling selected such that distortion is minimized along the
central latitude parallel. Distortion increases with distance from the central latitude: this increase
becomes quite rapid near the poles.

The Equirectangular coordinate system is most useful for maps of regions that are predominantly
east-west in extent. The Equirectangular coordinate system is often used to map bands that
encircle the Earth and are enclosed by two fairly close parallels of latitude: for example, the
region between latitudes 20° north and 30° north. It is also used in situations where ease of
mapping is paramount.

This coordinate system is also know by the names Equidistant Cylindrical, Rectangular, and La
Carte Parallelogrammatique.
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20.3.2. Parameters

= I E quirectangular j
Center longitude and latitude:
Long: IEI * I'W'estj Lat; IEI * INDrth j

Falze easting and northing:
E o W o

Dratum ;

w5 84 [

e Center longitude and latitude - Type the center longitude and latitude. To minimize
distortion, the center latitude should be near the center of your area of interest.

e False easting and northing - Type the false easting and northing, and select the units used to
express them. Locations in this coordinate system are expressed using these units.

e Datum - Select the coordinate system's datum. See Section B.14, Datum Control, and
Appendix H, Introduction to Datums, for information on selecting datums.

20.4. Lambert Azimuthal Equal Area

20.4.1. Description

The Lambert Azimuthal Equal Area coordinate system is commonly used for both small- and
large-scale maps of regions that are roughly circular in extent. This is an equal-area coordinate
system, meaning that the areas of all regions are shown in the same proportion to their true areas.
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20.4.2. Parameters

= I Lambert Azimuthal Equal Area j
Center longitude and latitude:

Long: IEI * I'W'estj Lat; IEI * INDrth j
Falze easting and northing:

lo 3k m =]

Dratum ;

w5 84 [

e Center longitude and latitude - Type the center longitude and latitude. To minimize
distortion, the center longitude and latitude should be near the center of your area of

interest.

e False easting and northing - Type the false easting and northing, and select the units used to
express them. Locations in this coordinate system are expressed using these units.

e Datum - Select the coordinate system's datum. See Section B.14, Datum Control, and
Appendix H, Introduction to Datums, for information on selecting datums.

20.5. Lambert Conformal Conic

20.5.1. Description

The Lambert Conformal Conic coordinate system is commonly used for large-scale maps of
regions that are predominantly east-west in extent.

This coordinate system is also know by the name Conical Orthomorphic.
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20.5.2. Parameters

B I Lambert Conformal Conic j
Center longitude and latitude:
Long: IEI * I'W'estj Lat: IEI * INDrth j
Standard parallels:
First:IEEl * INDrthj Seu:u:und:lEEl : INDrthj

Falze easting and northing:
|o o [m =

Dratum

| \wEs 84 |

o (Center longitude and latitude - Type the center longitude and latitude. To minimize
distortion, the center latitude should be near the center of your area of interest.

e Standard parallels - Type the first and second standard parallels. Typically, these will be
near the southern and northern borders of your area of interest.

/ Important:

The standard parallels cannot be symmetrical spaced on opposite sides of the equator.
For example, standard parallels of 30° south and 30° north are illegal.

e False easting and northing - Type the false easting and northing, and select the units used to
express them. Locations in this coordinate system are expressed using these units.

e Datum - Select the coordinate system's datum. See Section B.14, Datum Control, and
Appendix H, Introduction to Datums, for information on selecting datums.

20.6. Local Flat-Earth XY

20.6.1. Description

In the Local Flat-Earth XY coordinate system, locations are specified using a local Cartesian
coordinate system: for example, meters east and north of a reference point. To specify this
coordinate system, you must know both the X-Y and Longitude-Latitude coordinates of a
reference point.
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To minimize distortion, you should select a reference point near the center of your area of
interest.

The Local Flat-Earth XY coordinate system is good general-purpose projection for maps of fairly
small regions (tens of miles across) that have roughly the same east-west and north-south extent.

Technically, this projection is based upon a conical projection developed by the US Federal
Aviation Administration for use by their Integrated Noise Model (INM). It is documented in an
appendix of the INM User's Guide.

20.6.2. Parameters

| Local FlatE arth -y =

-7 coordinates of a reference point:

| 100000 . | 200000

Longitude and latitude of a reference point:
Long: IEI : IWest j Lat: IEI : I Harth j
Inits of ¥ coordinate system axes:
Faotation of # axiz in degrees counterclockwize friom east;
IIJ
Cratum

|ws 84 [

e X-Y coordinates of a reference point - Specify the (X, Y) coordinates of the reference point.

e Longitude and Latitude of a reference point - Specify the longitude and latitude of the
reference point, in decimal degrees.

e Units of the XY coordinate system axes - Select the units used to measure distances along
the X-Y coordinate system axes.

e Rotation of X axis in degrees counterclockwise from east - Typically, projections measure
distances east and north from a reference point. However, rotated projections are also
possible. Specify the direction that the X axis points, in degrees counterclockwise from east.

e Datum - Select the coordinate system's datum. See Section B.14, Datum Control, and
Appendix H, Introduction to Datums, for information on selecting datums.

As an example, assume a Local Flat-Earth XY coordinate system is defined as follows.
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e Reference Point, X-Y: 100, 200

e Reference Point, Longitude and Latitude: 90° west, 45° north
e Units of XY Axes: feet

e Rotation of X Axis: 45°

In this example coordinate system, the point (110, 200) would be located 10 feet northeast of
longitude 90° west, latitude 45° north.

20.7. Longitude and Latitude

20.7.1. Description

Longitude and Latitude is the most common and well-known geographic coordinate system.
Locations are specified in degrees of east longitude and north latitude.

20.7.2. Parameters

— I Longitude and Latitude j —

Express A I Degrees, Minutes, and Seconds j

Dizplay Order: I Longitude-Latitude j

L aturm:

|wGs 84 B

e FExpress as - Select how the longitude and latitude should be presented. You have three
choices.

e Decimal Degrees (for example, 85.175000°)
e Degrees, Minutes, and Seconds (for example, 85° 10' 30.00")

e Degrees and Decimal Minutes (for example, 85° 10.5000' )

@ Note:

In some situations, the Express as choice will not be available.
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e Display Order - Select the order in which longitude and latitude are presented. You have
two choices.

e [ongitude-Latitude (long: 85.175° W lat: 35.675° N)

e Latitude-Longitude (lat: 35.675° N long: 85.175° W)

@ Note:

In some situations, the Display Order choice will not be available.

e Datum - Select the coordinate system's datum. See Section B.14, Datum Control, and
Appendix H, Introduction to Datums, for information on selecting datums.

20.8. Orthographic

20.8.1. Description

The Orthographic coordinate system is most often used to display an entire hemisphere. Such a
map will appear similar to the Earth as seen from a spacecraft located directly above the center
longitude and latitude.

When the center latitude is 90 south or 90 north, this projection is also used to display the polar
regions of the Earth.

20.8.2. Parameters

= I Orthographic j
Center longitude and latitude:
Long: IEI * I'W'estj Lat; IEI * INDrth j

Falze easting and northing:
|o o [m =

Dratum ;

w5 84 [
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e (Center longitude and latitude - Type the center longitude and latitude. To minimize
distortion, the center longitude and latitude should be near the center of your area of

interest.

e False easting and northing - Type the false easting and northing, and select the units used to
express them. Locations in this coordinate system are expressed using these units.

e Datum - Select the coordinate system's datum. See Section B.14, Datum Control, and
Appendix H, Introduction to Datums, for information on selecting datums.

20.9. Stereographic

20.9.1. Description

The Stereographic coordinate system is commonly used for both small- and large-scale maps
(showing one hemisphere or less) of regions that are roughly circular in extent.

When the center latitude is 90 south or 90 north, this projection is also used to display the polar
regions of the Earth.

20.9.2. Parameters

= I Stereographic j
Center longitude and latitude:
Long: IEI * I'W'estj Lat; IEI * INDrth j

Falze easting and northing:
|o o [m =

Dratum ;

w5 84 [

e Center longitude and latitude - Type the center longitude and latitude. To minimize
distortion, the center longitude and latitude should be near the center of your area of

interest.

e False easting and northing - Type the false easting and northing, and select the units used to
express them. Locations in this coordinate system are expressed using these units.
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e Datum - Select the coordinate system's datum. See Section B.14, Datum Control, and
Appendix H, Introduction to Datums, for information on selecting datums.

20.10. Universal Transverse Mercator (UTM)

20.10.1. Description

Universal Transverse Mercator, or UTM, is a common coordinate system that specifies locations
in meters east and north from a reference point.

The UTM system divides the globe into 60 zones, each 6 degrees of longitude wide and
stretching from 80 degrees south latitude to 80 degrees north latitude.

UTM is suitable for mapping regions that are contained entirely within a single zone and its two
adjacent zones. Beyond this, distortion increases rapidly.

20.10.2. Parameters

= I niverzal Tranzverse Mercator [UT ] j

|_ Alwaps Lze Zohe

[15  (Longiude from 96 t0 90 * west)  —|

Falze easting:
&+ Defaulk value [500,000]

= Lzer specified value
I A000a0

Falze northing:
% Default value for nothern hemisphere [0
" Defaulk value for southern hemizphere [10,000,000)

= Lzer specified value
I 1]

Dratum ;

s 24 |
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Always use zone - If you check this box, select the UTM zone number that will always be
assumed. If you do not check this box, you will be asked for the zone whenever you enter
coordinates.

@ Note:

In some situations, you will be required to specify the UTM zone number.

False easting - Select the false easting. Typically, this is 500,000, but in rare situations, a
different value may be used. Unless you know otherwise, use the default of 500,000.

False northing - Select the false northing. This is usually 0 in the northern hemisphere. In
the southern hemisphere, 10,000,000 is often used. Unless you know otherwise, use the
recommended default of 0 or 10,000,000, depending on your hemisphere.

Datum - Select the coordinate system's datum. See Section B.14, Datum Control, and
Appendix H, Introduction to Datums, for information on selecting datums.
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Setting NMPlot
Application Options

Application options allow you to customize NMPlot.

21.1. The NMPlot Application Options Dialog
Box

Most application options are set using the NMPlot Application Options dialog box. To change
these options, follow these steps.

1. Choose Application Options from the Options menu. The NMPlot Application Options dialog
box appears.
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2. The left portion of the dialog box displays a list of option categories. One category in this
list is always selected. The right portion of the dialog box displays controls that allow you
to change the options in the selected category. Select the desired category by clicking on it.

The Application Options dialog box is a Multiple Page dialog box. See Section B.2,
Multiple Page Dialog Boxes, for more information.

3. Change the options as desired, then press OK.

21.2. Default Datum

Use the Default Datum page of the NMPlot Application Options dialog box to set the default
datum.

Default datum aszumed far geagraphic data:

WG5S B4 ]

IF the majority of geographic data you work, with iz in a single datum,
choose it az the default. Othenwize, zet the defaulk to 'WGES-34. ou
will be able to override the default datum where neceszany.

If the majority of the geographic data that you work with is in a single datum, choose it as the
default. Otherwise, set the default to WGS-84.

NMPIlot will assume that all geographic data is in the default datum unless you specify otherwise.
You will be able to override the default datum where necessary.

See Appendix H, Introduction to Datums, for general information on datums. See Section B. 14,
Datum Control, for information about the datum control, which you use to specify the default
datum.

21.3. Physical Units

Use the Physical Units page of the NMPlot Application Options dialog box to set the units of
measurement NMPlot uses to display information.

Measurement Cateqgary Phyzical Lnit

Diztance I miles "I

Area acres -
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You can select the units used for:

e Distance - The Distance units are used to display the distance between two points when

using the Measurement tool.

e Area - The Area units are used to display contour areas in both the Contour Area and

Properties Of Selected Object dialog boxes.

21.4. Mouse Location Display Coordinates

Use the Mouse Location Display Coordinates page of the NMPlot Application Options dialog
box to set the geographic coordinate system NMPlot uses to display the location of the mouse on

the status bar.

" Dizplay mouse location in plot's defaul coordinate system

% Digplay mouse location in the following coordinate system;

= E Univerzal Tranzwverse Mercator [ITH) j

|_ Always Uze zone

[15  (Longiude from 96 t0 30 * west)  —]

Falze easting:
% Default value [500.000)

' User specified value
I A00000

Falze northing:

% Default value for northem hemisphere (0]
" Default value for southern hemisphere [10,000,000]
' User specified value

—

Select whether to use the coordinate system of a plot's primary grid, or to specify a global
coordinate system used for all plots. If you select a global coordinate system, set the system's
options. See Section 20.1, Coordinate System Control, for more information on setting

coordinate system options.
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21.5. Client-Specific Extensions

Use the Client-Specific Extensions page of the NMPlot Application Options dialog box to
configure any extensions installed in your version of NMPIlot. Client-specific extensions give
NMPIot additional capabilities when working with grids created by specific third-party sources.

Inztalled Client-Specific Estenzions:

Maoizemap 7.0 Information Properties

The Client-Specific Extensions page lists all installed extensions. Press the Information button to
learn more about an extension. Press the Properties button to change an extension's options.

21.6. NOISEMAP 7.0 Client-Specific Extension

NOISEMAP is a computer program used to calculate the noise impacts of aircraft operations on
the area surrounding an airport. It was developed by the United States Air Force, but is used
world-wide for aircraft noise calculations. The NOISEMAP extension to NMPlot lets you
interactively run NOISEMAP from within NMPlot. Both grid and point-of-interest calculations
can be performed. The extension also allows NMPlot to read NOISEMAP Point-Of-Interest
(POI) files.

21.6.1. Requirements

In order to use the NOISEMAP extension to NMPlot, you must have NOISEMAP 7.0 installed
on your computer.

21.6.2. Configuring the NOISEMAP 7.0 Extension
To configure the NOISEMAP 7.0 extension, follow these steps.

1. Choose Application Options from the Options menu. The Application Options dialog box
appears.

2. Select the Extensions page.

3. Press the Properties button associated with the NOISEMAP 7.0 extension. The NOISEMAP
7.0 Extension Options dialog box appears.
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MOISEMAP 7.0 extenzion options llil

MHame and location of the MOISEMAP program [.E*E] file:
C:AMbap?0hnmap 0. exe J

ak

4. Type the name and location of the NOISEMAP computer program (i.e., the .EXE file).
Press the Browse button J, located to the right of the text box, to display the Open File
dialog box, which allows you to browse for the file.

The NOISEMAP computer program will typically have the name NMAP70 . EXE.

21.6.3. Performing a NOISEMAP Point-Of-Interest Analysis From
Within NMPIot

You can use NMPlot's Point of Interest Computation tool to perform a NOISEMAP point of
interest analysis from within NMPlot. See Section 8.8, The Point Of Interest Computation Mouse
Tool, for information on using this tool.

When you use the Point of Interest tool on a NOISEMAP grid, NMPlot will, if necessary, ask
you for the name and location of the NOISEMAP run (.RUN) file associated with that grid.

Mame of RUN file 7] x|
Enter the name of the HOISEMAP run file [[RUM] that was used to produce thiz gnd "ret1 p9.grd”
C: A apOhrat] pS.run J
Ok

After performing the analysis, NMPlot will display the results, including the ranked flight and
static event tables.

21.6.4. Performing a NOISEMAP Grid Calculation From Within NMPlot

You can use NMPlot's Grid Computation tool to perform a NOISEMAP grid calculation from
within NMPlot. Typically, you will use this feature to enhance the grid resolution around areas of
high noise gradients (for example, near runways and static pads). See Section 8.9, The Grid
Computation Mouse Tool, for information on using the Grid Computation tool.
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When you use the Grid Computation tool on a NOISEMAP grid, NMPlot will, if necessary, ask
you for the name and location of the NOISEMAP run (.RUN) file associated with that grid.

Mame of RUN file 7] x|
Enter the name of the HOISEMAP run file [[RUM] that was used to produce thiz gnd "ret1 p9.grd”
C: A apOhrat] pS.run J
Ok

21.6.5. NOISEMAP Point-Of-Interest (POI) Files

When NMPIlot opens a grid file created by NOISEMAP 7.0, it looks for a Point-Of-Interest file
that has the same name as the grid file, but with the extension . poi. If a POI file is found, it will
be read along with the grid file.

If you display a plot of a NOISEMAP 7.0 grid, and choose to display points of interest, you can
click on a point using the Display Properties mouse tool @ and display a full report on that point,
including the ranked flight and static event tables.

21.7. Setting New Plot Options

To set the options of new plots created with the New command on the File menu, follow these
steps.

1. Create a new plot, or open an existing one.
2. Display the Plot Options dialog box, and set the options as desired.
3. Choose Save As from the File menu. The Save As dialog box is displayed.

4. Navigate to the directory where you installed NMPlot: i.e., the directory where
NMPlot . exe is located. Save the plot in this directory with the name Default . nmp.

In the future, when you create a new plot, it will have the same options as Default .nmp. For
example, if the background color of the plot in Default .nmp is blue, then all new plots will
have a blue background.
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@ Note:

The primary grid of the plot in Default .nmp is irrelevant, since you are queried for the
primary grid every time you create a new plot.
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Accessing Help

22.1. Displaying the User's Guide Table of
Contents

The entire NMPlot User's Guide (this document) can be browsed online. To display the table of
contents, either:

e Press Ctrl + F1.
e Choose Contents from the Help menu.

The User's Guide Reader will be displayed, showing the table of contents.

22.2. The User's Guide Reader

Use the User's Guide Reader to browse the User's Guide online.
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Uszer's Guide ilil

nllﬁl%l ‘ﬂ:'l'_f | Close |

Contents | =

16.2.5. Hyperlinks
= Acceszsing Help ;I

o el e U B T Ifuch ke a web browser, the zer's Guide
= The User's Guide Readsr Eeader suppotts hyperlinks. The are displayed
" ':_hanlg'”g the Reader LF'“‘? usthg blue type. Click ona link to follow it
Wiewing Dbzcured Topicz i
Switching The K.eyboard Fr
Hiding the Table of Conten
Hyperlinkz
Frinting & Topic
Frinting The Entire User's ¢
Frirt Previewing a Topic ® DPressing Backspace
Dizplay the Page Setup Di:
Exporting a Topic az HTML s Pressing Alt ++<—
2 [lozing the Uzer's Guide B
Dizplaying Relevant Topics  —
Uzing ""what's Thiz?"' Help Mc

Dizplaying “ersion Histary -
Dizplaying the About Bax w2 ® Pressing the forward button -

] | b _ -
- . _L?:

Browse back to previously visited topics by

s Pressing the back button &

o a o o o o o o o

After browsing baclk, browse forward by

L= R« R |

The left side of the Reader displays the table of contents. One topic is always highlighted. It is
referred to as the selected topic. To select a topic, click on it. Click on a plus symbol 5 in the
table of contents to display subtopics.

= Accessing Help = Acceszzing Help
= [Digplaying the Uzer'z Guide T able of Contents = [Digplaying the Uzer'z Guide Table of Contents
The Uzer's Guide Reader 'K The Uzer's Guide Reader
Digplaying Relevant Topics @ Changing the Reader Location and Size

@ lzing "wWhat's Thiz?" Help Mode @ Wiewing Obzcured Topics in the T able of Contents
@ Digplaying FPiew's Werzion Higtary @ Switching The Keyboard Focuz Between Panes
@ [Digplaying the About Box 2 Hiding the T able of Contents

Click on the ¢r symbol next to a topic... ..to dizplay itz subtopics

The right side of the Reader displays the selected topic using a document display control. See
Section B.13, Document Display Control, for more information.

22.2.1. Changing the Reader Location and Size
The User's Guide Reader window can be moved and resized as necessary. Drag its title bar to
move it. Drag one of its edges to resize it.

To change the relative sizes of the two panes in the Reader, use the mouse to drag the separator
between the two panes either left or right.
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previously wsited topics
by

h® Pressing the back
Hyperlirks button

® Pressing Backspace

22.2.2. Viewing Obscured Topics in the Table of Contents

If a topic in the table of contents is partially obscured, hold the mouse cursor over it. A tooltip
window will appear, showing you the rest of the topic.

o [Changing the Feade pate has the focus, the
® Viewinl_:l Obzcured Tc awwnrn leare wonl] gither
- |SW|t|:h|ng The K.eyboard Focuz Between Panes

« Hiding the Table of % TIVIZ e I remle of

= Hypeilinks contents, or scroll the

22.2.3. Switching The Keyboard Focus Between Panes

At any given time, either the left or the right pane of the User's Guide Reader has the keyboard
focus. Depending on which pane has the focus, the arrow keys will either navigate the table of
contents, or scroll the selected topic. To switch the keyboard focus between panes, press the Tab
key.

22.2.4. Hiding the Table of Contents

To temporarily hide the table of contents, press the Hide button
button E.

. To display it, press the Show

Press Ctrl + T to switch between showing and hiding the table of contents.

22.2.5. Hyperlinks

Much like a web browser, the User's Guide Reader supports hyperlinks. The are displayed using
blue type. Click on a link to follow it.

Browse back to previously visited topics by:
e Pressing the back button %

e Pressing Backspace
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e Pressing Ctrl + B
After browsing back, browse forward by:
e Pressing the forward button =
e Pressing Shift + Backspace
e Pressing Ctrl + Shift + B

If you follow a hyperlink to another section of the NMPlot User's Guide, the selected topic in the
table of contents will be updated. This means that you can always find the location in the User's
Guide of the topic you are reading.

22.2.6. Printing A Topic

To print a topic, select it, then either:
e Press the Print button &% on the User's Guide Reader toolbar

e Press Ctrl + P

22.2.7. Printing The Entire User's Guide

To print the entire NMPlot User's Guide, simply select the NMPlot User's Guide topic (i.e., the
first topic in the table of contents), and then print it as described in Section 22.2.6, Printing A
Topic.

When you print the entire NMPlot User's Guide, all front matter, including the cover page and
the table of contents, is printed. Blank pages are inserted as needed so that chapters always start
on the right page of two-page spreads.

22.2.8. Print Previewing a Topic

To print preview a topic, select it, then either:
e Press the Print Preview button [& on the User's Guide Reader toolbar
e Press Ctrl + W

See Chapter 16, Using Print Preview, for more information.
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22.2.9. Display the Page Setup Dialog Box
To display the Page Setup dialog box, either:

e Press the Page Setup button B on the User's Guide Reader toolbar

e Press Ctrl + Shift + P

The Page Setup dialog box lets you select a printer, set the paper orientation (portrait or
landscape), and set the page margins.

22.2.10. Exporting a Topic as HTML

To export a topic as HTML, select the topic, then press Ctrl + H. You will be prompted for the
name of the HTML file that the topic will be written to.

22.2.11. Closing the User's Guide Reader

To close the User's Guide Reader, you can:
e Press the Close button

e Press the Esc key

22.3. Displaying Relevant Topics

Context-sensitive help, meaning help that is relevant to your current activity, can be displayed in
NMPIlot by:

e Pressing the F1 key

e Selecting Relevant Topics from the Help menu
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—Contents Tab Relevant Topics Tab
Uszer's|Guide llil

& < | @ Close_|

1

I
Contents  Belevant Topics |

16.2. The User's
Accessing Help GUide Reader

Diocument Dizplay Control
Dialog Boxes

The User's Guide Feader

TTze the TTzer's ude Feader to
browse the User's Gude online.

Uzer's Guide
wRlE < |

Contents |

= Accessing Help :I :I

-~ LI e I I ™ i

—L izt of Relevant Topics

NMPIlot displays the User's Guide Reader, with a list of relevant topics listed in the left pane. The
topics are ordered, with the most relevant at the top of the list.

To display the table of contents, click on the Contents tab, or press Alt + C.

To display the list of relevant topics, click on the Relevant Topics tab, or press Alt + R.

22.4. Using "What's This?" Help Mode

NMPlot's "What's This?" help mode lets you click on an object in NMPIlot and have the relevant
section of the User's Guide displayed. To enter "What's This?" help mode, you can:

e Press Shift + F1
e Choose What's This? from the Help menu

e Press the "What's This?" button # on the title bar of a dialog box

NMPIlot enters "What's This?" help mode, and the mouse cursor changes to a question mark RQ
Click anywhere on the NMPlot application. The NMPlot User's Guide is displayed with a list of
topics relevant to the location where you clicked.
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If you accidentally enter "What's This?" help mode, cancel it by pressing the Esc key.

22.5. Displaying NMPIlot's Version History

To display the version history of NMPlot, choose Show Version History from the Help menu. The
version number and new feature summary of all NMPIlot versions is displayed.

22.6. Displaying the About Box

To display the NMPlot about box, choose About from the Help menu. The about box shows
important information about the NMPlot application, including:

e The version

e The build number

e The list of sponsors

e Developer contact information

If you need to know the version of NMPIot you are running, check the about box.
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Sponsors

e United State Air Force
Air Force Research Laboratory
Wright-Patterson Air Force Base, Ohio

e United State Army
Construction Engineering Research Laboratory (CERL)
Champaign, Illinois

e United States Department of Transportation
Federal Aviation Administration
Office of Environment and Energy, AEE-120
Washington, DC
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Details of Various
NMPlot Components

NMPIlot uses a number of specialized components. Some of these components (for example, the
coordinate system control) are specific to NMPlot, and are described in detail. Other components
(for example, the text edit control) are commonly used by Microsoft Windows applications.
Familiarity with these common components is assumed: only unique or non-obvious aspects are
described in this appendix.

B.1. Dialog Boxes

Most NMPlot dialog boxes can be moved and resized. NMPlot remembers the new position and
size, and uses them the next time that dialog box is displayed.

To move a dialog box to a new location, drag it by its title bar.

To resize a dialog box, drag one of its edges. The layout of the dialog box's contents will be
updated to fit the new size.

A Dialog Box ﬂil A Dialog Box ilil

Drag a dialog box"s edge... o resize it
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Press Tab and Shift + Tab to move the keyboard focus between controls in a dialog box.

B.2. Multiple Page Dialog Boxes

NMPIlot makes extensive use of Multiple Page Dialog Boxes. These dialog boxes have one or
more pages of options that can be displayed.

Sample Options ilil
DOption Categaories: Mame Optionz
@ :
= Description Mame of Object:
ar  Physical Properties I.-i'-. Sample Mame
] Cancel | IJnhdo Page |
&

The left portion of a Multiple Page dialog box displays a list of option categories (in the example
above, these are Name, Description, and Physical Properties). One category in this list is always
selected (in the example above, Name is selected). Click on a category to select it.

The right portion of the dialog box displays controls that allow you to change the options in the
selected category (in the example above, this is the Name of Object text edit box).

For organizational purposes, options are arranged in a hierarchy. If an option category has a plus
sign T next to it, this means that it has one or more subpages. To display the subpages, click on
the plus sign.
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A Sample Mame

Click on the Undo Page button to discard all changes you have made to the controls on the
selected page. All controls are set to the values they had when you opened the dialog box.

Click on the Cancel button to discard all changes you have made since opening the dialog box,
regardless of the page.

B.3. Error Messages

If an error message must be displayed, NMPlot will highlight the relevant portion of the user
interface by tinting it red.

2| x|

—
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B.4. Text Control

A Text Control allows you to enter text.

ISl:ume ket

It is assumed that you are familiar with using a text control. Therefore, only the functions of
certain keys are listed.

Key Action
Shift + Arrow Key Move the caret while selecting text
Ctrl + « Move one word to left
Ctrl + — Move one word to right
Ctrl+C Copy selected text to the clipboard
Ctrl + X Cut selected text
Ctrl +V Paste text from clipboard
Ctrl + A Select all text

B.5. Symbolic Fields Text Control

A Symbolic Field Text Control allows you to enter text that contains symbolic fields:
placeholders for information that is automatically inserted when the text is displayed. For
example, in the text "You are using {AppName} version {AppVersion}", {AppName} and
{AppVersion} are fields representing, respectively, the name and version of the application you
are using. The text would be displayed as "You are using NMPlot version 4.958".

A Symbolic Fields Text Control is a text control with a button located to its right.

I The curent time is {CurrentTime). r{H}I

Edit the text as you would using a regular text control. To insert a symbolic field at the caret
location, either press Alt + Space Bar, or press the Insert Symbolic Field button ﬁl The Select
Symbolic Field To Insert dialog box is displayed.
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Select symbolic field to inzert llil

Current date :I
EF Current time

Hours:mintes, 12 hour clock farmat [10:02 PR]
Hours:mintes, 24 hour clock format [22:02]

Hourz:minutes: seconds, 12 howr clock format [10:02: 45 Ph]
Hourz:minutes: seconds, 24 hour clock format [22:02; 45]

Application name
Application verzion

Select the symbol to insert, then press the OK button.

Note that the list of symbols is hierarchical. Click on one of the small + signs to display
subsymbols. Often, these subsymbols are alternative ways of formatting the parent symbol. For
example, in the screen capture of the Select Symbolic Field To Insert dialog box above, symbols
for several ways of formatting the current time are shown.

B.6. Drop-down List Control

A Drop-down List Control allows you to select a single item from a list of choices.

I-.lu|_',' "’I

It is assumed that you are familiar with using a drop-down list control. Therefore, only the
functions of certain keys are listed.

Key Action
Letter key A Cycle through the choices beginning with that letter. For example, if you
through z are using a drop-down list control that presents a choice of month names,
pressing A will alternate the selected month between April and August.
Space Bar Display the drop-down list
Alt+ 4 Display the drop-down list
l Select the next choice in the list
T Select the previous choice in the list
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B.7. Spreadsheet Control

A Spreadsheet Control is used to enter a two-dimensional table of information.

M arme Shiotw Colar d
Lake Michigan v . Elue -
Mizsizzippi Fiver I~ | Dark Blue -
Grand Canyon I~ |[]Light Brawn =
b ount B airier R[] white -
Smokey Mountains 3 . Dark Green j :I

M o

.-i‘-.l:h:IFtil Fieml:uvth:uwl aneHl:qulpl aneHnwDuwnl

A spreadsheet control works much like a commercial spreadsheet, such as Microsoft Excel. A
two-dimensional table of cells is presented. One cell is always selected. This is indicated by a
dark outline. In the example above, the Mississippi River cell is selected. The selected cell is the
one that you are currently editing. The selected row is the row containing the selected cell.

To select another cell, click on it. Alternatively, use the following navigation keys.

Key

Action

Arrow Key
Ctrl + Arrow Key
Enter
Shift + Enter
Tab
Shift + Tab

Page Up
Page Down
Ctrl + Page Up

Ctrl + Page
Down

Home

End

Move one cell in the indicated direction

Move one page in the indicated direction

Move one cell down

Move one cell up

Move right one cell, or to start of next row if at end of current row

Move left one cell, or to end of previous row if at beginning of
current row

Move up current column one page
Move down current column one page
Move to top of current column

Move to bottom of current column

Move to first column in current row

Move to last column in current row
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Most spreadsheet controls have Add and Remove buttons. The Add button adds a new row,
located just below the selected row. The Remove button removes the selected row.

Some spreadsheet controls have Move Row Up and Move Row Down buttons that move the
selected row up or down in the table. Use these buttons to change the relative ordering of rows.

In most spreadsheet controls, you can change a column's width by dragging the separator

between column headers.

Riner

_I_I?I.

B.8. File Name Control

A File Name Control is used to enter the name of a file.

| AT empiMyFile. it

You can type the name of the file in the box provided.

To browse for the file, either press Alt + Space Bar, or press the Browse button J, located to the
right of the text box. The standard Microsoft Windows Open File dialog box is displayed.

Select a File Hame

2l

oy [ 3w 3 &l o B
|l aim35 __IHelp LI mgdownld. trmp
|__IConfig __IHiztory __IFi
|| Cookies __Inf LI Profiles
| I Cursors L ldava | IProfiles.bak,
|__IFonts __Ikeda ___lrepair
| IForms __Imzagent L_IShellt ey
K i
File narne: IM_I,IFiIe.t:-:t Dpen I

Files of type: |l files

j Cancel |
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The exact appearance of the Open File dialog box will vary, depending on the version of
Microsoft Windows that you are using. Familiarity with this dialog box is assumed. See your
Microsoft Windows documentation for additional information.

B.9. Font Control

A Font Control is used to select a typeface font.

|12 pt Times Mew Raoman _I

The current font is displayed in the box. To change it, either press the Space Bar, or press the
Select Font button J The standard Microsoft Windows Font dialog box is displayed.

Font 2| x|
Eont; Faont style:
ITimes Mew RBoman IHeguIar Qk. I
Times New Boman C |
T Times New Boman M [talic ElEE |
T Tribute to Mova Bold
B Wenus Rising Bold Italic
H erdana
T Vibrocentic ]
T ipnagorgialla ;I
—Sample
LaBhYyis
Script:

IWestern ;I

The exact appearance of the Font dialog box will vary, depending on the version of Microsoft
Windows that you are using. Familiarity with this dialog box is assumed. See your Microsoft
Windows documentation for additional information.

B.10. Color Control

A Color Control is used to select a color.
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I- Elue j

A sample of the current color is displayed in the box, followed by a name for that color. If the
color is one of the standard ones recognized by NMPlot, its common name is displayed.
Otherwise, the relative intensities of red, green, and blue are displayed, as in "RGB 10, 100,
255". The RGB values can range from 0 to 255.

Press a letter key, A through Z, to cycle through all colors with names beginning with that letter.

Press Alt + ., the Space Bar, or the drop-down button j to display a drop-down list of named
colors.

Il Bl El

. Current color [Blue] §8
. Cugtorn color

B Gk -
[[] white

|:| Cream

|:| Light Gray

. Giray

Select Custom Color to display the standard Microsoft Windows Color dialog box, which will
allow you to pick from all possible colors.

Color 2 x|

u i‘
Huefes | Red[11
Sat: Iﬁ Green: Iﬁ

[efite Euston Ealons = | Colarl5 glid Lurn; IEEI Blue: IEEI

k. I Cancel | Add to Cuztom Colars |

AF NEEE |
AR "THETIEN
AR EEEET
BN [HEEN]
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The exact appearance of the Color dialog box will vary, depending on the version of Microsoft
Windows that you are using. Familiarity with this dialog box is assumed. See your Microsoft
Windows documentation for additional information.

B.11. Line Pattern Control

A Line Pattern Control is used to select a line dash pattern (solid, dashed, dotted, etc.).
— =

The sample of the current line pattern is displayed in the box. To change the pattern, either press

the Space Bar, or press the Select Pattern button J The Select Line Pattern dialog box is
displayed.

Select Line Pattern 2| x|

Solid

Dazhed

Long Dazhed
Dotted
Dot-Dazh

R ailroad

G N i i e e

Cuigkarm

[V First zegment iz vizible

Seament lengthz [mm] : | 2.1.4.2

Example of line pattern : I —_——-—

ok Cancel |
2

The box at the bottom of the dialog box displays a sample of the current line pattern. You can
choose one of the predefined patterns, such as Solid or Dashed. Alternatively, you can select
Custom, and define your own line pattern.

To define a line pattern, type a list of numbers, separated by commas, in the box labeled Segment
lengths. These numbers are the lengths, in millimeters, of alternating line segments and gaps in
the line pattern. If the First segment is visible box is checked, the first number represents the
length of a line segment. Otherwise, the first number represents the length of a gap.
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B.12. Symbol Control

A Symbol Control is used to select a graphical symbol.

The current symbol is displayed in the box. To change it, either press the Space Bar, or press the
Select Symbol button J The Select Symbol dialog box is displayed.

Select Symbol 1'5'

& Select from librany of standard symbols

™ Select a character from a symbal font

12 pt Symbol _I

2~ Large Triangle il
T b edivirm Arrow
+  Medium Cross J

#  Medium Diagonal Crozs

o M edium Diamond

oK LCancel |

A

You can select from a library of standard symbols that are included with NMPlot. Alternatively,
you can select a character from a symbol font.

g Tip:

Symbol fonts are available from a variety of third-party sources. Some (for example,
"Symbol") are distributed with Microsoft Windows. Some are available for purchase. Still
others may be freely downloaded from the World Wide Web.
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B.13. Document Display Control

A document display control displays formatted text.

Document Display Control j

& document display contrel 1z used to
display formatted text. If vou resize i,
lines will wordwrap to the new width,
Tou can scroll the text, print and print-
preview it, and export it to HTL.

Document display controls can
display vanous typeface sethings
such as hold, i#afic, and underhine. =

The following keys have special functions when using a document display control.

Key Action
T Scroll up one line
d Scroll down one line
Page Up Scroll up one page
Page Down Scroll down one page
Home Go to the top of the document
End Go to the bottom of the document
Ctrl + P Print the document
Ctrl + W Print preview the document
Ctrl +H Save the document as HTML

If your mouse has a middle mouse button, you can use it to scroll the document. Press and hold
the middle button, then move the mouse up or down.

If your mouse has a wheel button, you can scroll the document by turning the wheel.

B.14. Datum Control

A Datum Control is used to select a geographic datum.
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|wiGs 24 ]

The current datum is displayed in the box. To change it, either press the Space Bar, or press the

Select Datum button J The Select Datum dialog box is displayed.

Select Datum ﬂﬂ
WORLD-WIDE DATUMS :‘
WES 84

NORTH AMERICAN DATLUMS

Cape Canaveral - Flarida, Bahamasz

Haorth Arnerican 1327 - Alaska [excluding Aleutian |slands)

Maorth Amenican 1327 - Alberta, Britizh Colurnbia

Marth Amencan 1327 - Aleutian |slands [east of 1807

Marth &mencan 1327 - Aleutian lslands [west of 1807/

Marth &mencan 1327 - Bahamas [excluding San S alvador |zland] ﬂ

Inforrmation about Selected Daturm

Mame : Maorth American 1927
Region : Alaska (excluding Aleutian Islands)
Continent : Naorth America
Ellipsaid : Clarke 1866
WES-84 Cornversion Method : Molodensky: DX =-5m, DY =135 m, DZ= 172 m
WiES-84 Conversion Error: 11 m

ok Cancel

The list at the top of the dialog box displays all available datums, grouped by continent or ocean
(North America, Pacific Ocean, etc.). Within these groups, datums are listed alphabetically.

Below the list, the following information about the selected datum is presented:
e The datum's name
e The applicable geographic region for this datum
e The continent or ocean that contains the datum's applicable region

e The datum's reference ellipsoid
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e The method used to convert between this datum and the WGS-84 datum (for the
3-parameter Molodensky transformation, the three transformation parameters DX, DY, and
DZ are displayed)

e An estimate of the worst-case error when converting from this datum to WGS-84

See Appendix H, Introduction to Datums, for general information on datums. See Section 21.2,
Default Datum, for information about the default datum.

g Tip:

Some datums are listed several times, each associated with a different area or region. For
example, the "North American 1927" datum is listed 20 times: "North American 1927 -
Alaska (excluding Aleutian Islands)", "North American 1927 - Alberta, British Columbia",
etc. Generally, you should pick the one with the smallest associated region that completely
encloses your area of interest. For example, if you are working with North American 1927
map data for the state of New York, you should select "North American 1927 - Contiguous
United States east of Mississippi River" instead of "North American 1927 - Contiguous
United States."

8 Tip:

Datums are often abbreviated using their initials and two-digit year. For example, the North
American 1927 datum is commonly abbreviated as NAD-27.
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Appendix

A Sample Grid C
Summary Report

When a grid is opened, NMPlot displays a Grid Document window. Among other information,
this window displays a report summarizing the contents of the grid. This appendix contains a
sample grid summary report.

Summary of Grid "Sample Grid - Airport Noise.grd"

Description of Grid
Noise at Holloman Air Force Base

Noise at Holloman Air Force Base, New Mexico, as calculated by NOISEMAP 6.0, the
United State's Air Force's Airport Noise Model.

Metric

This grid contains Noise data in units of dB DNL.

Coordinate System

Coordinate system used to specify geographic locations in this grid:
User-defined XY coordinate system
Reference point in longitude and latitude: 106.107224° west, 32.8663902° north
Reference point in local (X-Y) coordinates: 99992, 200000 feet
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Point of Contact

Point of contact for this grid:
Fred Wasmer
Wasmer Consulting
e-mail wasmer@wasmerconsulting.com

Time and Date

This grid was created at 11:35 AM on Thursday, February 23 1989.

Program

This grid was created by NOISEMAP version 6.

Other Attributes

The following attributes are associated with this grid:
Temperature (F) = 69
Humidity (%) = 28
Magnetic Declination (degrees east) = 10.69

Valid Grid Data Point Value Limits

All grid data points with values less than -40 or greater than 9.9E9 are ignored. They are
treated as missing data.

Grid Point Statistics
There are 9296 valid data points in this grid.
The data points range in value from 34.4 to 102.1 dB DNL.
Geographic limits of the data point locations:
x: 50,000, y: 150,000

to
x: 149,000, y: 249,000

Geographic Features
This grid contains the following geographic features.

Point Features
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8 features of category Navigational Aid
16GS
22GS
BWS5
HMN
[HMN
IMUK
P.R.
S.R.

4 features of category Point of Interest
65A
67A
HUD
SP1

16 features of category Static Pad
807B
A638
B638
CRA
CRB
CRC
CRD
CRE
ERA
ERB
ERC
ERD
ERE
ERF
R11
TC

Line Features

4 features of category Runway
16
22
25
34

19 features of category Flight Track
16A1
16A2
16C1
16C2
16C3
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16D1
16D2
22D1
22D2
25D1
25D2
25D3
25DT
34A1
34A2
34Cl1
34C2
34C3
34D1
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List of NMPIlot Files

D.1. List of Files Shipped With NMPIot

The following files are distributed as part of the NMPIlot installation package.

NMPIlot.exe - The NMPlot application.

NMPlot_VersionHistory.txt - A text file containing a record of the released versions of
NMPIot.

Sample Grid - Airport Noise.grd - A sample grid of aircraft noise levels, expressed in
decibels (dB), around Holloman Air Force Base, New Mexico. This grid is displayed by all
of the sample plots.

Sample Grid - Airport Noise plus 3 dB.grd - A grid created by using NMPlot's grid
modification capability to add 3 dB to all data points in the grid Sample Grid -
Airport Noise.grd. This file is used to demonstrate the overlaying of two sets of
contours.

Sample Plot - Contours.nmp - A sample plot that demonstrates the contouring capability
of NMPlot. The plot is of 60 through 80 dB noise level contours.

Sample Plot - Annotations.nmp - A sample plot demonstrating NMPlot's ability to draw
geographic annotations. Flight tracks (the paths that airplanes follow as they fly patterns
near Holloman Air Force Base), navigational aids, and points of interest are shown. 60, 70,
and 80 dB noise level contours are also displayed, demonstrating NMPlot's ability to draw
contours filled with solid colors.

Sample Plot - Color Gradient.nmp - A sample plot demonstrating the color gradient
capability of NMPlot. The grid Sample Grid - Airport Noise.grd is plotted
with smoothly varying colors indicating noise levels. The 65 dB contour is also drawn.
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e Sample Plot - Contour Overlay.nmp - A sample plot demonstrating NMPlot's ability to
overlay contours from two or more grids. This plot is of the 65 and 80 dB contours from
two grids: Sample Grid - Airport Noise.grdand Sample Grid -
Airport Noise plus 3 dB.grd.

e Sample Plot - Map Overlay.nmp - A sample plot that demonstrates NMPlot's ability to
display plots over background maps. 60, 70, and 80 dB noise level contours are displayed
over a map of Holloman Air Force Base, New Mexico.

e *nmplot_legend - Legends that you can select from when printing plots. See Section 15.4,
Legends, for more information.

e Default.MapFormattingScheme - Controls the colors, line styles, etc. used to display
Digital Line Graph (DLG) maps. See Section 14.2.1, Map Formatting Schemes.

e SampleMapData\*.dlg - The SampleMapData subdirectory contains map data for
Holloman Air Force Base. It is used by the sample plot Sample Plot - Map
Overlay.nmp. The data consists of 1:100,000 Digital Line Graph (DLG) files
downloaded from the United States Geological Survey (USGS) web site.

e Documentation\*.* - The Documentation subdirectory contains the NMPlot User's
Guide, stored in XML format.

D.2. Files Created by NMPlot

The following files are not included in the NMPlot distribution package, but may appear after
running NMPlot.

e NMPIot.cfg - Contains application-wide NMPlot configuration information. An example of
the type of information stored in this file is the last size and location of many dialog boxes.
If this file is deleted, all options will return to their default values.

e NMPlot.log - Log of debugging, error and warning messages from the last time NMPlot
was run.

e NMPIlot Fatal Error Report.txt - A report containing debugging information for the last
fatal error experienced by NMPlot. This file may contain information allowing the cause of
the error to be determined.
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Appendix

Command-Line E
Options

The name of one or more grid or plot files may be specified on the NMPlot command line. These
files will be opened when NMPIlot runs. This allows you to associate the extensions .nmp and
.grd with the NMPIlot application, and invoke NMPlot by double-clicking on a plot or grid file
from Microsoft Windows Explorer.

Enclose file names containing spaces with double-quotes, as in...

C:\>nmplot "Sample Grid - Airport Noise.grd"

NMPIlot recognizes the following command-line options.

E.1. Display Help

E.1.1. Synopsis
-Help

E.1.2. Description
Displays the NMPlot User's Guide.

E.1.3. Example
C:\>nmplot -help
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E.2. Display a Plot of a Specific Grid

E.2.1. Synopsis

-LoadPlotSetGrid plotfilename gridfilename

E.2.2. Description

Loads the plot file plotfilename, sets the plot's primary grid to gridfilename, saves the
modified plot, and then displays the plot. Note that this operation modifies the existing plot file

plotfilename.

E.2.3. Example
C:\>nmplot -loadplotsetgrid myplot.nmp mygrid.grd

E.2.4. Comments

This command-line option is for third-party applications that use NMPlot to display graphical
output. As an example, consider how a hypothetical numerical model called X might use
NMPlot.

X's developers create a plot file named X . nmp that is distributed with X. This plot's options are
set appropriately for displaying grid files created by X.

When a user running X requests a contour plot, X performs the following actions.

1. X creates a grid file named UserCase.grd, where UserCase is the name of the user's
current scenario in X.

2. X copies X.nmp to UserCase.nmp.

3. X runs NMPlot using the command line:

nmplot -loadplotsetgrid "UserCase.nmp" "UserCase.grd"

4. NMPIlot displays the plot. The user can use the full power of NMPlot to explore X's
predictions.

5. The user can access the plot later by simply double-clicking on UserCase . nmp. X no
longer needs to be running.
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E.3. Export a Plot in ARC/INFO Shapefile
(SHP) Format

E.3.1. Synopsis

-se gridfilename [coordsys plotfilename shapefilename]

E.3.2. Description

Exports a plot in ARC/INFO Shapefile (SHP) format. NMPIlot reads the plot from file
plotfilename, temporarily sets the plot's primary grid to gridfilename, and exports the plot to
a Geographic Information System (GIS) in ARC/INFO Shapefile (SHP) format.

coordsys controls the coordinate system of the Shapefile(s) that are created. If it equals
"default", then the primary grid's default coordinate system will be used. Otherwise, coordsys
must be the name of an NMPlot coordinate system file. To create a coordinate system file, 1)
start NMPlot, 2) choose Export to GIS from the File menu, 3) press the Properties button, 4) choose

Export in the Following Coordinate System, 5) press the Browse button J to display the Select
Coordinate System dialog box, 6) select the desired coordinate system, including the datum, and
7) press the Save To File button, then type the desired file name.

plotfilename is used to specify the plot options: the contour levels, whether geographic
annotations are exported, etc. This file is not modified.

shapefilename is a model file name that controls the name(s) of the Shapefile(s) created. This
model file name works exactly like the Output Filenames section of NMPlot's Export to GIS
dialog box. See Section 17.1, Export to GIS Dialog Box, for more information.

The last three parameters — coordsys, plotfilename, and shapefilename — are optional. If
they do not appear, then their values are constructed by taking gridfilename and changing the
file extension to . coordsys, .nmp, and . shp, respectively.

E.3.3. Examples
C:\>nmplot -se mygrid.grd mycoordsys.coordsys myplot.nmp myoutput.shp

C:\>nmplot -se mygrid.grd default myplot.nmp myoutput.shp

C:\>nmplot -se mygrid.grd
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E.3.4. Comments

This command line is intended to be used as part of a batch operation. NMPlot will exit after
creating the Shapefile(s).

E.4. Export a Plot in DXF Format

E.4.1. Synopsis

-ExportToDXF gridfilename plotfilename dxffilename coordsys

E.4.2. Description

Exports a plot in AutoCAD Data Exchange Format (DXF) format. NMPIot reads the plot from
file plotfilename, temporarily sets the plot's primary grid to gridfilename, and exports the
plot to a Geographic Information System (GIS) in DXF format.

plotfilename is used to specify the plot options: the contour levels, whether geographic
annotations are exported, etc. This file is not modified.

dxffilename is the name of the DXF file that will be created.

coordsys controls the coordinate system used for locations in the DXF file. It must be either
"Default" for the primary grid's default coordinate system, or "LongLat" for decimal degrees of
east longitude and north latitude.

E.4.3. Example

C:\>nmplot -ExportToDXF mygrid.grd myplot.nmp myoutput.dxf LongLat

E.4.4. Comments

This command line is intended to be used as part of a batch operation. NMPlot will exit after
creating the DXF file.
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E.5. Interpolate Grid Data Levels at a List of
User-Supplied Points

E.5.1. Synopsis

-pi gridfilename [coordsys pointsfilename resultsfilename]

E.5.2. Description

NMPIlot reads the grid from file gridfilename, reads the file pointsfilename (a text file
containing a list of point coordinates specified using the coordinate system denoted by the
coordsys parameter), determines the grid data level at each point by interpolating into the grid,
and then writes the interpolated grid data levels to the text file resultsfilename.

coordsys controls the coordinate system used to specify locations in the points file. If it equals
"default", then the primary grid's default coordinate system will be used. Otherwise, coordsys
must be the name of an NMPlot coordinate system file. To create a coordinate system file, 1)
start NMPlot, 2) choose Export to GIS from the File menu, 3) press the Properties button, 4) choose

Export in the Following Coordinate System, 5) press the Browse button J to display the Select
Coordinate System dialog box, 6) select the desired coordinate system, including the datum, and
7) press the Save To File button, then type the desired file name.

pointsfilename is a simple text file. Its lines specify the points, one per line. Each line consists
of three fields, separated by either commas or tab characters. The three fields contain:

1. A descriptive alphanumeric name for each point
2. The X coordinate of each point
3. The Y coordinate of each point

The meaning of the X and Y coordinates will depend on the coordinate system of the points. For
example, if the coordinate system is longitude and latitude, X is the longitude and Y is the
latitude.

Here is an example points file.

Baker High School, -95.2343, 32.4857
Jackson Junior High School, -95.2938, 32.4492
St. Mary's Hospital, -95.3037, 32.5088

resultsfilename is a simple text file. Its lines specify the interpolated grid data levels for each
point, one per line, in the same order as the points appear in the points file. Each line consists of
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two fields, separated by either commas or tab characters (depending on the character used to
separate columns in the points file). The two fields contain:

1. The descriptive alphanumeric name of each point

2. The interpolated grid data level for each point, or -9999 if the point is located outside of the
grid's defined area polygon

Here is an example results file.

Baker High School, 65.4
Jackson Junior High School, 62.3
St. Mary's Hospital, 53.8

The last three parameters — coordsys, pointsfilename, and resultsfilename — are
optional. If they do not appear, then their values are constructed by taking gridfilename and
changing the file extension to . coordsys, .pts, and . out, respectively.

E.5.3. Examples

C:\>nmplot -pi mygrid.grd mycoordsys.coordsys mypoints.pts results.out
C:\>nmplot -pi mygrid.grd default mypoints.pts results.out

C:\>nmplot -pi mygrid.grd

E.5.4. Commments

This command line is intended to be used as part of a batch operation. NMPlot will exit after
creating the results file.
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Introduction to the
Noise Model Grid
Format

The Noise Model Grid Format (NMGF) is a well-documented standard way of representing a
grid and its auxiliary information.

Internally, NMPIlot processes all grids using NMGF, as shown in the Details pane of the Grid
Document window.

The NMGF standard includes a format for storing grids in files. Many third-party applications
communicate with NMPlot using NMGF grid files. Writing a NMGF file is the easiest ways to
import third-party data into NMPlot. For a quick-start guide to creating NMGF files for this
purpose, see Appendix G, Quick-Start Guide to Importing Data into NMPlot.

F.1. Full Documentation for NMGF

This appendix provides an overview of the NMGF standard. Complete documentation is
available from the NMGF web page, http://www.wasmerconsulting.com/nmgf.htm.

F.2. Why Was NMGF Developed?

There are a number of computer models in use that calculate the noise impacts of installations,
such as airports and railroads, upon the surrounding community. Examples of such models
include the United States Air Force's (USAF) NOISEMAP and the United States Federal
Aviation Administration's (US FAA) Integrated Noise Model (INM).
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In the early 1990's, each model defined its own output file format. This resulted in duplicate
effort developing post-processing utilities that performed essentially the same tasks. For
example, both the USAF and the US FAA independently developed contour plotting utilities for
use with their respective noise models.

To promote the development of shared post-processing utilities, the USAF and the US FAA
sponsored the development of a standard grid file format that met the needs of both models. This
format is known as the Noise Model Grid Format (NMGF). Version 1.0 of this format was
released in September 1993.

F.3. NMGF: Not Just For Environmental Noise
Models

While NMGF was originally developed to support noise models, it is neutral to any particular
application domain. A NMGF grid can just as easily contain data from other types of models (for
example, air pollution models) or from sources other than computer models (for example,
measured data).

F.4. NMGF Sections

Data is stored in the NMGF format as a list of sections. There are more than 30 types of sections,
each with a specific purpose. For example, a CART section defines a coordinate system used to
specify geographic locations in a grid.

Section types are defined that specify data points (both on rectangular grids and as lists of
location-value pairs), information about data points (the physical units, the range of valid data
point values, etc.), geographic annotations (for example, the locations of roads and buildings),
and bookkeeping information (where the data came from, who created the data, etc.).

F.5. Child Sections

The NMGF data structure is hierarchical. That is, sections can have subsections, called child
sections. A child section specifies an attributes of its parent section.

As an example, consider the ZCRD section, which specifies an altitude or height. A ZCRD
section by itself is meaningless: you do not know what the altitude refers to. The ZCRD section
is always used as a child of the section it refers to.
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Consider the PNTS section, which specifies information about a point geographic feature (for
example, the location of a house). This section has several required parameters, such as the
geographic coordinates of the point. The altitude of the point is not a required parameter.
However, the ZCRD section can optionally appear as a child of the PNTS section to specify the
altitude of the point.

F.6. Types of NMGF Sections

F.6.1. Geographic Coordinate System Specification

This NMGF section defines a geographic coordinate system used to specify locations in the grid.
If a grid does not contain a CART or UTMC section, longitude and latitude are assumed.

e CART - Define a local flat-Earth Cartesian coordinate system for specifying geographic
coordinates

e UTMC - Define a Universal Transverse Mecator (UTM) coordinate system for specifying
geographic coordinates

F.6.2. Data Point Specification

These NMGF sections specify information about the data points in a grid.

e DAPY - Specify the grid's defined area polygon: i.e., the geographic area where data is
known. See Section 4.2.5, Defined Area Polygon.

e DPAL - Specify a group of data points as a list of location-value pairs.
e GRID - Specify a group of data point arranged on a regular rectangular grid
e GTSH - Specify the range of data point values that is considered valid

e MTRC - Specify what is being measured by the data points, and what units of measurement
are used

e SUBG - Specify a nested subgrid: i.e., a set of data points that doubles the resolution of a
portion of a grid
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F.6.3. Geographic Annotations
These NMGF sections specify map data stored in a grid.

e AREM - Define a geographic feature consisting of one or more closed polygons
e ARES - Define a geographic feature consisting of a single closed polygon
e BKMP - Define information about a background map that is stored in an external file

e LINC - Define a geographic feature consisting of a series of (possibly non-contiguous) lines
and arcs, described by a series of commands that move a hypothetical cursor

e LINM - Define a geographic feature consisting of one or more continuous lines
e LINS - Define a geographic feature consisting of a single continuous line
e PNTM - Define a geographic feature consisting of one or more points

e PNTS - Define a geographic feature consisting of a single point

F.6.4. Audit Trail

This NMGF section is used to record the creation and modification history of a grid.

e SORC - Specify audit trail information about a grid: how, why, when, where, and by whom
it was created

F.6.5. Predefined Optional Attributes

These NMGF sections allow predefined optional attributes to be specified. They are used only as
child sections.

e DATE - Specify a date

DESL - Specify a detailed multiple-line description of an object

DESS - Specify the proper name or a short one-line description of an object

HEAD - Specify the direction (i.e., the heading) of an object

PERS - Specify information about a person: name, telephone number, etc.

PROG - Specify the name and version of a computer program
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e TIME - Specify a time
e WARN - Specify a problem or limitation of the data in a NMGF grid

e ZCRD - Specify the height or altitude of an object

F.6.6. Arbitrary Optional Attributes

These NMGF sections allow grids to store information that was not anticipated by the designers
of the NMGF format: arbitrary attributes can be specified as name-value pairs. These sections are
used only as child sections.

e ATRC - Specify a coordinate as an arbitrary attribute of a NMGF section

ATREF - Specify a floating point number as an arbitrary attribute of a NMGF section

ATRI - Specify an integer as an arbitrary attribute of a NMGF section

ATRS - Specify text as an arbitrary attribute of a NMGF section

ATRT - Specify a table of information as an attribute of a NMGF section

F.6.7. File Control
These NMGF sections control the processing of a NMGF grid when it is stored in a file.

e ENDF - Mark the end of a NMGF grid file

e TITL - Mark the beginning of a NMGF grid file, and specify the NMGF version number

F.7. Simple Rectangular Grid Optimization

If a grid meets the following conditions, NMPIlot can use alternative interpolation and contouring
algorithms that are faster and use less memory.

e The grid contains a single GRID section, and does not contain any DPAL or SUBG
sections.

e The grid either a) does not contain a GTSH section, or b) does not contain any invalid data
points (i.e., data points whose values are outside the valid range specified by the GTSH
section).
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For large grids, the time and memory savings can be substantial. Therefore, if your data points
are arranged on a regular, rectangular lattice of locations, they should be specified using a GRID
section instead of a DPAL section.
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Quick-Start Guide to
Importing Data into
NMPlot

NMPIlot is a powerful application for working with grid data sets. If you would like to use
NMPIlot to work with your data, you must first put it into a format that NMPlot can import. This
appendix is a quick-start guide to doing so with a minimum of effort.

The easiest way to import your data is to create a text-based NMGF grid file. The NMGF format,
while powerful and well-documented, can be somewhat intimidating when all you want to do is
create a simple grid file. Therefore, this appendix describes the bare minimum necessary to do
SO.

@ Note:

If you are using NMPIot as part of a third-party application (BNOISE2, INM, NOISEMAP,
ROUTEMAP, SARNAM, SIPS, or TNM), you can skip this section, as these applications
write files that NMPlot can read directly.

G.1. What is the bare minimum I have to do
to create an NMGF file?

Create a text file with the following text, replacing the sample data points with your own.

{TITL Grid vers 2 3}

{DPAL 5
(-90.02, 45.00) 50.0
(-90.02, 45.02) 50.0
(-90.00, 45.02) 50.0
(-90.00, 45.00) 50.0
(-90.01, 45.01) 60.0
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{ENDF}

The first and last lines, beginning with {TITL and {ENDF, denote the beginning and end of the
data set. They must appear exactly as shown.

The middle seven lines specify the actual data. The line...

{DPAL 5

...specifies that 5 Data Points with Arbitrary Locations (DPAL) follow. Each data point is
specified by a location (the numbers in parentheses) and a data value at that location (the
numbers after the parentheses). The locations are specified in decimal degrees of east longitude
and north latitude. West longitudes are negative, so the point (-90.02, 45.00) is at longitude 90.02
degrees west, latitude 45.00 degrees north.

G.2. Do I Have To Use Longitude and Latitude
to Specify My Data Point Locations?

No, you can use Cartesian coordinates to specify locations. Add the following line just after the
line that begins with {TITL.

{CART -90.0 45.0 0 0 METR 0}

This specifies that all locations will be given in meters east and north from longitude 90.0 west,
latitude 45.0 north. If you want to use feet, replace METR with FEET.

Here is the modified example file.

{TITL Grid Vvers 2 3}
{CART -90.0 45.0 0 0 METR 0}

{DPAL 5
( o, 0) 50.0
( 0, 100) 50.0
(100, 100) 50.0
(100, 0) 50.0
( 50, 50) 60.0

}

{ENDF}
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G.3. How Do I Specify The Physical Units of
the Data Points?

Add the following line just before your data points.

{MTRC "Air Temperature" "F"}

The first quoted text string describes what is being measured. The second specifies the physical
units.

Here is the modified example file.

{TITL Grid Vers 2 3}
{CART -90.0 45.0 0 0 METR 0}
{MTRC "Measured air temperature" "F"}
{DPAL 5
( o, 0) 50.0
( 0, 100) 50.0
(100, 100) 50.0
(100, 0) 50.0
( 50, 50) 60.0
{ENDF}

G.4. Can I Add More Detailed Notes About My
Data?

Yes. Add the following lines just after the line that begins with {TITL.

{SORC "Measured"
{DESS "Measured air temperature at 1 meter above ground level"}
{DESL "Measurements made using a ACME model X34 thermocouple"}

}

The quoted text after SORC specifies the broad category of the data's origin. It can be any text,
but it is suggested that "Measured" be used for measured data, and "Model" be used for the
output of numerical models.

The quoted text after DESS is a short description of the data in the file. If possible, it should be
kept under 60 characters in length. This text should be appropriate for use as, say, the title of a
contour plot of the data.

The quoted text after DESL is a long, detailed description of the data in the file and any notes
you wish to add. It can be as long as necessary, and can contain line breaks.
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Here is the modified example file.

{TITL Grid Vers 2 3}

{SORC "Measured"
{DESS "Measured air temperature at 1 meter above ground level"}
{DESL "Measurements made using a ACME model X34 thermocouple"}

}

{CART -90.0 45.0 0 0 METR 0}

{MTRC "Measured air temperature" "F"}
{

DPAL 5
( o, 0) 50.0
( 0, 100) 50.0
(100, 100) 50.0
(100, 0) 50.0
( 50, ©50) 60.0

}

{ENDF}

G.5. Where Can I Get Additional Information?

The NMGF standard has many additional features that you can use to describe and annotate your
data. To learn more, visit the NMGF web page, http://wasmerconsulting.com/nmgf.htm.
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Introduction to
Datums

H.1. What is a Datum?

A datum is a detailed survey of a country, continent, or some other portion of the Earth's surface.
As part of the survey, the longitudes and latitudes of a large number of points are measured using
the best available methods. Once the survey is complete, maps of the region can be constructed.

Over time, the accuracy of surveying methods has steadily improved. Therefore, most regions of
the Earth of been surveyed many times, with increasingly accuracy. Each of these surveys is
referred to as a datum. With each new datum, the longitude and latitude of a given point on the
Earth will change. This change can be as large as several hundred meters.

H.2. Why are Datums Important?

Adopting a new datum is expensive. Maps must be reprinted. Data files must be converted.
Computer programs must be modified. Therefore, at any given time, more than one datum will
likely be in use for a given region.

For example, in the United States, both the North American Datum of 1927 (NAD-27) and the
World Geodetic System of 1984 (WGS-84) are in widespread use. In addition, maps and data in
numerous lesser-used datums are also available.

For this reason, longitude and latitude alone are insufficient to describe the location of a point
with an accuracy better than a few hundred meters. If greater accuracy is required, another piece
of information is needed: the datum.
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@ Note:

Even if you are certain that all of your data and maps are in a single, consistent datum, you
still may need to know what that datum is. For example, the datum is required in order to
convert from Universal Transverse Mercator (UTM) coordinates to longitude and latitude.
This is because the conversion depends on the ellipsoid (a mathematical model of the
Earth's shape), and the ellipsoid is part of the datum.

H.3. Doesn't WGS-84 Solve the Datum
Problem?

Most datums are local, intended to be used for only a portion of the Earth's surface. However, in
recent decades, improved surveying techniques have enabled global datums to be established.
These datums can be used to accurately map the entire Earth.

The most recent, and most accurate, datum is the World Geodetic System of 1984 (WGS-84).
While future improvements in surveying techniques may result in modifications to this datum,
these are expected to be minor: the coordinates of locations should shift by only a few
centimeters. Therefore, for most practical applications, WGS-84 represents the ultimate datum.

Once all maps and data are converted to WGS-84, the problems associated with multiple datums
will disappear. Therefore, mapping organizations throughout the world are converting to
WGS-84.

Unfortunately, the goal of a single global datum has not yet been attained. Converting to a new
datum is expensive and time-consuming. Therefore, the conversion to WGS-84 is proceeding
slowly, and may take decades. Certainly for the foreseeable future, the existence of multiple
datums will be a reality. Anyone who works with geographic data must be prepared to deal with
this fact.

H.4. How NMPIlot Converts Between Datums

NMPIlot can convert between most common datums. The 3-parameter Molodensky
transformation is used for this purpose. Transformation parameters were taken from Department
of Defense World Geodetic System 1984—ts Definition and Relationships with Local Geodetic
Systems, NIMA Technical Report TR8350.2, Third Edition, Amendment 1, 3 January 2000.
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H.5. Recommendations

If errors of several hundred meters are acceptable, you can ignore the entire issue of datums.
However, if you require greater accuracy, then you must know the datum of any geographic data
you use.

Whenever you obtain geographic data (maps, computer files, tables of locations), make sure that
you determine the datum of that data. For maps, the datum can often be found printed in the
legend area of the map. For computer files, the datum is often listed in the accompanying
documentation. If you cannot determine the datum, ask your source. Any reputable source of
geographic data should be able to supply this information.

Similarly, whenever you supply geographic data to others, make sure you tell them the datum.
Include the datum in any documentation you provide.

If you are working with computer programs that process geographic data, insure that you know
how those programs handles datums. Some programs (such as NMPlot) allow you to specify the
datum of your data. Others require that all data be in a fixed datum. Consult the program's
documentation.

If you are working with a global positioning system (GPS), make sure you know the datum that
your GPS displays locations in. Many allow you to select the display datum.

If you absolutely cannot determine the datum of your data, then WGS-84 should be assumed.
However, be aware of the potential errors if this assumption is incorrect.
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Appendix

Contacting Wasmer I
Consulting

@ WASMER

CONSULTING

NMPlot was developed by Wasmer Consulting, a software development firm specializing in
scientific and engineering applications. Since 1989, Wasmer Consulting has been developing
products with an emphasis on quality and usability.

Wasmer Consulting welcomes your comments about NMPlot: both reports of problems and
suggestions for future enhancements.

e-mail: wasmer@wasmerconsulting.com

web: http://wasmerconsulting.com
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